Copyright and Trademarks

Copyright © 1995, 2007, Oracle. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are “commercial computer software” or “commercial technical data” pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle and Agile are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.
CONTENTs

Copyright and Trademarks ................................................................. ii

Items ........................................................................................................ 1

Item Objects .......................................................................................... 1

Lifecycle Phase ...................................................................................... 3

Title Block Tab ..................................................................................... 3

Changes Tab .......................................................................................... 4

BOM Tab ............................................................................................... 5

Manufacturers Tab ................................................................................ 9

Sites Tab ............................................................................................... 10

Prices Tab ............................................................................................ 10

Quality Tab .......................................................................................... 10

Compliance Tab ................................................................................... 10

Suppliers Tab ....................................................................................... 10

Relationships Tab ............................................................................... 11

Where Used Tab .................................................................................. 11

Attachments Tab .................................................................................. 12

History Tab .......................................................................................... 13

Working with Item Revisions .............................................................. 13

Viewing a Different Revision .............................................................. 14

Introductory Revisions ......................................................................... 14

Blank Revisions .................................................................................... 14

How the Revision List Works .............................................................. 15

Revisions and Attachment Capabilities ............................................. 15

How Rev and Site Lists are Determined ............................................ 16

Working with Pending Revisions ....................................................... 16

Attachments on Pending Revisions .................................................... 17

Creating Agile Items ............................................................................ 18

Creating Items in Java Client ............................................................... 19

Creating Items in Web Client ............................................................... 20

Creating an Item Using Save As ......................................................... 20

Creating an Item Using Add ................................................................. 22

Deleting Agile Objects .......................................................................... 23

Editing Agile Items .............................................................................. 26

Editing an Unreleased Item ................................................................. 26
Editing a Released Item .................................................................................................................................................27
Changing an Item's Subclass ..................................................................................................................................................28
Releasing an Agile Item to Production ..................................................................................................................................28
Unreleasing an Item .................................................................................................................................................................29
Incorporating and Unincorporating Items .................................................................................................................................29
Overview of File Folders and Item Attachments ..........................................................................................................................30
Overview of Incorporation ..........................................................................................................................................................30
Pre-incorporating an Item ...........................................................................................................................................................31
Incorporating an Item .................................................................................................................................................................31
Unincorporating an Item ...........................................................................................................................................................31
Printing Item Tabs ...........................................................................................................................................................................32

Sites and Distributed Manufacturing .......................................................................................................................................33
What Are Sites? ...............................................................................................................................................................................33
How Sites Can Be Used ..................................................................................................................................................................34
Different AMLs at Each Site .........................................................................................................................................................34
Different BOMs at Each Site .........................................................................................................................................................34
Different Effectivity Dates and Dispositions at Each Site .............................................................................................................35
How Sites Work ...............................................................................................................................................................................35
Site Information on BOMs and AMLs ............................................................................................................................................35
Sites Tab of Items .............................................................................................................................................................................35
Changes and Sites ............................................................................................................................................................................36
Controlling Access to Sites ............................................................................................................................................................36
Common BOM/AML Sections .......................................................................................................................................................36
Where Sites Are Documented ........................................................................................................................................................37
Site Objects ......................................................................................................................................................................................37
General Info Tab - Sites .................................................................................................................................................................38
Attachments Tab ..............................................................................................................................................................................38
History Tab .....................................................................................................................................................................................40
Creating Sites ..................................................................................................................................................................................41
Creating Manufacturing Sites ..........................................................................................................................................................42
Creating a Site Using the Save As Feature ..................................................................................................................................42
Associating a Site with an Item .......................................................................................................................................................42
Fields on the Sites Tab .................................................................................................................................................................42
Adding Sites to the Sites Tab ........................................................................................................................................................43
Removing Sites from the Sites Tab ...............................................................................................................................................44
Deleting Site Objects .......................................................................................................................................................................44
Editing Sites ...................................................................................................................................................................................44
Printing Sites ................................................................................................................................................................................45
## Bills of Material

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Bills of Material</td>
<td>73</td>
</tr>
<tr>
<td>BOM Tab</td>
<td>73</td>
</tr>
<tr>
<td>How the Agile Administrator Controls What You See</td>
<td>74</td>
</tr>
<tr>
<td>BOM Tab Buttons</td>
<td>74</td>
</tr>
<tr>
<td>BOM Table Fields</td>
<td>77</td>
</tr>
<tr>
<td>Common and Site-specific Portions of the BOM</td>
<td>78</td>
</tr>
<tr>
<td>Viewing BOMs by Site</td>
<td>78</td>
</tr>
<tr>
<td>Opening Items on a BOM</td>
<td>79</td>
</tr>
<tr>
<td>Opening a Part, Assembly, or Document from the BOM Tab</td>
<td>79</td>
</tr>
<tr>
<td>Expanding and Collapsing an Assembly</td>
<td>79</td>
</tr>
<tr>
<td>Using BOM Go To</td>
<td>81</td>
</tr>
<tr>
<td>Revisions Listed on BOMs</td>
<td>82</td>
</tr>
<tr>
<td>BOMs of Items Affected by an ECO</td>
<td>82</td>
</tr>
<tr>
<td>About Modifying the BOM Table</td>
<td>83</td>
</tr>
<tr>
<td>Modifying Site-Specific Portions of the BOM of a Preliminary Item</td>
<td>83</td>
</tr>
<tr>
<td>Adding Items to the BOM Table of a Preliminary Item</td>
<td>84</td>
</tr>
<tr>
<td>Modifying the BOM Table of a Preliminary Item</td>
<td>91</td>
</tr>
<tr>
<td>Removing Items from the BOM Table</td>
<td>92</td>
</tr>
<tr>
<td>Working with Reference Designators</td>
<td>93</td>
</tr>
<tr>
<td>Viewing Reference Designators</td>
<td>93</td>
</tr>
<tr>
<td>Adding Reference Designators</td>
<td>94</td>
</tr>
<tr>
<td>Deleting Reference Designators</td>
<td>99</td>
</tr>
<tr>
<td>Modifying Reference Designators</td>
<td>100</td>
</tr>
<tr>
<td>Redlining the BOM of a Released Item</td>
<td>101</td>
</tr>
<tr>
<td>Overview of BOM Redlining</td>
<td>101</td>
</tr>
<tr>
<td>Redline BOM Tab</td>
<td>102</td>
</tr>
<tr>
<td>Adding an Item to a Redline BOM Table</td>
<td>104</td>
</tr>
<tr>
<td>Removing an Item from a Redline BOM Table</td>
<td>104</td>
</tr>
<tr>
<td>Editing Item Information on a Redline BOM Table</td>
<td>105</td>
</tr>
<tr>
<td>Undoing Changes to a Redline BOM Table</td>
<td>106</td>
</tr>
<tr>
<td>Printing BOM Data</td>
<td>106</td>
</tr>
</tbody>
</table>

## Changes

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Classes</td>
<td>109</td>
</tr>
<tr>
<td>Change Subclasses</td>
<td>109</td>
</tr>
<tr>
<td>Change Objects</td>
<td>110</td>
</tr>
<tr>
<td>Cover Page Tab</td>
<td>111</td>
</tr>
<tr>
<td>Affected Items Tab</td>
<td>114</td>
</tr>
</tbody>
</table>
Preface

The Oracle|Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) contains the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation folder available on your network from which you can access the Oracle|Agile documentation (PDF) files.

Note  To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. This program can be downloaded from the Adobe Web site (http://www.adobe.com).

The Oracle Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) can be accessed through Help > Manuals in both the Agile Web Client and the Agile Java Client. If you need additional assistance or information, please contact support (http://www.oracle.com/agile/support.html) for assistance.

Note  Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please have ready the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. Outside the United States, call +1.407.458.2479.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible, with good usability, to the disabled community. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For more information, visit the Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html).

Agile Training Aids

Go to the Oracle University Web page (http://www.oracle.com/education/chooser/selectcountry_new.html) for more information on Agile Training offerings.
Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.
Chapter 1

Items

This chapter includes the following:

- Item Objects......................................................................................................................................................... 1
- Working with Item Revisions.................................................................................................................................. 13
- Creating Agile Items................................................................................................................................................... 18
- Deleting Agile Objects.............................................................................................................................................. 23
- Editing Agile Items..................................................................................................................................................... 26
- Releasing an Agile Item to Production...................................................................................................................... 28
- Incorporating and Unincorporating Items.................................................................................................................. 29
- Printing Item Tabs.................................................................................................................................................... 32

Item Objects

Items can be parts or documents. In general, if the document is shipped as part of a product, or it has costs associated with it, create it as a part object. If the document is an internal document, procedure, or reference, create it as a document object. (In some cases, you may want to create a document as a part. For examples, see Part or Document? (on page 178))

This section includes the following topics:

- Lifecycle Phase (on page 3)
- Title Block Tab (on page 3)
- Changes Tab (on page 4)
- BOM Tab (on page 5)
- Manufacturers Tab (on page 9)
- Sites Tab (on page 10)
- Prices Tab (on page 10)
- Quality Tab (on page 10)
- Compliance Tab (on page 10)
- Suppliers Tab (on page 10)
- Relationships Tab (on page 11)
- Where Used Tab (on page 11)
- Attachments Tab (on page 12)
- History Tab (on page 13)

To locate and open an item, follow the instructions in Getting Started with Agile PLM.
When you view an item in Java Client, information about it is displayed on tabs in an item window.

When you view an item in Web Client, information about it is displayed in the right pane.

The following table lists the items tabs.

The Agile administrator may have added additional tabs or sections, called **Page Two** and **Page Three** by default. These tabs or sections contain custom fields defined by the administrator.

<table>
<thead>
<tr>
<th>Item tab name</th>
<th>Tab information includes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title Block Tab</strong> (on page 3)</td>
<td>General information about the item, unique class and subclass fields defined by the Agile administrator</td>
</tr>
<tr>
<td><strong>Changes Tab</strong> (on page 4)</td>
<td>Any pending or released changes against the item</td>
</tr>
<tr>
<td><strong>BOM Tab</strong> (on page 5)</td>
<td>The item’s bill of material</td>
</tr>
<tr>
<td><strong>Manufacturers Tab</strong> (on page 9)</td>
<td>Manufacturer and manufacturer parts information about sources for that part</td>
</tr>
<tr>
<td><strong>Sites Tab</strong> (on page 10)</td>
<td>The manufacturing sites that use the item</td>
</tr>
<tr>
<td><strong>Prices Tab</strong> (on page 10)</td>
<td>Prices associated with the item. For more information about Product Cost Management (PCM), see the Product Cost Management User Guide.</td>
</tr>
<tr>
<td><strong>Quality Tab</strong> (on page 10)</td>
<td>Information about Product Quality Management (PQM) objects associated with this item. Product Service Requests (PSRs) are problem reports or non-conformance reports about this item. For more information about PQM, see the Agile Product Quality Management User Guide.</td>
</tr>
<tr>
<td><strong>Compliance Tab</strong> (on page 10)</td>
<td>Information about the compliance to material regulations related to the item. For more information about Product Governance &amp; Compliance (PG&amp;C), see the Agile Product Governance and Compliance User Guide. <strong>Note</strong>: The <strong>Compliance</strong> tab is visible in Web Client only. Agile PG&amp;C is a Web Client-based solution.</td>
</tr>
<tr>
<td><strong>Suppliers Tab</strong> (on page 10)</td>
<td>Information about the approved suppliers for the item. This tab is used in both the PG&amp;C and PCM solutions. For more information about PG&amp;C, see the Agile Product Governance and Compliance User Guide. For more information about PCM, see the Product Cost Management User Guide. <strong>Note</strong>: The <strong>Supplier</strong> tab is visible in Web Client only. Agile PG&amp;C and Agile PCM are Web Client-based solutions.</td>
</tr>
<tr>
<td><strong>Relationships Tab</strong> (on page 11)</td>
<td>The <strong>Relationships</strong> tab allows you to create relationships with other Agile objects and to create dependencies between the current item object and other routable objects. For more information about relationships, see the chapter about working with business objects in Getting Started with Agile PLM.</td>
</tr>
</tbody>
</table>
Lifecycle Phase

A lifecycle phase name at the top right of the object window of an item indicates the production lifecycle phase of the item. (The names of the out-of-the-box lifecycles are shown next to each stamp. What you see may differ, however, if the Agile administrator has customized the lifecycle names for your organization.)

The lifecycle phase name also appears in the Lifecycle Phase field on the item Title Block tab. See Title Block Tab (on page 3).

The following table shows the default lifecycle phases.

<table>
<thead>
<tr>
<th>Lifecycle phase name</th>
<th>Lifecycle definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preliminary</td>
<td>The item has never been released. It may have a pending change against it.</td>
</tr>
<tr>
<td>Prototype</td>
<td>The item has been released to be built in very limited quantities for testing.</td>
</tr>
<tr>
<td>Pilot</td>
<td>The item has been released to be built in limited initial quantities.</td>
</tr>
<tr>
<td>Production</td>
<td>The item has been released for regular production.</td>
</tr>
<tr>
<td>Inactive</td>
<td>The item is temporarily not in use but may be reactivated.</td>
</tr>
<tr>
<td>Obsolete</td>
<td>This item is no longer in use.</td>
</tr>
</tbody>
</table>

Title Block Tab

The Title Block tab has fields that contain the information found on a typical paper-based title block. Some fields are filled in automatically; you complete the rest. You may not be able to edit the contents of some fields. Your assigned roles and privileges determine which entries you are allowed to edit.

For more information about editing items, see Editing an Unreleased Item (on page 26) and Editing a Released Item (on page 27).

For more information about Title Block fields, see Fields on the Title Block Tab (on page 3).

Fields on the Title Block Tab

By default, the item object Title Block tab contains the fields listed in the following table. Agile administrators determine which fields are enabled and visible on the Title Block tab.
In Web Client, the Title Block can contain two additional sections, called Page Two and Page Three by default. In Java Client, these are separate tabs. Agile administrators can add custom class fields to Page Two section and customer subclass fields to the Page Three section. The Agile administrator determines whether these sections are enabled, and what they are called.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The item’s number. The item number is completed when the item is created. Depending on Agile system settings, the number may be automatically generated or the user may enter a number.</td>
</tr>
<tr>
<td>Description</td>
<td>Text that describes the item. By default, descriptions can be up to 240 characters, counting spaces and carriage returns (carriage returns count as two spaces).</td>
</tr>
<tr>
<td>Size</td>
<td>Drawing size; select from the list.</td>
</tr>
<tr>
<td>Product Line(s)</td>
<td>The product group or groups that include this item; select from the list.</td>
</tr>
<tr>
<td>Lifecycle Phase</td>
<td>The lifecycle phase of the item for the displayed revision, for example, Prototype or Production. See Lifecycle Phase (on page 3) for more information.</td>
</tr>
<tr>
<td>Rev Incorp Date</td>
<td>The date an item is incorporated; automatically completed when the item is incorporated.</td>
</tr>
<tr>
<td>Rev Release Date</td>
<td>The date an item is released; automatically completed when the item is released.</td>
</tr>
<tr>
<td>Part Type</td>
<td>The subclass of this item; completed when the item is created. Depending on Agile system settings, the part type field may be automatically completed or the user may select a part type. See Changing an Item’s Subclass (on page 28) for more information.</td>
</tr>
<tr>
<td>Part Category</td>
<td>The category that includes the item; select from the list.</td>
</tr>
<tr>
<td>Effectivity Date</td>
<td>Displays the date the revision becomes effective. This date is specified on the Affected Items tab of the change that released the revision. See also Site-Specific Effectivity and Obsolete Dates (on page 122).</td>
</tr>
<tr>
<td>Mass</td>
<td></td>
</tr>
<tr>
<td>Part Family</td>
<td></td>
</tr>
<tr>
<td>Overall Compliance</td>
<td>These fields are associated with Agile PG&amp;C. For more information about Product Governance &amp; Compliance (PG&amp;C), see the Agile Product Governance and Compliance User Guide.</td>
</tr>
</tbody>
</table>

Changes Tab

The item object Changes tab displays a list of changes related to the item you are viewing, displayed in two tables. The information on this tab is filled in automatically. You can sort the tables by clicking the heading of the column by which you want to sort. For example, to sort by description, click the Description column heading.
Note: If you do not have Discovery privilege for a change, it does not appear on the Changes tab. You may see a message telling you how many changes are not displayed. For more information, see Details about Discovery and Read Privileges (on page 177). If you have questions about your Discovery or Read privileges, see the Agile administrator.

The upper table, Pending Changes, shows pending changes, including changes on hold. The lower table, Change History, shows released and canceled changes.

The Site column displays the site entered on the Affected Items tab of the change. If more than one site is listed on the Affected Items tab, then the change is listed once for each site.

Note: Although its name is similar, the History tab shows actions made against an item, while the Change History table on the Changes tab lists released and canceled changes for the item.

To open a change listed on the Changes tab:

- In Java Client, double-click the change row.
- In Web Client, click the change number.

The change opens with the Cover Page tab on top.

BOM Tab

The BOM tab lists all the items on an item’s bill of material (BOM). For details on the BOM tab, see Bills of Material (on page 73).

Note: If you do not have Discovery privilege for an item, it does not appear on the BOM tab. You may see a message telling you how many items are not displayed. For more information, see Details about Discovery and Read Privileges (on page 177).

If there are site-specific items on the BOM, common items and site-specific items are grouped together. The common items are listed first; the Sites column is blank for common items. The Sites column of site-specific items displays the associated site name.

Note: You can directly edit the BOM table when an item is initially created and before it is added to the Affected Items table of a change. See Creating a Common BOM (on page 6) and Creating a Site-Specific BOM (on page 7).

The common section of the BOM lists items that are associated with all the sites where the parent item is associated. The common section of a BOM can be modified through a revision change only.

The site section of the BOM lists items specific to the selected site. The site section of the BOM can be modified through a revision change or an SCO (site change order). For a site to be listed in a section of the BOM, the site must also be associated with the parent item.

Note: By assigning a color to each site, you can color code the site section of the BOM tab.

If you want to view all the components for all sites, select ALL from the Site drop-down list.

To open an item listed on the BOM tab:

- In Java Client, double-click the item row. The item opens with the Title Block tab on top.
- Or, right-click the item row, choose Open, then choose a tab. The item opens with the selected
In Web Client, click the item number. The item opens with the Title Block tab on top.

Creating a Common BOM

You can directly edit the item object BOM table when an item is initially created and before it is added to the Affected Items table of a change.

To create a common BOM using Java Client:

To add items to the BOM table:

1. On the BOM tab, click the Add drop-down menu button and choose a menu option to add components to the BOM.

2. Depending on your menu selection, do one of the following:
   - **Search** – Search for one or more existing items. In the Add BOM dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.) In the search results, select the items you want, select Common in Site drop-down list, and click OK. All the items in the Selected Items list are added to the BOM.

   **Note** If the selected items do not have the necessary site association, you are prompted to add the sites to the selected items. When you accept the warning, the selected items are added to the BOM.

   - **Type-in Known Numbers** – enter one or more existing item numbers, select Common in Site drop-down list, and click Add.

   **Note** You may enter a non-existent number to add a placeholder row. When prompted that the number does not exist, accept the warning to add the placeholder row to the BOM.

   - **Create** – Select a type from the Type drop-down list. If appropriate, enter an object number and complete any required fields. Select Common in Site drop-down list. Click OK. The common sites are automatically added to the newly created item.

   **Note** If you have already selected ALL in the item’s Site drop-down list, Common is preselected for you in the Search, Type-in Known Numbers, or Create dialog.

To create a blank row for common BOM using Java Client:

3. Select ALL in the item’s Site drop-down list.

4. In the BOM Add menu, select Add Blank Row.

   **Add Blank Row** adds a blank row to the BOM table that can be filled in later.

The Sites column is blank to indicate that the item is associated with all the sites assigned to the BOM.

To create a common BOM using Web Client:

1. On the BOM tab, click the Add button and, in the drop-down menu, choose a menu option to add components to the BOM.
2. Depending on your menu selection, do one of the following:

- **Search** – Search for one or more existing items. In the Add BOM Items dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). (For more information about searches, see *Getting Started with Agile PLM.*) In the search results, select the items you want, select Common in the Add for Site drop-down list, and click OK. All the items in the Selected Items list are added to the BOM.

  **Note** If any selected items do not have the necessary site association, you are prompted to add the site to the items. When you accept the warning, the selected items are added to the BOM.

- **Type-in Known Numbers** – enter one or more numbers, select Common in the Add for Site drop-down list, and click Add.

  **Note** You may enter a non-existent number to add a placeholder row. When prompted that the number does not exist, accept the warning to add the placeholder row to the BOM.

- **Create New** – Select a type from the Type drop-down list. If appropriate, enter an object number and complete any required fields. Select Common in the Add for Site drop-down list, and click OK. The common sites are automatically added to the newly created item.

  If you have already selected ALL in the item’s Site drop-down list, Common is preselected for you in the Search, Type-in Known Numbers, or Create New dialog.

**To create a blank row for common BOM using Web Client:**

3. Select ALL in the item’s Site drop-down list.
4. In the BOM Add menu, select Blank Row.

  Blank Row adds a blank row to the BOM table that can be filled in later.

The Sites column is blank to indicate that the item is associated with all the sites assigned to the BOM.

**Creating a Site-Specific BOM**

You can directly edit the item object BOM table when an item is initially created and before it is added to the Affected Items table of a change.

**Note** If the site for which you want to create a site-specific BOM is not on the Site list, you must associate the item with that site through the item’s Site tab.

**To create a site-specific BOM using Java Client:**

1. Select the site you want in the item’s Site drop-down list.

**To add items to the BOM table:**

1. On the BOM tab, click the Add drop-down menu button and choose a menu option to add components to the BOM.

2. Depending on your menu selection, do one of the following:

   - **Search** – Search for one or more existing items. In the Add BOM dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and
click Search. You can also define an advanced search, run a saved search, or select a
bookmarked or recently visited item (Shortcuts). (For more information about searches,
see Getting Started with Agile PLM.) In the search results, select the items you want,
select Common in Site drop-down list, and click OK. All the items in the Selected Items list
are added to the BOM.

**Note**  
If the selected items do not have the necessary site association, you are
prompted to add the sites to the selected items. When you accept the warning,
the selected items are added to the BOM.

- **Type-in Known Numbers** – enter one or more numbers and click Add.

**Note**  
You may enter a non-existent number to add a placeholder row. When prompted
that the number does not exist, accept the warning to add the placeholder row to
the BOM.

- **Create** – Select a type from the Type drop-down list. If appropriate, enter an object number
and complete any required fields. Click OK. The site will be automatically associated with
the newly created item.

**Note**  
If you have already selected the site you want in the item’s Site drop-down list, it
is preselected for you in the Search, Type-in Known Numbers, or Create dialog.

If you selected ALL in the item’s Site drop-down list in step 1 above, select the site you want before
you complete the dialog.

**To create a site-specific blank BOM row using Java Client:**

1. Select the site you want in the item’s Site drop-down list.
2. In the BOM Add menu, select Add Blank Row.

Add Blank Row adds a blank row to the BOM table that can be filled in later.

The Site column is automatically completed with the site selected from the Site list as the associated site.

**To create a site-specific BOM using Web Client:**

1. Select the site you want in the item’s Site drop-down list.

**Note**  
If you select ALL in the item’s Site drop-down list, you can then select any site
in the Search, Type-in Known Numbers, or Create dialog in step 3 below.

2. On the BOM tab, click the Add button and, in the drop-down menu, choose a menu option to add
components to the BOM.
3. Depending on your menu selection, do one of the following:

   - **Search** – Search for one or more existing items. In the Add BOM Items dialog box, select a
     search method. If you choose to perform a simple search, enter the value to search for and
     click Search. You can also define an advanced search, run a saved search, or select a
     bookmarked or recently visited item (Shortcuts). (For more information about searches,
     see Getting Started with Agile PLM.) In the search results, select the items you want,
     select Common in the Add for Site drop-down list, and click OK. All the items in the Selected
     Items list are added to the BOM.

   - If any selected items do not have the necessary site association, you are prompted to add the
     site to the items. When you accept the warning, the selected items are added to the BOM.
Type-in Known Numbers — enter one or more numbers and click Add.

Note You may enter a non-existent number to add a placeholder row. When prompted that the number does not exist, accept the warning to add the placeholder row to the BOM.

Create New— Select a type from the Type drop-down list. If appropriate, enter an object number, and complete any required fields. Click OK. The site will be automatically associated with the newly created item.

Note If you have already selected the site you want in the item’s Site drop-down list, it is preselected for you in the Search, Type-in Known Numbers, or Create New dialog.

If you selected ALL in the item’s Site drop-down list in step 1 above, select the site you want before you complete the dialog.

To create a site-specific blank BOM row using Web Client:

1. Select the site you want in the item’s Site drop-down list.
2. In the BOM Add menu, select Blank Row.

Blank Row adds a blank row to the BOM table that can be filled in later.

The Site column is automatically completed with the site selected from the Site list as the associated site.

Manufacturers Tab

The Manufacturers tab displays the manufacturer parts used for the item, including site-specific manufacturer parts. The information on the tab is derived from associated manufacturing objects. If your company is using Agile AML features, and you have the appropriate privileges, you can use this tab to construct an approved manufacturers list (AML) for the item.

The Manufacturers tab displays, in a sortable table, information about:

- The manufacturers that produce the part
- The manufacturer parts that they supply, including:
  - Whether the manufacturer part is the preferred or an alternate part
  - Whether they are currently an active manufacturer of that part
  - The manufacturer’s part number corresponding to the part in Agile PLM.
- The manufacturing site to which the manufacturer part applies (manufacturer parts are listed once per applicable site). The AML Split column on the Manufacturers tab allows you to define the percent (%) allocated for the AML for the selected site.

Note If you do not have Discovery privilege for a manufacturer, it does not appear on the Manufacturers tab. You may see a message telling you how many manufacturers are not displayed. For more information, see Details about Discovery and Read Privileges (on page 177).
Viewing a Manufacturer Part from the Manufacturers Tab

To open a manufacturer part from the item object Manufacturers tab:

- In Java Client, double-click the manufacturer part row.
  
  Or, right-click the manufacturer part row, choose Open, then choose a tab. The manufacturer part opens with the selected tab on top.

- In Web Client, click the manufacturer part number.

Sites Tab

The Sites tab of an item lists all the manufacturing sites that use the item or that have site-specific information that pertains to the item.

To make an item available to site-specific BOMs and AMLs, you must add the appropriate sites to the item’s Sites tab. For example, if you want to enable users at the India site to add site-specific information for a part, add India to the part’s Sites tab. With the necessary privileges, you can add, edit, and remove information on the Sites tab.

For more information about manufacturing sites, including how to work with the Sites tab, see Associating a Site with an Item (on page 42).

Prices Tab

The item object Prices tab shows information about the prices associated with the item.

For more information about pricing and the Prices tab, see Getting Started with Agile PLM or the Product Cost Management User Guide.

Quality Tab

The Quality tab of an item (part or document) lists the product service requests (PSRs) that reference the item. PSRs may include non-conformance reports (NCRs) and problem reports (PRs). The Agile administrator may have defined additional PSR types for your company. This tab is filled in automatically. For more information about the Quality tab and PQM features, see the Product Quality Management User Guide.

Compliance Tab

The item object Compliance tab relates to Agile PG&C and lists the compliance declarations associated with the item. For more information, see Agile Product Governance and Compliance User Guide.

Note: The Compliance tab is visible in Web Client only. Agile PG&C is a Web Client-based solution.

Suppliers Tab

This item object Suppliers tab relates to Agile PG&C and lets you associate suppliers with the item.
For more information, see *Agile Product Governance and Compliance User Guide*.

**Note** The Supplier tab is visible in Web Client only. Agile PG&C is a Web Client-based solution.

### Relationships Tab

The item object **Relationships** tab allows you to create relationships with other business objects, both lifecycle objects and routable objects. If the related object is a routable object, you can specify a rule for the relationship, thus creating a dependency between the current item and the routable object. A relationship with a rule indicates a routable object whose workflow progression is affected by the lifecycle phase of the current item object.

A relationship with no specified rule does not limit or affect the workflow progression of the related routable object. You can use non-rule relationships to record objects that are somehow related to the current item, but do not have any dependencies with the current item.

**Note** You cannot specify a rule for an item relationship with another lifecycle phase (non-routable) object.

For more information about relationships and how to use this tab, see the chapter about working with business objects in *Getting Started with Agile PLM*.

### Where Used Tab

The item object **Where Used** tab lists all the assemblies that use the item. The information on this tab is filled in automatically.

The **Where Used** tab includes two tables:

- **Where Used** — displays the latest released revision of the assemblies where the item is used. If the assembly has never been released, the Introductory revision is displayed. For more information, see *Introductory Revisions* (on page 14).

- **Pending Change Where Used** — displays the pending revisions of the assemblies where the item is used, including the associated change order number.

**To view or hide the Pending Change Where Used table:**

Use the View drop-down list to select either Show Pending or Hide Pending.

**Note** When you first view the Where Used tab, the Pending Change Where Used table is hidden by default.

**To view an item from the Where Used tab using Java Client:**

Double-click the item’s row.

**To view an item from the Where Used tab using Web Client:**

Click the item number.

**Note** If you do not have Discovery privilege for an item, it does not appear on the Where Used tab. You may see a message telling you how many items are not displayed. For more information, see *Details about Discovery and Read Privileges* (on page 177).

For information about site information displayed in the Where Used tables, see *Sites and the*
Where Used Tab (on page 12).

**Sites and the Where Used Tab**

The item object Where Used table displays all the assemblies where the item is used. Assemblies can be listed multiple times, once per site. The Sites column in the Where Used table shows common (blank) and site-specific portions of the BOM that include the item.

For more information about the where used tables, see Where Used Tab (on page 11).

**Attachments Tab**

All objects have an Attachments tab. On the Attachments tab, you can attach files and URLs to the object by referencing those files and URLs in a file folder object. On the Attachments tab, you can view, copy (get), or print attached files if you have the appropriate privileges.

Individual attached files are stored in file folder objects and can be attached to multiple objects. The files in a file folder object can be drawings or scanned images, documents, non-viewable files, compressed files, and so on.

For detailed information about working with file folder objects and the Attachments tab, see Getting Started with Agile PLM.

You cannot make modifications to the Attachments tab of incorporated items. For more information about incorporated items, see Incorporating and Unincorporating Items (on page 29).

Attachment tab operations (add, remove, edit) for items are revision-based. Attachments are added to or deleted from a specific ECO-created revision of the item, such as Rev A, Rev B, and so on. ECO-created item revisions have attachment capabilities. MCOs and SCOs are based on a particular item revision, but have no revision of their own, and therefore do not have attachment capabilities. For more information about item revisions and attachments, see Revisions and Attachment Capabilities (on page 15).

**Note**

Attachments apply to all manufacturing sites of an item; there are no site-specific attachments.

Common Attachments tab operations in Java Client include:

- View a file in Viewer – select a row in the Attachments table and click the View Files button.
- View a file in its native application – select a row in the Attachments table and click the Open Files button.
- Get a local copy of a file – select a row in the Attachments table and click the Get Files button.

Common Attachments tab operations in Web Client include:

- View file in Viewer – click its filename link. If the attached file is not viewable with Viewer, it opens in the native application, if it is installed on your computer.
- Get a local copy of a file – in the file’s row, click the Get button.
History Tab

The History tab shows a summary of actions taken against an object, including a description of the action, which user took the action, the date of the action, and other details.

Note If you do not have the appropriate Read privilege for an object, you cannot see the contents of the fields on the History tab. See Details about Discovery and Read Privileges (on page 177).

The types of actions recorded for items are:

- Creation of the item
- Attachment actions: view, open, add, delete, get, check in, check out, cancel checkout, incorporate, unincorporate, and field modifications on the Attachments tab.
- Save As
- Send
- Print
- Modification of the subclass or any field of a released item
- Subscription modification and sharing

Field modifications for preliminary items that have not been released are recorded for modifications to the Relationships tab and Attachments tab only; other field modifications to preliminary items are not recorded.

For modifications to released items, the revision information is included in the history table row in the Rev column.

Working with Item Revisions

The Site and Rev fields above the item tabs let you display item information based on manufacturing site and revision.

When you open an item, the Rev field displays the latest released version.

Note When you open the item from the Affected Items tab of a change order, the revision associated with that change order is displayed.

This section includes the following topics

- Viewing a Different Revision (on page 14)
- Introductory Revisions (on page 14)
- Blank Revisions (on page 14)
- How the Revision List Works (on page 15)
- How Rev and Site Lists are Determined (on page 16)
- Working with Pending Revisions (on page 16)
Viewing a Different Revision

To view a different revision:

1. If you want to see a revision that pertains to a specific manufacturing site, select that site from the Site drop-down list.

   Note: When you select ALL from the Site drop-down list, the default value in the Rev list is the latest released change for that item.

2. Select a revision from the Rev drop-down list above the tabs. When you select a revision, the corresponding effectivity date is displayed.

   When you select a different revision, all the tabs display information from the selected revision. For example, if the BOM tab is displayed, and you switch from revision C to revision B, the other tabs also show revision B.

   Note: Not all tabs are revision-specific; for example, the Where Used tab and the History tab are not revision-specific. When you view tabs that are not revision-specific, the Rev drop-down list is disabled.

Introductory Revisions

The initial revision of an item—that is, the revision of a newly created, unreleased item—is labeled Introductory. Introductory revisions have no changes against them, and they are not assigned a revision letter. When an item is in the Introductory stage, it is not under change control and can therefore be modified directly.

Introductory revisions are treated the same as released revisions; they are considered the base revision by Where Used and Object searches, the Where Used tab, changes, and the Save As feature.

Introductory appears in the Rev drop-down list at the bottom of the list because it is the earliest revision. It is the only revision on the list that is not associated with a change.

See also: How the Revision List Works (on page 15)

Blank Revisions

You may see revisions in the list that are not Introductory and that do not have an assigned revision letter. These are referred to as blank revisions.

Blank revisions occur when an MCO is released against an item before an ECO releases the item. That releasing MCO creates a blank revision, as do any subsequent changes that occur before a new ECO revision is created. The Rev list displays the number of the MCO instead of a revision letter. The following is an example of a Rev list that includes a blank revision created by MCO M00001.

(A) C00004
M00001
Introductory
How the Revision List Works

As stated above, a revision labeled Introductory in the Rev list indicates the initial revision of the object, with no pending changes. Once the object is listed on a change, a letter sequence of revisions is started.

For released revisions, the number of the releasing ECO is displayed next to its corresponding revision. (Remember, an item can be revised only by an ECO.) For example, for a part, if ECO E54321 resulted in the release of revision C, then revision C in the Rev drop-down list reads C E54321

A revision number or letter inside parentheses indicates that the revision is pending, not yet released:

(A) C00004

You may see revisions in the list that are not Introductory and that do not have an assigned revision letter. These are referred to as blank revisions.

Blank revisions occur when an MCO is released against an item before an ECO releases the item. That releasing MCO creates a blank revision, as do any subsequent changes that occur before a new ECO revision is created. The Rev list displays the number of the MCO instead of a revision letter:

M00001

MCOs and SCOs are based on item revisions, but neither can create a new revision of a part, and, therefore, neither has attachment capabilities. MCO and SCO modifications, which you can select in the Rev drop-down list, inherit the attachments of the ECO-created revision or the Introductory revision upon which they are based.

The MCO or SCO number is displayed next to the corresponding revision on the Rev drop-down list. For example, if there is a pending MCO M12345 against Rev B of a part, then on the Rev drop-down list, that revision is listed as “(B) M12345.”

Revisions and Attachment Capabilities

Item attachment operations (add, remove, edit) are revision-based. Attachments can be added to or deleted from only an ECO-created revision or an Introductory revision. MCOs and SCOs are based on an item revision, but have no revision of their own, and therefore do not have attachment capabilities. MCO and SCO modifications, which you can select in the Rev drop-down list, inherit the attachments of the ECO-created revision or the Introductory revision upon which they are based.

Note If the ECO-created revision or the Introductory revision is incorporated, you will not be able to add or remove attachments and you will not be able to edit the attachments table. For more information about item incorporation, see Incorporating and Unincorporating Items (on page 29).

See also Attachments Tab (on page 12). For detailed information about attachments and file folders, see the chapter about working with attachment files in Getting Started with Agile PLM. For information about ECO-redlining attachment files, see Agile Viewer Addendum.

The following tables illustrate attachment capabilities (add, remove, edit) for different entries on the item Rev drop-down list.
### How Rev and Site Lists are Determined

All revisions are shown to all users regardless of their default site or site access. However, when you open an item, the Rev drop-down list is set to the last change for your default site.

An item’s default revision shown is based on your default site. Even if you select a different site from the Site drop-down list, the default revision still reflects what you see from your default site.

### Working with Pending Revisions

You can create a pending revision of an item. When you create an ECO against an item, the ECO creates a pending revision of that item. Pending revisions let you modify the item under change control, including redline modifying its BOM table and Manufacturers table. You can also create pending revision attachment markups.

A pending revision can be identified by the parentheses around the revision number in the Rev field,

<table>
<thead>
<tr>
<th>Rev list entry</th>
<th>Attachment capabilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>(C) ECO-356</td>
<td>Yes, has attachment capabilities, because it is a pending ECO-created Rev.</td>
</tr>
<tr>
<td>B SCO-444</td>
<td>No attachment capabilities; it is based on Rev B and inherits Rev B’s attachments.</td>
</tr>
<tr>
<td>B ECO-233</td>
<td>Yes, has attachment capabilities, because it is an ECO-created Rev.</td>
</tr>
<tr>
<td>A MCO-888</td>
<td>No attachment capabilities; it is based on Rev A and inherits Rev A’s attachments.</td>
</tr>
<tr>
<td>A ECO-222</td>
<td>Yes, has attachment capabilities, because it is an ECO-created Rev.</td>
</tr>
<tr>
<td>INTRODUCTORY</td>
<td>Yes, has attachment capabilities, because it is an introductory revision. Introductory revisions have the same features as an ECO-created revision. See Introductory Revisions (on page 14).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rev list entry</th>
<th>Attachment capabilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>(B) MCO-934</td>
<td>No attachment capabilities; pending MCO based on Rev B and inherits Rev B’s attachments.</td>
</tr>
<tr>
<td>B ECO-572</td>
<td>Yes, has attachment capabilities, because it is an ECO-created Rev.</td>
</tr>
<tr>
<td>A SCO-444</td>
<td>No attachment capabilities; it is based on Rev A and inherits Rev A’s attachments.</td>
</tr>
<tr>
<td>A MCO-788</td>
<td>No attachment capabilities; it is based on Rev A and inherits Rev A’s attachments.</td>
</tr>
<tr>
<td>A ECO-333</td>
<td>Yes, has attachment capabilities, because it is an ECO-created Rev.</td>
</tr>
<tr>
<td>MCO-766</td>
<td>No attachment capabilities; it is based on the Introductory revision and inherits the Introductory revision’s attachments.</td>
</tr>
<tr>
<td>INTRODUCTORY</td>
<td>Yes, has attachment capabilities, because it is an introductory revision. Introductory revisions have the same features as an ECO-created revision. See Introductory Revisions (on page 14).</td>
</tr>
</tbody>
</table>
for example, (A).

For information about incorporating pending revisions of items, see Incorporating and Unincorporating Items (on page 29).

**Attachments on Pending Revisions**

By default, when a pending revision is created, it inherits the same list of attached files that are attached to the current default revision. If any files are then either added to or removed from the current default revision, those modifications are not reflected on the Attachments tab of the pending revision. For additional information about attachments and item revision levels, see Getting Started with Agile PLM.

See also: Removing an Item from the Affected Items Tab (on page 149).

**Effects of CopyFilesToRev SmartRule**

The CopyFilesToRev (Copy Files to Rev) SmartRule setting determines how pending revision item attachments are created or referenced. The Agile administrator sets the Agile PLM system to either copy, copy with warning, reference, reference with warning or disallow the list of attachments to be copied to a new pending revision.

When you add an item to the Affected Items table of a pending ECO, you create a pending revision of an item. Depending on the Agile PLM Copy Files to Rev SmartRule setting, pending revision attachments are processed as followed:

- **Copy** - For the item's new pending revision, Agile creates a new file folder and creates a new copy of the attachment file, which is placed in the new file folder.

- **Reference** - Agile uses the existing file folder and creates a new reference to it on the item's new pending revision Attachments tab.

- **Disallow** - The new item pending revision is created with no attachments.

- **Copy with Warning** - The same as the Copy setting, with the option of choosing no attachments for the new pending revision.

  When you add items to the pending ECO, you are presented with a warning dialog that includes a row for each item you are adding.
  
  - To add the item and to copy the attachments, check both the Add checkbox and the Attachments checkbox.
  
  - To add the item with no attachments, check only the Add checkbox.

- **Reference with Warning** - The same as the Reference setting, with the option of choosing no attachments for the new pending revision.

  When you add items to the pending ECO, you are presented with a warning dialog that includes a row for each item you are adding.
  
  - To add the item and to reference the existing attachments, check both the Add checkbox and the Attachments checkbox.
  
  - To add the item with no attachments, check only the Add checkbox.

When this SmartRule is set to Reference or Reference with Warning, if there are multiple versions of any attachment file, only the reference to the latest version is used for the new reference on the pending revision.
For example, if you create an ECO against Part 456, Rev C (thus creating a pending Rev D), all the attachment files that are attached to Rev C are also attached to pending Rev D. (The file and file folder references on the Attachments tab of released Rev C are duplicated on the Attachments tab of pending Rev D.) Any attachment files that are added to the Attachments tab of Rev C, or any other Rev C Attachments tab modifications (for example, modifying the file folder version numbers) after the creation of the ECO are not copied to pending Rev D.

Note  Attachment files that are added to the Introductory revision after the object is associated with a change (that will result in released Rev A) will not be copied to subsequent revs. This SmartRule does not affect MCO or SCO revisions because MCOs and SCOs do not create separate new revisions.

Creating a Pending Revision

Writing a pending ECO against an item creates a pending revision of the item. A pending revision can be identified by the parentheses around the revision number in the Rev field, for example, (A).

To create a pending revision:
1. Create the item.
2. Create an ECO.
3. Place the item on the Affected Items tab of the change.
4. Give the affected item a revision number.

Note  SCOs are for site-specific changes only; they do not affect common site information, and they do not roll the revision number. SCOs cannot be used to create a pending revision of a newly created item that has never been released.

For information about creating changes, see Changes (on page 109).

Modifying Pending Revisions

You modify pending revisions the same way you modify other objects. Because modifying a pending revision could affect a released revision, you must have the appropriate privileges to modify the Title Block, Page Two, and Page Three fields. If you have privileges to modify preliminary items, you can modify fields on the pending revisions of items. If you have privileges to modify released items only (and you do not have privileges to modify preliminary items), you cannot modify fields on the pending revisions of items. If you have questions about your assigned modify privileges, see the Agile administrator.

See also: Editing a Released Item (on page 27).

Creating Agile Items

To create an item, you must have the Create Item privilege.

In Java Client, you can create an item with the File | New | Item command, the New Object button , or the Save As command, on the More Actions menu (click the More button at the top of the object window) and on the right-click shortcut menu.
In Web Client, you can create an item with the **Create | Items** command or the **Actions | Save As** command.

You can also create an item as you add it to the **BOM** tab of a parent item or the **Affected Items** tab of a change.

This section contains the following topics:

- [Creating Items in Java Client](#) (on page 19)
- [Creating Items in Web Client](#) (on page 20)
- [Creating an Item Using Save As](#) (on page 20)
- [Creating an Item Using Add](#) (on page 22)

The initial revision of an item—that is, the revision of a newly created, unreleased item—is labeled **Introductory**. For more information about Introductory revisions, see [Introductory Revisions](#) (on page 14).

Once you create an item, that item exists until you delete it. If you create a new item, then decide you do not wish to keep it, be sure to delete the item; otherwise, the new item is still in the database, and the number cannot be reused. See [Deleting Agile Objects](#) (on page 23).

### Creating Items in Java Client

The process for creating new objects involves two main steps: creating an empty object, then filling in the object tabs with information specific to the object.

**To create and complete an item in Java Client:**

1. Using the **File** menu, choose the object class you want to create. For example:
   - **File | New | Items | Parts**
   - **File | New | Items | Documents**

2. In the **New** dialog box, use the **Type** drop-down list to select the type (subclass) of item you want to create.

3. Assign a number to the item. To do so, either accept the number that appears, click the **Autonumber** button to use the next autonumber, or type a number.
   - If more than one autonumber format can be used, the available autonumber formats appear in a list when you click the **Autonumber** button. Select the autonumber format you want.
   - The autonumber format and sequence are determined by the Agile administrator. The Agile administrator also determines whether using autonumbers is required or optional.

4. Complete any required fields.

5. Click **OK**.
   - The new item appears with the **Title Block** tab showing.

6. Fill in information on the item tabs, as desired.
   - You do not enter information on the **Changes**, **Where Used**, or **History** tabs. Those tabs are completed automatically.
Creating Items in Web Client

A wizard leads you through the process of creating an item and specifying the BOM, manufacturing sites, manufacturers, and attachments.

To create and complete an item in Web Client:

1. Using the Create menu, choose the object class you want to create. For example:
   - Create | Items | Parts
   - Create | Items | Documents

2. In the Create dialog box, use the Type drop-down list to select the type (subclass) of item you want to create.

3. Assign a number to the item. To do so, either accept the number that appears, click the Autonumber button to use the next autonumber, or type a number.

   When you click the Autonumber button to enter the item number, you might see a list of autonumber choices. The autonumber format and sequence are determined by the Agile administrator. The Agile administrator also determines whether using autonumbers is required or optional.

4. To continue using the Create wizard to enter information on each tab of the item, check the Continue Creation in Wizard checkbox, and click the Continue button. Follow the onscreen instructions to complete the wizard.

5. To create and display the item immediately, uncheck the Continue Creation in Wizard checkbox and click Finish. The new item appears with the Title Block tab showing. Fill in information on the item tabs, as desired.

   **Note** Agile PLM remembers your most recent selection for the Continue Creation in Wizard checkbox in any create dialog and it remains preselected for you in the Create dialog box.

   You do not enter information on the Changes, Where Used, or History tabs. Those tabs are completed automatically.

See also: Creating Items in Java Client (on page 19), Creating an Item Using Save As (on page 20), Creating an Item Using Add (on page 22).

Creating an Item Using Save As

Using the Save As feature is a quick way to create an item that is similar to an existing item.

For site-specific items, the original item’s manufacturing sites are copied to the new item, as are all components and manufacturer parts on the common and site-specific portions of the BOM and Manufacturers tabs. (Sites for which you do not have privileges are not copied.) If you select a specific site in the Site drop-down list and Save As, only the selected site’s data will be copied to the
newly created item.

**Caution**  In general, you should not use Save As to create an object in a different class or subclass (type) from the original object. The different classes or subclasses may not have the same tabs or defined fields, and you may lose access to some data in the newly created object.

For example, parts generally have a **BOM** tab. By default, documents do not. When you save a part as a document, you cannot view the part’s BOM in the resulting document unless the Agile administrator has configured your system to permit documents to have BOMs.

**Note**  If you do not have Discovery privilege for any of the items on the BOM list of the existing item, you can use Save As to create a new item, which includes the BOM list items that you cannot discover. You also will not be able to discover those BOM list items on the newly created item.

If the Agile administrator has set the appropriate attributes, fields in the optional **Page Two** and **Page Three** sections are copied to the new item. For information about the behavior of Page Two and Page Three fields in your Agile PLM system, see the Agile administrator.

If the item has one or more attachments, the attachments for the new item are created using the method specified by the Agile administrator in Agile system preferences:

- **Create new copy of file(s)** — Agile creates a new file folder and creates a new copy of the attachment file, which is placed in the new file folder.
- **Reference existing file(s)** — Agile uses the existing file folder and creates a new reference to it on the new item’s **Attachments** tab.
- **Do not copy file(s)** — The new item is created with no attachments.
- **Prompt** — You are prompted to select one of the above three methods. If the item has no attachments, no prompt appears.

Save As copies data from a field in the existing object to the same field in the new object. If a field or list value in the existing object is not available in the new object, then that field or list value is not copied to the new object.

For items using sites:

- The new item has only the default site associated with it (that is, the site selected in the **Sites** drop-down list when you performed the Save As action), even if the original item had multiple sites. If the new item needs additional sites, you must add sites to the new item manually.
- If you select **All** from the **Site** drop-down list of the original item and then perform a Save As action, all the sites from the original item are copied to the new item.
- If the original item does not have a default site, after the Save As action, the resulting new item also does not have a default site.

In Java Client, you can create an item using the **File | Save As** command or the **Save As** command on the More Actions menu (click the **More** button at the top of the object window) and on the right-click shortcut menu.

In Web Client, you can create an item using the **Actions | Save As** command.

For more information about creating items or other objects using Save As, see *Getting Started with Agile PLM*. 
Creating an Item Using Add

When you click the **Add** button on certain tabs of items and changes, such as the **Affected Items** or **BOM** tab, you can create a new item to add to the tab.

**To create an item to add to the tab using Java Client:**

1. On the tab to which you want to add a new item, click the **Add** drop-down menu button and choose the **Create** option. The New object dialog appears.
2. Select the site you want. To create and add an item to the common portion of the BOM, select **Common**.
   
   If you have already selected the site you want in the item’s **Site** drop-down list, it is preselected for you in the dialog.
3. From the **Type** drop-down list, select a type (subclass).
4. Assign a number to the item. To do so, either accept the number that appears, click the **Autonumber** button to use the next autonumber, or type a number.
   
   If more than one autonumber format can be used, the available autonumber formats appear in a list when you click the **Autonumber** button. Select the autonumber format you want.
5. Complete any required fields.
6. **Click OK**.
   
   The new item appears in the BOM table.
7. To fill in the rest of the new item’s tabs, open the item and fill in the information.

**To create an item to add to the tab using Web Client:**

1. If you want to add a site-specific item to the **BOM** tab, select the site you want in the item’s **Site** drop-down list.
2. On the tab to which you want to add a new item, click the **Add** drop-down menu button and choose the **Create New** option. The New object dialog appears.
3. Select the site you want. To create and add an item to the common portion of the BOM, select **Common**.
   
   If you have already selected a specific site in the item’s **Site** drop-down list, that site is preselected for you in the dialog.
4. From the **Type** drop-down list, select a type (subclass).
5. Assign a number to the item. To do so, either accept the number that appears, click the **Autonumber** button to use the next autonumber, or type a number.
   
   If more than one autonumber format can be used, the available autonumber formats appear in a list when you click the **Autonumber** button. Select the autonumber format you want.
6. Complete any required fields.
7. **Click Add**.

See also: *Creating Items in Java Client* (on page 19), *Creating Items in Web Client* (on page 20), *Creating an Item Using Add* (on page 22).
The new item appears in the BOM table.

8. To fill in the rest of the new item’s tabs, open the item and fill in the information.

See also: Creating Items in Java Client (on page 19), Creating Items in Web Client (on page 20), Creating an Item Using Save As (on page 20).

## Deleting Agile Objects

Java Client and Web Client support “soft” and “hard” deletes. When you soft-delete an object in the database, it is not permanently deleted. A soft-deleted object is marked “Deleted” in the database, and its object number is reserved. You cannot create another object with the same type and number as a soft-deleted object.

Note You can undelete a soft-deleted object, if you have the appropriate privileges. If you need to do so, but do not have privileges, contact the Agile administrator.

This section contains the following topics:

- Soft-Deleting an Object (on page 25)
- Undeleting an Object (on page 25)
- Hard-Deleting an Object (on page 25)

When you run a search, soft-deleted objects do not appear in the search results table. To locate soft-deleted objects, you must run the predefined deleted object searches in the Recycle Bin Searches folder.

Note You have access to the Recycle Bin Searches folder if Recycle Bin Searches is included in the Searches field of your user profile. If you have the appropriate privileges, you can edit your user profile and add Recycle Bin Searches to the list of searches in the Searches field. If you do not have the appropriate privileges to modify the Searches field in your user profile, ask the Agile administrator to modify your user profile.

A hard-deleted object is permanently removed from the database.

Caution You cannot undelete a hard-deleted object.

Before you can delete an object, it must meet the conditions described in the following table.

Note You cannot delete an object unless all of its relationships and subscriptions are removed.

<table>
<thead>
<tr>
<th>Class or base class of object</th>
<th>You can delete this kind of object that meets the following conditions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>The item has no released changes against it.</td>
</tr>
<tr>
<td></td>
<td>The item is not listed on the Affected Items tab of any pending change. (You must first remove the item from the Affected Items tab of each pending change before you can delete the item.)</td>
</tr>
<tr>
<td>Note</td>
<td>If you delete an item that is listed on the BOM table of an assembly item, that BOM table row becomes a temporary item, that is, a blank row in the BOM table.</td>
</tr>
<tr>
<td>Class or base class of object</td>
<td>You can delete this kind of object that meets the following conditions:</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Change**                    | ☐ You created it; or you are the change analyst or component engineer, and the Agile administrator has given change analysts or component engineers the appropriate privileges to delete a change.  
☐ The change is at the Pending status type or the Unassigned status.  
☐ You have Discovery and Read privileges for any items on the Affected Items table, otherwise, you cannot delete the change.  
**Note:** To delete a change that has already been released, you must first unrelease the change. You need the appropriate privileges to unrelease a change by using the **Workflow** tab to switch it to a different status. |
| **Manufacturer**              | ☐ It is not listed on the Manufacturers tab of an item. (Check the Where Used tab of the manufacturing object.)  
☐ If the object is a manufacturer, no manufacturer parts are associated with it.  
**Note:** If all manufacturer parts associated with a manufacturer have been deleted, then the manufacturer can be deleted as well. However, you will not be allowed to undelete the soft-deleted manufacturer parts until the soft-deleted manufacturer object is undeleted. |
| **Site**                      | **Note:** Unlike other Agile objects, site objects can be soft deleted, but soft-deleted sites cannot be undeleted or hard deleted. If you are no longer using a site, Agile recommends that you disable it.  
☐ The site does not appear on any item’s Sites tab.  
☐ The site is not associated with any other Agile object.  
☐ The site has a lifecycle of Disabled.  
If it meets the conditions listed above, a disabled site can be soft-deleted even when it is listed in the Sites or Default Site field of user profiles. The deleted site is automatically removed from the Sites list in any user profile where it is listed.  
**Note:** Once the site has been associated with an item, you can change its status to Disabled, but you cannot delete it. |
| **Package**                   | ☐ You created it; or you are the program manager, and the Agile administrator has given program managers the appropriate privileges to delete a package.  
☐ The package is at the Pending status type or the Unassigned status. |
| **Transfer Order**            | ☐ You created it, or the Agile administrator has given you the appropriate privileges to delete a transfer order.  
☐ The transfer order is at the Pending status type or the Unassigned status. |
| **PSR or QCR**                | ☐ You created it; or the Agile administrator has given change analysts or component engineers the appropriate privileges to delete a PSR or QCR.  
☐ The PSR or QCR is at the Pending status type or the Unassigned status.  
☐ You have Discovery and Read privileges for any items on the Affected Items table, otherwise, you cannot delete the PSR or QCR.  
**Note:** To delete a PSR or QCR that has already been released, you must first unrelease it. You need the appropriate privileges to unrelease a PSR or QCR by using the **Workflow** tab to switch it to a different status. |
| **RFQ**                       | ☐ The RFQ has no released changes against it. |
Soft-Deleting an Object

To soft-delete an object in Java Client:
1. Select and open the object you want to delete.
2. Click the Delete button, and respond Yes to the confirmation prompt.

The object is soft-deleted. It is no longer available for use. However, until it is hard-deleted, its number or name is reserved in the Agile database and cannot be reused.

To soft-delete an object in Web Client:
1. Select and open the object you want to delete.
2. Choose Actions > Delete, and respond OK to the confirmation prompt.

The object is soft-deleted. It is no longer available for use. However, until it is hard-deleted, its number or name is reserved in the Agile database and cannot be reused.

See also: Deleting Agile Objects (on page 23), Undeleting an Object (on page 25), and Hard-Deleting an Object (on page 25).

Undeleting an Object

You can undelete soft-deleted objects.

To undelete an object in Java Client:
1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.
2. Open the deleted object you want to restore.
3. Click the Undelete button.

To undelete an object in Web Client:
1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.
2. Open the deleted object you want to restore.
3. Choose Actions > Undelete.

See also: Deleting Agile Objects (on page 23), Soft-Deleting an Object (on page 25), and Hard-Deleting an Object (on page 25).

Hard-Deleting an Object

Soft-deleted objects still exist in the database. To remove an object permanently, you hard-delete it. While an object is still only soft-deleted, you can undelete it. Run the appropriate Deleted object search from the Recycle Bin Searches folder.

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Java Client:
1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.
2. Open the object.
3. Click the **Delete Object** button \( \times \), and respond **Yes** to the confirmation prompt.

**To hard-delete a soft-deleted object (if you have the appropriate privileges) in Web Client:**
1. Run the appropriate **Deleted <objects>** search from the **Recycle Bin Searches** folder.
2. Open the object.
3. Choose **Actions > Delete**, and respond **OK** to the confirmation prompt.

See also: [Deleting Agile Objects](page 23), [Undeleting an Object](on page 25), and [Soft-Deleting an Object](on page 25).

### Editing Agile Items

You can edit preliminary and released items in different ways. Preliminary items can be edited directly, but released items must be edited with a change order.

This section contains the following topics:
- **Editing an Unreleased Item** (on page 26)
- **Editing a Released Item** (on page 27)
- **Changing an Item’s Subclass** (on page 28)

#### Editing an Unreleased Item

You can edit numbers and much of the other information about an item **Title Block** tab if the item has **not** been released. For additional information about editing an item that has not been released, see [Working with Pending Revisions](on page 16) and [About Modifying the BOM Table](on page 83).

**Note**

When you renumber a part that is a child of another item, the connection between the parent and child is maintained. If the parent item has been released, you will see a warning asking you if you want to continue.

Whether the item is released or unreleased, you cannot edit item tabs that are completed automatically, such as the **Where Used** tab, the **Changes** tab and the **History** tab.

**For example, to renumber an unreleased item using Java Client:**
1. Open the item.
2. Select the number in the **Number** field, and type a new number.
   
   Or click ![autonumber](image) to assign a new autonumber automatically.
3. When your modifications are complete, click **Save** to keep them, or click **Close** to close the object window without saving the changes.

Other fields can be modified in a similar way.

**For example, to renumber an unreleased item using Web Client:**
1. Open the item.
2. Click Edit.

3. Select the number in the Number field, and type a new number.
   Or click 123 to assign a new autonumber automatically.

4. When your modifications are complete, click Save to keep them, or click Cancel to close the Edit page without saving the changes.

Other fields can be modified in a similar way.

**Editing a Released Item**

If you have sufficient privileges, you can edit most fields on the item object Title Block tab even after an item is released, including:

- The Number field.
  See **Editing an Unreleased Item** (on page 26).

- The Description field.
  See **Editing a Released Item’s Description Field** ("Editing a Released Item’s Description Field" on page 27).

For more information about editing a released item, see **Redlining the BOM of a Released Item** (on page 101).

With sufficient privileges, you can also add or modify attachments (on the Attachments tab) after an item is released.

**Note** If you have questions about your privileges, ask the Agile administrator.

**Editing a Released Item’s Description Field**

**Note** The Agile administrator may have configured Agile PLM so that a released item’s Description field can be changed only by using the Affected Items tab of a change order.

If you have sufficient privileges, you can edit the Description field of the latest released revision of an item or of a pending ECO revision.

- When you edit a released item’s Description field, the new description appears only on the latest released revision of the item.

- If the Description field has been modified several times, only the most recent modification appears in the item’s Description field.

- If the item has pending revisions, a warning message appears and allows you to choose whether or not to copy the new description to the pending revisions as well.

**Note** If the change order Affected Items tab of the pending revision displays both the Old Item Description (latest released revision) and the New Item Description (pending revision), the Old Item Description field on the Affected Items table will be updated to reflect the actual item description of the latest released revision. The Affected Items table New Item Description (pending revision) remains unchanged.
To modify the Description field of a pending revision, use one or both of the following methods. The methods available on your Agile system depend upon how the Agile administrator has configured the Agile system and which privileges you have.

- Open the item, select the pending revision in the Revision drop-down list. Then edit the Description field and save your edits. (Requires the appropriate privileges.)
- Use the Affected Items tab of the change order. Select the item's row on the Affected Items table and click Edit. Edit the (new) item description field, and save your edits. (Requires the appropriate privileges.)

Description field modifications are recorded on the item's History tab after the item is released.

**Important** The item Description field cannot be modified through an MCO because an MCO does not create a new item revision. The MCO uses the Description field information from the ECO revision or Introductory revision on which it is based.

**Changing an Item’s Subclass**

If your administrator has created additional subclasses, and you have the appropriate privileges, you can change the subclass of an item. For example, you can change the subclass of a particular document from Specification to Data Sheet.

For information about how to change the subclass of an item, see Changing an Item’s Subclass (on page 179).

**Releasing an Agile Item to Production**

Items are not released to production directly. Rather, a change (an ECO) is created against the item, and that change is released through the change control process, described in Getting Started with Agile PLM. For more information about ECOs and other Agile changes, see Changes (on page 109).

To release an item to production:

1. Follow the steps in Creating Changes (on page 124) to create an ECO that releases the item.
2. Route the ECO as described in Changes (on page 109).
3. When the change has progressed through the required statuses, it is ready for release. Usually, this includes at least one Review status type, when users sign off the change.
   - If AutoPromote is set, the change is released automatically when the change has been signed off and all required values to enable release have been filled in.
   - If AutoPromote is not set, click the Next Status button (ائد in Java Client) to release the change.

**Note** If you have the appropriate privileges, you can use the Workflow tab to move the change directly to the Released status type in the workflow.

When the change is released, the item is also released.

For more information about working with workflows, see Getting Started with Agile PLM.
Unreleasing an Item

If you have sufficient privileges, and the workflow allows it, you can unrelease a released item.

Caution! Do not unrelease items if you use Agile ChangeCAST or Agile Content Service (ACS).

To unrelease an item:
1. Open the item.
2. Click the Changes tab.
3. Open the change that released the item.
   (If there are subsequent changes to the item, you must first unrelease those changes in the reverse order from which they were made.)
4. On the Workflow tab, click the Pending status type in the status chart.

   **Note** Switching a change to any status in the workflow that occurs before the first Released status type unreleases the change and, therefore, unreleases the item. If there is no such status displayed as an available status to select in the change status flowchart (Pending, Submit, Review, or Hold type), either you do not have the necessary privileges to select that status to unrelease the change, or the change’s workflow does not allow unreleasing the change. (For information about how to view the sequential list of statuses in a workflow, see the chapter on workflows in Getting Started with Agile PLM.)

   The Change Status dialog box (Java Client) or page (Web Client) opens.

5. Fill in the Notify field.
6. Enter any comments in the Comments field.
7. Click OK.

Incorporating and Unincorporating Items

If you have sufficient privileges, you can incorporate an item. When you incorporate an item, you lock its attachments so no unauthorized changes can be made. If you incorporate an item with no attachments, then none can be added to it.

This section includes the following topics:
- Overview of File Folders and Item Attachments (on page 30)
- Overview of Incorporation (on page 30)
- Pre-incorporating an Item (on page 31)
- Incorporating an Item (on page 31)
- Unincorporating an Item (on page 31)
Overview of File Folders and Item Attachments

Note For detailed information about attachments and file folder objects, see Getting Started with Agile PLM, Working with Attachments and Working with File Folders. See also Attachments Tab and Revisions and Attachment Capabilities (on page 15).

All objects have an Attachments tab. On the Attachments tab, you can attach files and URLs to the item by referencing those files and URLs in a file folder object. Individual attached files are stored in file folder objects and can be attached to multiple objects. On an item’s Attachments tab, the file folder Version is listed in the attachments table. Each time you check out and check in an attachment from the item’s Attachments tab, the file folder Version is advanced by one number. If you have the appropriate privileges, you can also edit the attachments table and select a specific Version of the file folder.

Because multiple objects, including items, can reference the same file folder, it is possible for different items to reference different Versions of the same file folder. Item 123 can reference Version 3 of file folder FF444, and Item 987 can reference Version 6 of file folder FF444.

Overview of Incorporation

When you incorporate an item revision, you lock the item’s attachments to the specific file folder Version currently displayed on the item’s Attachments tab. Incorporation is an action that applies to item objects only. Non-item business objects, including file folder objects, cannot be incorporated.

Note Only ECO-created revisions and Introductory revisions can be incorporated. For more information about attachments and item revisions, see Revisions and Attachment Capabilities (on page 15).

For example, if the item’s attachment is file SPEC.doc, and it is stored in FF004, and the file folder Version on the item’s Attachments tab is Version 3, when you incorporate the item, the item’s attachments are now locked to Version 3 of FF004. In a similar manner, if the Version selected on the item’s Attachments tab is Latest-4, when you incorporate the item revision, the file folder Version reverts to Version 4, and is now locked on that Version for the incorporated item. If the item has multiple attachments in multiple file folders, all the file folder Versions are locked when you incorporate.

Important Regardless of how many Versions a file folder has, once you incorporate an item revision, it always refers to the locked file folder Version.

Due to checkout and checkin actions that can be performed from the Attachments tabs of any objects that reference the same file folder, as well as checkout and checkin actions on the Files tab of the file folder object itself, it is possible for the file folder to be modified and additional file folder Versions to be created.

Once an item is incorporated, you can no longer check out its attachments from the item’s Attachments tab. Copies can be taken of attachments for the purpose of viewing and working with them, but the attachments cannot be amended on that revision of the item without unincorporating. (Amending an item’s attachments includes adding or deleting attachments and changing the file folder Version number shown in the attachments table.) Likewise, you cannot incorporate an item that has any files checked out.

Before you can add or edit the attachment files of an incorporated item or the file folder Versions
referenced by an incorporated item, the item must first be unincorporated. Once the changes are made, the item can be incorporated again. Appropriate privileges are required to either incorporate or unincorporate items.

The Incorporated/Unincorporated status refers to all the attachments to the item for a specific revision. When you incorporate an item, only that revision with its attachments is incorporated. For example, if you have three unincorporated revisions of an item (revisions C, D, and E), when you incorporate revision D, revisions C and E remain unincorporated.

For information about working with attachments and file folder objects, see Getting Started with Agile PLM.

See also: Incorporating and Unincorporating Items (on page 29).

**Pre-incorporating an Item**

An item with a pending change can be incorporated before it is released, in which case it is referred to as “pre-incorporated.” Pre-incorporating an item provides a way to mark a revision as tentatively complete, and to “freeze” attachments from checkout. (It is still possible to “get” a copy of an attachment, but the files attached to an incorporated item cannot be modified.)

Pre-incorporation is performed the same way as incorporation, except that it is performed on an unreleased item. For instructions, see Incorporating an Item (on page 31).

See also: Incorporating and Unincorporating Items (on page 29).

**Incorporating an Item**

You cannot incorporate an item that has any attachment files checked out.

To incorporate an item using Java Client:

1. Open the item.
2. Click the More button at the top of the object window to display the More Actions menu and choose Incorporate.
   
   Or, right-click in the window, and choose Incorporate from the shortcut menu.

To incorporate an item using Web Client:

1. Open the item.
2. Choose Actions | Incorporate.

If an item is incorporated before it is released, the incorporation process is performed the same way, but it is known as pre-incorporation. See Pre-incorporating an Item (on page 31).

See also: Incorporating and Unincorporating Items (on page 29).

**Unincorporating an Item**

When you unincorporate an item, just that particular revision is unincorporated.
To unincorporate an item using Java Client:

1. Open the item.
2. Click the More button at the top of the object window to display the More Actions menu and choose Unincorporate.
   Or, right-click in the window, and choose Unincorporate from the shortcut menu.

To unincorporate an item using Web Client:

1. Open the item.
2. Choose Actions | Unincorporate.

See also: Incorporating and Unincorporating Items (on page 29).

Printing Item Tabs

You can print object tabs and other data from your Agile PLM system. You can print the current tab or all tabs. Attachments are printed from their native applications or the Viewer.

In Java Client, with the object open, use the Print button.

In Web Client, with the object open, choose Actions | Print.

For additional information about printing objects, see Getting Started with Agile PLM.
What Are Sites?

In Agile PLM, site objects represent manufacturing sites. Companies that practice distributed manufacturing use several different manufacturing sites for their products. For example, Widget Corporation manufactures its products at the corporate location in Austin, Texas, but also at manufacturing plants in Taiwan, Singapore, Mexico City, and Milpitas, California.

Site objects ensure that each ERP has only the relevant information for its production needs. For example, companies can manage what is sent to each internal ERP site or contractor in a Make vs. Buy site association.

Site objects help ease the production transfer from one manufacturing site to another. For example, the Widget Corporation can transfer an entire product from their Taiwan prototype site to their Mexico City production site by adding the production site association to all the parts in the Taiwan BOM that are not in the Mexico City BOM, then send the BOM to Mexico City through an engineering change order (ECO) or a site change order (SCO).

Site objects also help to formalize the site effectivity process by allowing a user to create a proposed effectivity date change (SCO) against a part revision. For example, if a site production date has to be changed to a later date, an SCO against the part provides a simple record of approvals and reasons for changing the effective date.

The following diagram illustrates how sites can be used in Agile PLM. The three sites in this diagram vary in ERP system, effectivity date, and manufacturer. Also, Site 3 has added site-specific build instructions.
How Sites Can Be Used

You can use sites to record and manage site-specific AMLs, BOMs, and effectivity dates.

This section includes the topics:

- Different AMLs at Each Site (on page 34).
- Different BOMs at Each Site (on page 34).
- Different Effectivity Dates and Dispositions at Each Site (on page 35).

Different AMLs at Each Site

Often, different sites use different manufacturers and manufacturer parts to build the same products. Reasons for the differences could be cost (for example, it may be more cost-effective for a site to use a nearby manufacturer) or status of a manufacturer, to name two examples. The AML for an assembly can include different manufacturer parts for the various manufacturing sites.

See also: How Sites Work (on page 35).

Different BOMs at Each Site

The BOM of an assembly can include items that pertain only to specific sites. The common BOM
lists all items that make up the core assembly, and that BOM is the same for all sites; but the appropriate users assigned to each manufacturing site can add site-specific items to the BOM (thus creating a site-specific portion of the BOM). Often, these additional items are documents, such as assembly instructions specific to how something is built at a site.

See also: How Sites Work (on page 35).

### Different Effectivity Dates and Dispositions at Each Site

Items may have different effectivity dates and dispositions at each site. This enables, for example, the Austin site to begin using revision B of an item while Singapore continues to use revision A until stock has run out.

Effectivity dates and dispositions are specified on the Affected Items tab of an ECO or an SCO. If you want to create a new revision when you assign the new effectivity date or disposition, use an ECO. To assign site-specific effectivity dates and dispositions without incrementing the revision, use an SCO.

See also: How Sites Work (on page 35).

### How Sites Work

Site objects, similar to manufacturer objects, hold information about each site. Users with appropriate privileges can create additional sites.

This sections includes the topics:

- Site Information on BOMs and AMLs (on page 35).
- Sites Tab of Items (on page 35).
- Changes and Sites (on page 36).
- Controlling Access to Sites (on page 36).
- Common BOM/AML Sections (on page 36).

### Site Information on BOMs and AMLs

When you view an item’s BOM or AML (Manufacturers tab), you can choose to view it for all sites or for a specific site. When you view the BOM or AML for a specific site, the common BOM or AML is included in the list.

See also: How Sites Work (on page 35), Viewing BOMs by Site (on page 78), Viewing AML Information by Site (on page 64).

### Sites Tab of Items

Each item includes a Sites tab. The Sites tab lists the sites where that item can be used. If a site is not listed on an item’s Sites tab, then that item cannot be included in the portion of a BOM specific to that site. If all the sites of the parent BOM are not listed on an item’s Sites tab, then that item cannot be included in the common portion of a BOM. For a detailed explanation, see Common BOM/AML Sections (on page 36).
See also: *How Sites Work* (on page 35), *How Sites Can Be Used* (on page 34).

**Changes and Sites**

Changes can affect all sites of an item or a specific site. The **Affected Items** tab lets you select sites to affect as you add affected items. Use site change orders (SCOs) to create site-specific changes to an item without changing the revision.

See also: *How Sites Work* (on page 35), *Changes and Manufacturing Sites* (on page 120), *Site Change Orders* (on page 122).

**Controlling Access to Sites**

The use of sites is controlled by your organization’s licenses, roles, privileges, and default site property (which determines which site you see by default). You can create as many sites as you want.

Your organization may have implemented sites in such a way that users can access only the information pertaining to certain sites.

Your user profile **Sites** list controls which site objects you can discover in the Agile database and which item site-related rows (**BOM** tab, **Manufacturers** tab) you can discover. The ability to read site object attributes is controlled by your Read privilege.

Users with Administrator privilege have the ability to assign all sites when modifying a user’s User Profile attributes. However, when searching for sites in Web Client or Java Client, the Administrator user can discover only the sites listed in the **Sites** list of his own User Profile.

See also: *How Sites Can Be Used* (on page 34), *How Sites Work* (on page 35).

**Common BOM/AML Sections**

The common section of the BOM distinguishes information that is shared between all the sites listed on the **Sites** tab of the item. All the parts in the common section of the BOM of an assembly must have listed on their **Sites** tabs all the sites that are listed on the **Sites** tab of the assembly. That is, they have those sites in common.

For example, if part 300 is to appear on the Milpitas-specific portion of the BOM of assembly 234, then part 300 and assembly 234 must both have the Milpitas site listed on their **Sites** tabs. If assembly 234 has three sites (Milpitas, India, and San Jose) on its **Sites** tab, for part 300 to appear on the common portion of the BOM of assembly 234, part 300 must also have at least those three sites (Milpitas, India, and San Jose) included on its **Sites** tab. That is, they must have those sites in common. (Part 300’s **Sites** tab may also include additional sites that do not relate to assembly 234.) A SmartRule (Items Released First) controls whether Agile checks an item’s BOM components for the appropriate site association at release. Compliance with the SmartRule is checked when an ECO, SCO, or MCO releases the assembly. You can also use the change Audit Release feature to check for compliance before release.

See also: *Creating a Common BOM* (on page 6), *Creating a Site-Specific BOM* (on page 7).
Where Sites Are Documented

You can find information about sites in the following sections:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Section or chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site objects</td>
<td>The rest of this chapter</td>
</tr>
<tr>
<td>Sites tab of items</td>
<td>This chapter and Chapter 1, Items (on page 1)</td>
</tr>
<tr>
<td>Viewing site-specific information</td>
<td>The following chapters:</td>
</tr>
<tr>
<td></td>
<td>Chapter 1, Items (on page 1)</td>
</tr>
<tr>
<td></td>
<td>Chapter 4, Bills of Material (on page 73)</td>
</tr>
<tr>
<td></td>
<td>Chapter 6, Affected Items of Changes (on page 129)</td>
</tr>
<tr>
<td></td>
<td>Chapter 3, Manufacturing Objects (on page 47)</td>
</tr>
<tr>
<td>Site-specific BOMs</td>
<td>Chapter 4, Bills of Material (on page 73)</td>
</tr>
<tr>
<td>Site-specific AMLs</td>
<td>Chapter 3, Manufacturing Objects (on page 47)</td>
</tr>
<tr>
<td>SCOs</td>
<td>Chapter 5, Changes (on page 109), and Chapter 6, Affected Items of Changes (on page 129)</td>
</tr>
<tr>
<td>Effects of changes on sites</td>
<td>Chapter 5, Changes (on page 109), and Chapter 6, Affected Items of Changes (on page 129)</td>
</tr>
<tr>
<td>Redlining site-specific information</td>
<td>Chapter 6, Affected Items of Changes (on page 129)</td>
</tr>
<tr>
<td>Site-specific effectivity dates and dispositions</td>
<td>Chapter 6, Affected Items of Changes (on page 129)</td>
</tr>
</tbody>
</table>

Site Objects

A site object contains general information about a site. Unlike items, sites do not need to go through a release process.

This section includes the following topics:

- General Info Tab - Sites (on page 38)
- Attachments Tab (on page 40)
- History Tab (on page 41)

To locate and open an item, follow the instructions in Getting Started with Agile PLM.

The Agile administrator may have added additional sections to the Title Block or General Information tab, called Page Two and Page Three by default (Web Client). In Java Client, these are separate tabs. These sections or tabs contain custom fields defined by the administrator.

<table>
<thead>
<tr>
<th>Site tab name</th>
<th>Tab information includes</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Info</td>
<td>General information about the site</td>
</tr>
</tbody>
</table>
General Info Tab - Sites

The General Info tab has fields that contain basic information about a site. Some fields are filled in automatically; you complete the rest. You may not be able to edit the content of some fields.

This section includes the following topics:
- General Info Tab Fields - Sites (on page 38)
- Site Lifecycle Phase (on page 39)
- AML Required on Buy Field (on page 39)
- Site AML Allowed Field (on page 40)

General Info Tab Fields - Sites

By default, the site object General Info tab contains the fields listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the site. This field must be filled in with a unique value.</td>
</tr>
<tr>
<td>Type</td>
<td>The subclass (type) of the site object.</td>
</tr>
<tr>
<td>Lifecycle Phase</td>
<td>The current state of the site: Enabled or Disabled.</td>
</tr>
<tr>
<td>Site ERP Code</td>
<td>The ERP system in use at the site, if applicable.</td>
</tr>
<tr>
<td>Address, Geography, Province/Region/State, Country/Area, City, Postal Code, Phone, URL, Fax</td>
<td>Contact information for the site.</td>
</tr>
<tr>
<td>Contact</td>
<td>The name of the contact person for the site.</td>
</tr>
<tr>
<td>Email</td>
<td>The email address of the contact person.</td>
</tr>
<tr>
<td>Buyer</td>
<td>The buyer code for the item at this site. Select one from a list of codes that have been assigned for sites.</td>
</tr>
<tr>
<td>Planner</td>
<td>The planner code for the item at this site. Select one from a list of codes that have been assigned for sites.</td>
</tr>
<tr>
<td>Color</td>
<td>The color associated with this site. Choose from a list of colors. This color will be used on the BOM, Manufacturers, and Affected Items tabs to distinguish common items from site-specific items. The same color can be used for more than one site.</td>
</tr>
</tbody>
</table>
### Field Definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site AML Allowed</td>
<td>For items specified as Buy, indicates whether a site-specific manufacturer value is required, allowed, or disallowed.</td>
</tr>
<tr>
<td>AML Required on Buy</td>
<td>Indicates whether a manufacturer value is required for an item when the item is specified as a Buy (as opposed to a Make) for this site. Whether an item is Buy or Make is shown by the Make/Buy field on the Sites tab of the item.</td>
</tr>
</tbody>
</table>

See also: Site Objects (on page 37), Site Lifecycle Phase (on page 39), AML Required on Buy Field (on page 39), Site AML Allowed (see “Site AML Allowed Field” on page 40).

### Site Lifecycle Phase

- A site can be in one of the following states, as indicated in the Lifecycle Phase field on the site’s General Info tab:
  - **Enabled** – When a site is enabled, users can define all site properties of the site itself. Also, users can associate the site with an item, define item-site properties, create site-specific BOMs and AMLs, and create changes for site-specific items.
  - **Disabled** – All sites are disabled when they are first created. When a site is disabled, users cannot create site-specific BOMs, AMLs, or changes. However, disabled sites do show up in searches and reports. Any in-process changes that involve a site that’s been disabled are allowed to continue through release, but users will not be able to edit the disabled site’s site-specific Affected Item table rows, and users cannot make any redline add or redline edit modifications to in-process changes when the site has been disabled.

To change a site’s lifecycle phase, select a lifecycle phase from the drop-down list.

See also: General Info Tab Fields - Sites (on page 38).

### AML Required on Buy Field

The AML Required on Buy field of a site determines whether an AML is required for an item when the item is specified as a Buy for a given site.

**Note** Whether an item is specified as a Buy is determined by the value in the Make/Buy field on the item’s Sites tab.

When an item is released, the system checks to see which sites the item is being released for, as indicated on the Affected Items tab of the releasing change. The system then checks the Make/Buy field on the item’s Sites tab to determine if any of the sites are specified as Buy. If an item is specified as a Make for all sites, this rule is ignored.

Possible AML Required on Buy values are Yes or No (the default)

- **No** – The system checks to see if the item being released has either a common AML or an AML that is specific for the sites that are specified as Buy sites for the item. At time of release, the system does not check if the item does not have an AML for the site. The item can still be released.
- **Yes** – The item being released must have either a common AML or an AML that is specific to the sites that are specified as Buy sites for the item.

When AML Required on Buy is set to Yes, if an autopromotion attempts to release the item (via a change), but the item does not have a site-specific AML for the appropriate sites, the promotion...
fails, and the appropriate person is notified.

See also: General Info Tab Fields - Sites (on page 38).

Site AML Allowed Field

This field, used when the item is specified as a Buy for a given site, governs whether an AML for an item:

- Must be specific for the site
- Can be modified for a specific site
- Can use only the common site AML

Note Whether an item is specified as a Buy for a given site is determined by the value in the Make/Buy field on the item’s Sites tab.

When an item is released, the system checks to see which sites the item is being released for, as indicated on the Affected Items table of the releasing change. The site’s Site AML Allowed field is then checked to determine if any of these sites are required or allowed to have a site-specific AML.

Possible Site AML Allowed values are Allowed (the default), Required, and Disallowed:

- **Allowed** – The item being released is allowed to have a site-specific AML for the site, but it is not required. The item can be released.
- **Required** – The item being released must have a site-specific AML for the sites specified as Buy sites for the item. The item cannot be released until this condition is satisfied.
  
  If an auto-promotion attempts to release the item (via a change), but the item does not have a site-specific AML for the appropriate sites, the promotion fails, and the appropriate person is notified.
  
  - **Disallowed** – The item being released cannot have a site-specific AML for the site. If the item has a site-specific AML, it cannot be released.

  If an autopromotion attempts to release the item (via a change), and the item includes a site-specific AML, the promotion fails, and the appropriate person is notified.

If a site-specific AML is created for an item (through modification to the AML or redline of the AML), when the item is released, the system checks the Site AML Allowed field of the sites to determine if any of the sites have Site AML Allowed set to Disallowed. If a site is disallowed, you cannot release a site-specific AML for that site.

See also: General Info Tab Fields - Sites (on page 38).

Attachments Tab

All objects have an Attachments tab. On the Attachments tab, you can attach files and URLs to the object by referencing those files and URLs in a file folder object. On the Attachments tab, you can view, copy (get), or print attached files if you have the appropriate privileges.

Individual attached files are stored in file folder objects and can be attached to multiple objects. The files in a file folder object can be drawings or scanned images, documents, non-viewable files, compressed files, and so on.
For detailed information about working with file folder objects and the Attachments tab, see *Getting Started with Agile PLM*.

See also: [Site Objects](#) (on page 37).

## History Tab

The History tab shows a summary of actions taken against an object, including a description of the action, which user took the action, the date of the action, and other details.

**Note** If you do not have the appropriate Read privilege for an object, you cannot see the contents of the fields on the History tab. See [Details about Discovery and Read Privileges](#) (on page 177).

The types of actions recorded for sites are:
- Creating the site
- Attachment actions: view, open, add, delete, and get
- Save As
- Send
- Print
- Change subclass
- Modification of any field of a site

See also: [Site Objects](#) (on page 37).

## Creating Sites

This section includes the topics:
- [Creating Manufacturing Sites](#) (on page 42).
- [Creating a Site Using the Save As Feature](#) (on page 42).

To create a site, you must have the Create Site privilege.

In Java Client, you can create a site with the File | New | Site command or the New Object button, or the Save As command, on the More Actions menu (click the More button at the top of the object window) and on the right-click shortcut menu.

In Web Client, you can create a site with the Create | Site command or the Actions | Save As command.

**Note** The site name must be unique to a site, just as an item number must be unique to an item.

Choose a color to make it easier to distinguish common items from site-specific items on the BOM, Manufacturers, and Affected Items tabs. In Java Client, the site colors also appear on the item Where Used tab and Changes tab. For more information about site colors.
When you create a site, you automatically have access to information specific to that site. The new site is included in the Sites field in your user profile.

**Creating Manufacturing Sites**

The process for creating new objects involves two main steps: creating an empty object, then filling in the object tabs with information specific to the object. For more information about creating sites and other objects, see *Getting Started with Agile PLM*.

See also: [Creating Sites](on page 41).

**Creating a Site Using the Save As Feature**

Using the Save As feature is a quick way to create a site that is similar to an existing site.

All General Information and Page Two field values and Page Three (depending on Agile system settings) field values are copied to the new site. The new site’s lifecycle phase is Disabled. The Attachments are created using the preferred method selected by the Agile administrator (Create New, Reference Existing, Do Not Copy Files, or by prompting; see also [Creating an Item Using Save As](on page 20)). The History tab of the original site reflects that the new site was copied from it.

For more information about creating a site using Save As, see *Getting Started with Agile PLM*.

See also: [Creating Sites](on page 41).

**Associating a Site with an Item**

This section includes the following topics:

- [Fields on the Sites Tab](on page 42)
- [Adding Sites to the Sites Tab](on page 43)
- [Removing Sites from the Sites Tab](on page 44)

To make an item available to site-specific BOMs, you must add the sites to the item’s Sites tab. If a site is not listed on an item’s Sites tab, you cannot define a site-specific BOM or AML for the item. A site can be listed only once on the Sites tab.

The Sites tab is not under change control, so you don’t need to create a change to modify the information on this table.

**Fields on the Sites Tab**

The following table lists default fields on the Sites tab of items.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Name</td>
<td>The name of the site. Not editable from the Sites tab.</td>
</tr>
<tr>
<td>Buyer</td>
<td>The buyer code for the item at this site. Select one from a list of codes that have been assigned for sites.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planner</td>
<td>The planner code for the item at this site. Select one from a list of codes that have been assigned for sites.</td>
</tr>
<tr>
<td>Make/Buy</td>
<td>Indicates whether this site makes or buys the item.</td>
</tr>
<tr>
<td>Cost</td>
<td>Yes or No. Indicates, for this site, whether there is a cost associated with the item.</td>
</tr>
<tr>
<td>Quote As</td>
<td>Select from list. Indicates, for this site, how the item is to be quoted, for example, assembly or component.</td>
</tr>
<tr>
<td>Currency</td>
<td>Default currency for this site.</td>
</tr>
<tr>
<td>Standard Cost</td>
<td>This site's standard cost for the item.</td>
</tr>
<tr>
<td>Target Cost</td>
<td>This site's target cost set for the item.</td>
</tr>
<tr>
<td>First Released</td>
<td>The change that first released the item to this site. This is automatically filled in when the item is released. Not editable from the Sites tab.</td>
</tr>
<tr>
<td>Site Lifecycle Phase</td>
<td>The current state of the site: Enabled or Disabled. Not editable from the Sites tab.</td>
</tr>
<tr>
<td>Site Type</td>
<td>The subclass of the site. Not editable from the Sites tab.</td>
</tr>
</tbody>
</table>

See also: Adding Sites to the Sites Tab (on page 43), Removing Sites from the Sites Tab (on page 44).

### Adding Sites to the Sites Tab

When you add sites to the Sites tab of an item, you select the sites from a list. That list includes all enabled sites that you have access to—sites with a lifecycle phase of Enabled that are included in the Sites field of your user profile. Disabled sites do not appear in the list because disabled sites cannot be added to the Sites tab of an item.

After you add a site to the Sites tab of an item, you can select the site on the Sites table and edit it to enter values for the other fields in the Sites table. You cannot change the Site Name value in the Sites table; to change which site is listed, delete the site and add a new one.

**To add a site to the Sites tab in Java Client:**

1. On the Sites tab of an item, you can use the Add button in two ways:
   - Click the Add button + to display dialog box that allows you to select multiple sites. When you have made your selections, click OK.
   - Click the drop-down arrow portion of the add button + to select the site name you want in the drop-down list.

**To add a site to the Sites tab in Web Client:**

1. On the Sites tab of an item, click the Add button. The selection dialog appears.
2. Move the sites you want to include from the Available Values list to the Selected Values list. When you are finished, click OK

See also: Removing Sites from the Sites Tab (on page 44).
Removing Sites from the Sites Tab

You can remove a site from an item’s Sites tab, as long as the item has not been released to that site and you have the appropriate privileges. Deleting a site from the Sites tab does not delete the site object from the database.

If you try to remove a site that is referenced by a site-specific BOM or AML, the system displays a warning; removing such a site also removes the corresponding site-specific BOMs and AMLs and site-specific Affected Item table rows and site-specific redlines on changes.

To remove a site from an item’s Sites tab in Java Client:
1. Select the site that you want to remove.
2. Click the Remove button on the Sites tab.

To remove a site from an item’s Sites tab in Web Client:
1. Select the site that you want to remove.
2. Click the Remove button on the Sites tab.

See also: Adding Sites to the Sites Tab (on page 43).

Deleting Site Objects

For important details about deleting site objects, see Deleting Agile Objects (on page 23).

Editing Sites

Any user with the necessary privileges can modify values entered for a site. Sites are not required to go through the change control process; all modifications go into effect immediately.

To edit a site in Java Client:
1. Display the site’s General Info tab.
2. Make the changes you want.
3. Click Save.

To edit a site in Web Client:
1. Display the site’s General Info tab.
2. Click Edit.
3. Make the changes you want.
4. Click Save.

Keep the following in mind regarding some of the fields on the General Info tab:

- **Name** – If you change a site name, the change is made to the Sites tab of the items where the site is listed and to any other tabs where the site is listed, such as the BOM tab. You cannot
change the site name to the same name as another site.

- **Buyer or Planner** – A buyer or planner cannot be removed if listed on the Site table of an item.
- **AML Required on Buy and Site AML Allowed** – If you edit AML Required on Buy or Site AML Allowed, released items are not affected. The new values are enforced with any new items and newly released changes.

See also: [Creating Sites](on page 41).

### Printing Sites

You can print object tabs and other data from your Agile PLM system. You can print the current tab or all tabs. Attachments are printed from their native applications or the Viewer.

In Java Client, with the object open, use the Print button 📓.

In Web Client, with the object open, choose **Actions | Print**.

For additional information about printing objects, see [Getting Started with Agile PLM](on page 41).
Chapter 3
Manufacturing Objects

This chapter includes the following:

- What Is Agile AML? ................................................................. 47
- Setting Up Manufacturing Data....................................................... 49
- Manufacturing Objects: Manufacturers and Manufacturer Parts ................................................................. 50
- Creating and Managing Manufacturing Objects .......................................................................................... 54
- Deleting Manufacturing Objects .......................................................... 62
- Manufacturers Tab of an Item ............................................................ 64
- Viewing AML Information by Site ................................................ 63
- Associating a Manufacturer Part with Its Corresponding Item ................................................................. 64
- Important Considerations When Working with Manufacturing Objects .................................................. 65
- Working with Manufacturing Data on Preliminary Items ............................................................................... 65
- Modifying Manufacturing Data from the Redlines Tab ............................................................................. 67
- Printing Manufacturing Objects and AMLs ................................................................................................... 72

What Is Agile AML?

This section covers the following topics:

- What Does Agile AML Do? (on page 47)
- About Manufacturing Objects (on page 48)
- Many-to-One Relationships in Agile AML (on page 48)

The Agile Approved Manufacturers List (AML) solution enables an organization to manage information related to manufacturers and the parts they produce.

What Does Agile AML Do?

Agile PLM provides a way to track the relationships between items and their manufacturers and to create an approved manufacturers list (AML). This means you can quickly find, for instance, which manufacturers are producing a particular part, their identification information for that part, where that part is used, and contact information for the manufacturer.

An item’s AML is represented by the rows of information on the Manufacturers tab of the item. Each row represents a manufacturer part. See Manufacturers Tab of an Item (on page 63).

Additionally, you can use manufacturer change orders (MCOs) to change manufacturing data.

Note To change site-specific manufacturing data, use a site change order (SCO).
About Manufacturing Objects

The AML features let you work with the following manufacturing objects:

- The **manufacturer** – this object holds data about product manufacturers, including contact information and where their parts are used in your assemblies.

- The **manufacturer part** – this object describes product parts from the manufacturers’ point of view, with information such as their part numbers and their names for that part, as well as information about where this part is used in your assemblies and which manufacturing sites use this manufacturer part.

For more information about manufacturing objects, see Manufacturing Objects: Manufacturers and Manufacturer Parts (on page 50).

Many-to-One Relationships in Agile AML

AML capabilities allow you to track complex, many-to-one relationships. The following figure shows an example of a more complex situation such as those commonly found in real-life manufacturing.

In this example, one part has more than one manufacturer part, and some manufacturers provide more than one manufacturer part.

**Note**

Depending on the Agile Administrator setting for the Multiple Items Per Manuf Part SmartRule, your Agile PLM system may be configured so that a manufacturer part can be added to the Manufacturers tab of only one item. Contact the Agile administrator if you have questions about manufacturer parts associated with multiple items.
Sites and AML Data

A manufacturer part can apply to all manufacturing sites where the product is built, some sites, or just one site. The common portion of the AML lists AML information that is shared between all the sites assigned to the item. Each site can add other manufacturing information to the AML table that is site-specific—for example, manufacturers that are used by the site because they’re located nearby. Also, a manufacturer part may be Preferred at one site and Alternate at another site. Manufacturer parts used by multiple sites are listed multiple times on the AML tab, once for each site.

The AML Required on Buy field of a site determines whether a manufacturer part is required for an item when the item is specified as a Buy for a given site. For more information about AML Required on Buy, see AML Required on Buy Field (on page 39).

Note Whether an item is specified as a Buy is determined by the value in the Make/Buy field on the item’s Sites tab.

Setting Up Manufacturing Data

To track manufacturing data in Agile PLM, you must first set up the manufacturers in your database and then create the manufacturer parts that they produce for use in your assemblies.

Order is important. You cannot create a manufacturer part until you have created the corresponding manufacturer.

The process is performed in the following sequence:

1. Create the manufacturer.
   For example, create a manufacturer named Acme.

2. Create the manufacturer part.
   Create manufacturer part number AM230PS, specifying Acme as the manufacturer.

3. Add the manufacturer part to the internal part’s Manufacturers tab.
   For example, on part P001232, go to the Manufacturers tab and add Acme AM230PS.

Once the relationships have been established, it is easy to track manufacturing data activity.

From this point on, manufacturing data can be managed through the redlining process. This is discussed in Redlining through ECOs, MCOs, and SCOs (on page 125).

Note Manufacturing objects are not subject to the change control process and can be created, edited, and deleted by any user granted the necessary privileges. Those changes go into effect immediately.

To set up manufacturer data in the database:

1. Create the manufacturer. This represents the manufacturer of the purchased part.
   See Creating and Managing Manufacturing Objects (on page 54).

2. Create the manufacturer part. This represents the part that the manufacturer produces.
   See Creating and Managing Manufacturing Objects (on page 54).
3. Match the manufacturer part to the corresponding item by adding it to the item’s Manufacturers tab.
   See Adding a Manufacturer Part to the Manufacturers Tab (on page 65).

Manufacturing Objects: Manufacturers and Manufacturer Parts

This section covers the following topics:
- Manufacturing Object Tabs (on page 50)
- About Manufacturers (on page 52)
- About Manufacturer Parts (on page 53)

Manufacturing Object Tabs

Manufacturing objects have several of the same tabs as items (Where Used, Attachments, and History), but they also have differences. For example, they have a General Info tab in place of the Title Block tab, and they do not have a Changes or BOM tab.

The Agile administrator may have added additional sections (Web Client) or tabs (Java Client), called Page Two and Page Three by default. These sections or tabs contain custom fields defined by the administrator.

<table>
<thead>
<tr>
<th>Manufacturers</th>
<th>Manufacturer parts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tab</strong></td>
<td><strong>Fields include</strong></td>
</tr>
<tr>
<td>General Info</td>
<td>Name, Lifecycle Phase, Mfr. Type, Contact, URL, D-U-N-S Number, contact information</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following fields are related to Agile PG&C. For more information, see the Agile Product Governance and Compliance User Guide.
Manufacturers

Tab | Fields include |
---|---|
Where Used tab (on page 51) | Item Number, Item Description, Mfr. Part Number, Mfr. Part Lifecycle Phase |

Manufacturer parts

Tab name | Fields include |
---|---|
Where Used tab (on page 51) | Where Used table includes: Item Sites, Item Number, Item Description, Mfr. Tab Preferred Status, Mfr. Tab Reference Notes Pending Change Where Used table also includes: Pending Change |

Attachments tab | Attachment Number, Attachment Description, File Name, File Version, File Size, File Type, Modified Date, Last View Date, Checkout User, Checkout Date, Checkout Folder |

History tab | Action, User, Local Client Time, User Action Time (optional), Comments, Details |

Prices tab | This tab relates to Agile PCM. For more information, see the Product Cost Management User Guide. |

Compliance tab | These tabs relate to Agile PG&C. For more information, see Agile Product Governance and Compliance User Guide. |

Suppliers tab | |

**Where Used Tab**

The manufacturer **Where Used** tab lists all the manufacturer part numbers for the manufacturer and the items that use the manufacturer parts. The information on this tab is filled in automatically.

The manufacturer part **Where Used** tab lists all the items that use the manufacturer part. The information on this tab is filled in automatically.

The **Where Used** tab includes two tables:

- **Where Used** — displays the latest released revision of the items where the manufacturer part is used.
Pending Change Where Used — displays the pending revisions of the items where the manufacturer part is used, including the associated change order number.

To view or hide the Pending Change Where Used table:

Use the View drop-down list to select either Show Pending or Hide Pending.

Note When you first view the Where Used tab, the Pending Change Where Used table is hidden by default.

To view an item from the Where Used tab using Java Client:

Double-click the item’s row.

To view an item from the Where Used tab using Web Client:

Click the item number.

Sites and the Manufacturer Part Where Used Tab

When you view the Where Used tab of a manufacturer part, the table displays where-used information according to item number and manufacturing site. Click the Item Sites column header to sort the table by site.

See also: How Sites Work (on page 35).

Manufacturer Part Prices Tab

Note If your company has the necessary licenses, and you have been granted the necessary privileges, you can perform the Prices tab processes described here.

The Prices tab displays the price information for this manufacturer part. The information on this tab is filled in automatically. Click the price object number (in the Number column) to open that price object. For more information see the Product Cost Management User Guide.

Where Used Tab and the Discovery Privilege

If you do not have Discovery privilege for an item, site, or manufacturing object, it does not appear on the Where Used tab. The Agile administrator can specify whether or not to display a warning message telling you how many objects are not displayed. (For sites, this applies only to the Where Used tab of manufacturer parts. The Where Used tab of manufacturers does not include a column for site information.) For more information, see Details about Discovery and Read Privileges (on page 177).

Read Privilege

Your Read and Enforce Field Level Read privileges determine which fields you are able to view. For more information, see Details about Discovery and Read Privileges (on page 177).

About Manufacturers

Manufacturer objects contain information about manufacturers with which your organization collaborates.
Creating a manufacturer is the first step in adding a new manufacturer part to the Agile PLM database. After you create the manufacturer, create the manufacturer part in association with that manufacturer. When you then associate the manufacturer part with an item, the manufacturer part is referenced on the manufacturer’s Where Used tab.

You can modify a manufacturer object directly at any time, if you have the necessary privileges. Manufacturers are not under change control.

To find manufacturers in your Agile PLM database, use the same search process as you use for any other object. For more information about searches, see Getting Started with Agile PLM.

See also: Lifecycle Phase of a Manufacturer (on page 53), D-U-N-S Number (on page 53).

**Lifecycle Phase of a Manufacturer**

The lifecycle phase field on the General Info tab of the manufacturer object indicates its lifecycle phase. The following table lists the default manufacturer lifecycle phases. The Agile administrator may define a customized list of lifecycles for your Agile PLM system.

<table>
<thead>
<tr>
<th>Lifecycle name</th>
<th>Lifecycle definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>This is an approved manufacturer.</td>
</tr>
<tr>
<td>Disqualified</td>
<td>This manufacturer is no longer qualified for use.</td>
</tr>
<tr>
<td>Obsolete</td>
<td>This manufacturer is no longer available for use.</td>
</tr>
</tbody>
</table>

See also: Lifecycle Phase of a Manufacturer Part (on page 54).

**D-U-N-S Number**

The D-U-N-S Number field allows companies to list the DUNS of their suppliers in the system.

D-U-N-S stands for Data Universal Numbering System. A D-U-N-S number is a unique nine-digit sequence that identifies an organization.

See also: Manufacturing Object Tabs (on page 50).

**About Manufacturer Parts**

The manufacturer part object displays information about a part produced by a specific manufacturer, including the manufacturer’s part number, lifecycle phase, where it is used, and a history of actions affecting that manufacturer part.

The combination of the manufacturer name and manufacturer part number must be unique to that manufacturer part. In other words, you cannot create another manufacturer part for the same manufacturer using the same manufacturer part number. Agile PLM does support the situation in which different manufacturers are using an identical part number, however.

You can modify a manufacturer part object directly at any time, if you have the necessary privileges. Manufacturer parts are not under change control.

To find manufacturer parts in your Agile PLM database, use the same search process as you use for any other object. For more information about searches, see Getting Started with Agile PLM.

After you create a manufacturer part, you can add it to the Manufacturers tab of the Agile part to
which it corresponds. For more information about working with manufacturer parts, see Creating and Managing Manufacturing Objects (on page 54).

**Lifecycle Phase of a Manufacturer Part**

The lifecycle phase field on the General Info tab of the manufacturer part object indicates its lifecycle phase. The following table lists the default manufacturer part lifecycle phases. The Agile administrator may define a customized list of lifecycles for your Agile PLM system.

<table>
<thead>
<tr>
<th>Lifecycle name</th>
<th>Lifecycle definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>This manufacturer part is available for use.</td>
</tr>
<tr>
<td>Obsolete</td>
<td>This manufacturer part should no longer be used.</td>
</tr>
</tbody>
</table>

See also: Lifecycle Phase of a Manufacturer (on page 53).

**Creating and Managing Manufacturing Objects**

This section covers the following topics:

- Creating Manufacturers (on page 54)
- Creating Manufacturer Parts (on page 56)
- Modifying Manufacturing Objects (on page 62)

**Creating Manufacturers**

In Java Client, you can create a manufacturer with the File | New | Manufacturers command or with the New Object button, or the Save As command, on the More Actions menu (click the More button at the top of the object window) and on the right-click shortcut menu.

In Web Client, you can create a manufacturer with the Create | Manufacturers command or the Actions | Save As command.

Unlike items, manufacturers do not need to go through the release process. They are immediately available for use.

*Note* The manufacturer name must be unique to one manufacturer, just as an item number must be unique to an item.

Although different manufacturers can use the same manufacturer part number, the combination of manufacturer plus manufacturer part number must be unique to one manufacturer part.

The process for creating new objects involves two main steps: creating an empty object, then filling in the object tabs with information specific to the object.

**To create and complete a manufacturer using Java Client:**

1. Choose File | New | Manufacturers.
2. In the New dialog box, use the Type drop-down list to select the type (subclass) of manufacturer you want to create.
2. Type a unique name for the manufacturer.
3. Complete any required fields.
4. Click OK.
   The new manufacturer appears with the General Info tab showing.
5. Fill in information on the manufacturer tabs, as desired.
   You do not enter information on the Where Used and History tabs. Those tabs are completed automatically.

To create a manufacturer using Web Client:
1. Choose Create | Manufacturers.
2. In the New dialog box, use the Type drop-down list to select the type (subclass) of manufacturer you want to create.
3. Type a unique name for the manufacturer.
4. Complete any required fields.
5. To continue using the Create wizard to enter information on each tab of the manufacturer, check the Continue Creation in Wizard checkbox, and click the Continue button. Follow the onscreen instructions to complete the wizard.
6. To create and display the manufacturer immediately, uncheck the Continue Creation in Wizard checkbox and click Finish. The new manufacturer appears with the General Info tab showing. Fill in information on the manufacturer tabs, as desired.

Note Agile PLM remembers your most recent selection for the Continue Creation in Wizard checkbox in any create dialog and it remains preselected for you in the Create dialog box.

See also: Modifying Manufacturing Objects (on page 62).

Creating a Manufacturer Using the Save As Feature

Using the Save As feature is a quick way to create a manufacturer that is similar to an existing manufacturer.

In Java Client, you can create a manufacturer using the File | Save As command, the Save As command on the More Actions menu (click the More button at the top of the object window) or the Save As command on the right-click shortcut menu.

In Web Client, you can create a manufacturer using the Actions | Save As command.

In general, you should not use Save As to create an object in a different class or subclass (type) from the original object. The different classes or subclasses may not have the same tabs or defined fields, and you may lose access to some data in the newly created object.

To create a manufacturer using the Save As command in Java Client:

Select and open an existing manufacturer.
1. Choose File | Save As.
2. If appropriate, select a different manufacturer type (subclass) from the list.
3. Enter the new manufacturer’s name.
4. Complete any required fields.
5. Click OK.
   The new manufacturer opens with the General Info tab on top.

To create a manufacturer using the Save As command in Web Client:
1. Select and open an existing manufacturer.
2. Choose Actions | Save As.
3. If appropriate, select a different manufacturer type (subclass) from the list.
4. Enter the new manufacturer’s name.
5. Complete any required fields.
6. Click Save.
   The new manufacturer opens with the General Info tab on top.

See also: Modifying Manufacturing Objects (on page 62).

Creating Manufacturer Parts

To create manufacturer parts, you must have the Create Manufacturer Parts privilege.

In Java Client, you can create an manufacturer with the File | New | Manufacturer Parts command or with the New Object button . You can also use the File | Save As command when open manufacturer part is open.

In Web Client, you can create a manufacturer part with the Create | Manufacturer Parts command. From an open manufacturer object, you can create a manufacturer part with the Actions | Create Manufacturer Parts command. You can also use the Actions | Save As command from an open manufacturer part.

You can also create a manufacturer part on-the-fly as you add information to the Manufacturers tab of an item.

Unlike items, manufacturer parts do not need to go through the release process. They are immediately available for use.

**Note**  Different manufacturers can use the same manufacturer part number; however, the combination of manufacturer plus manufacturer part number must be unique to one manufacturer part.

See also:
- Manufacturer Part Creation Wizards (on page 57)
- Manufacturer Name Automatic Validation (on page 59)
- Creating a Manufacturer Part Using the Save As Feature (on page 60)
- Modifying Manufacturing Objects (on page 62)
Manufacturer Part Creation Wizards

Wizards lead you through the process of creating a manufacturer part.

This section includes the topics:

- Creating a Manufacturer Part in Java Client (on page 57)
- Creating a Manufacturer Part in Web Client (on page 58)

See also: Creating a Manufacturer Part Using the Save As Feature (on page 60).

Creating a Manufacturer Part in Java Client

To create and complete a manufacturer part using Java Client:

1. Choose File | New | Manufacturer Part.
2. In the New dialog box, use the Type drop-down list to select the type (subclass) of manufacturer part you want to create.
3. Select the manufacturer of the new manufacturer part.
   
   In the Manufacturer Name field, type the manufacturer name or a portion of the manufacturer name. Press the Tab key or click the Validate checkmark:

   ![Java Client ✔, Web Client ✔]

   - If you enter a valid and unique manufacturer name, Agile selects that manufacturer name and the Validate checkmark is disabled. Press the Tab key to continue with the next step.
   - If you did not enter a valid and unique manufacturer name, the resolution dialog appears.
     
     In the resolution dialog, select the manufacturer you want and click OK.
     
     If the manufacturer you want does not appear in the search results, you can perform another search or you can create a new manufacturer:

   - Search – In the resolution dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited manufacturer (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.) In the search results, select the manufacturer you want, and click OK.
   - Create – If you need to create a new manufacturer for the manufacturer part, click the Create link in the Select Objects dialog box. A dialog box opens that allows you to select the manufacturer type (subclass) in the Type drop-down list and enter the manufacturer name. Click OK. The resolution dialog box closes and the newly created manufacturer is selected.

   For further details, see How to Use Manufacturer Name Automatic Validation (on page 59).
4. Type a number for the manufacturer part.
5. Complete any required fields.
6. Click OK.
   
   The new manufacturer part appears with the General Info tab showing.
7. Fill in information on the manufacturer part tabs, as desired.

   You do not enter information on the Where Used and History tabs. Those tabs are completed
Creating a Manufacturer Part in Web Client

To create a manufacturer part using Web Client:

1. Choose Create | Manufacturer Part. (You can also choose Actions | Create Manufacturer Part from within a manufacturer.)

2. In the New dialog box, use the Type drop-down list to select the type (subclass) of manufacturer part you want to create.

3. Select the manufacturer of the new manufacturer part.

   In the Manufacturer Name field, type the manufacturer name or a portion of the manufacturer name. Press the Tab key or click the Validate checkmark:

   Java Client, Web Client:

   - If you enter a valid and unique manufacturer name, Agile selects that manufacturer name and the Validate checkmark is disabled. Press the Tab key to continue with the next step.
   - If you did not enter a valid and unique manufacturer name, the resolution dialog appears. In the resolution dialog, select the manufacturer you want and click OK. If the manufacturer you want does not appear in the search results, you can perform another search or you can create a new manufacturer:

     ▪ Search – In the resolution dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited manufacturer (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.) In the search results, select the manufacturer you want, and click OK.

     ▪ Create – If you need to create a new manufacturer for the manufacturer part, click the Create link in the Select Objects dialog box. A dialog box opens that allows you to select the manufacturer type (subclass) in the Type drop-down list and enter the manufacturer name. Click OK. The resolution dialog box closes and the newly created manufacturer is selected.

   For further details, see How to Use Manufacturer Name Automatic Validation (on page 59).

4. Type a number for the manufacturer part.

5. Complete any required fields.

6. To continue using the Create wizard to enter information on each tab of the manufacturer part, check the Continue Creation in Wizard checkbox, and click the Continue button. Follow the onscreen instructions to complete the wizard.

7. To create and display the manufacturer part immediately, uncheck the Continue Creation in Wizard checkbox and click Finish. The new manufacturer part appears with the General Info tab showing. Fill in information on the manufacturer part tabs, as desired.

   Note Agile PLM remembers your most recent selection for the Continue Creation in Wizard checkbox in any create dialog and it remains preselected for you in the Create dialog box.

   You do not enter information on the Where Used and History tabs. Those tabs are completed automatically.
Manufacturer Name Automatic Validation

Whenever you create a manufacturer part, or add to or edit the table of an item's Manufacturers tab, Agile PLM provides an automatic search and validation process to quickly search for and select the manufacturer you want to specify.

This section includes the topics:

- **Where is Manufacturer Name Automatic Validation Used?** (on page 59)
- **How to Use Manufacturer Name Automatic Validation** (on page 59)

**Where is Manufacturer Name Automatic Validation Used?**

Agile PLM uses automatic manufacturer name validation whenever you create a manufacturer part or you edit manufacturer part information.

With the appropriate privileges, you can create a manufacturer part by using the following Agile PLM features:

- **Object Create**
  - Java Client: File | New | Manufacturer Part or choose More | New Manufacturer Part from
  - Web Client: Create | Manufacturer Part or choose Actions | Create Manufacturer Part from within a manufacturer.

- **Item object Manufacturers tab, Add | Create button.**

- **Change object Affected Items tab, Redline Manufacturers tab, Add | Create button.**

- **Change object Affected Items tab, manufacturer part bulk change process:** (Java Client) Manufacturer Part Bulk Change, (Web Client) Bulk Change | Manufacturer Part.

With the appropriate privileges, you can edit manufacturer part information by using the following Agile PLM features:

- **Item object Manufacturers tab, Edit button.**

- **Change object Affected Items tab, Redline Manufacturers tab, Edit button:** (Java Client), (Web Client)

- **Change object Affected Items tab, manufacturer part bulk change process:** (Java Client) Manufacturer Part Bulk Change, (Web Client) Bulk Change | Manufacturer Part.

**How to Use Manufacturer Name Automatic Validation**

Whenever manufacturer name automatic validation is used, follow these steps:

1. In the **Manufacturer Name** field of the create or edit dialog, type the name of the manufacturer or a portion of the name for which you want to search.

   If you enter a valid and unique manufacturer name, Agile selects that manufacturer name and the Validate checkmark is disabled. Press the Tab key to move to the next field in the dialog.

   **Note** You may leave the **Manufacturer Name** field blank. When the resolution dialog appears, use the search options to search for the manufacturer you want or create a new manufacturer.
For example, if you want to find the manufacturer name Motorola, you can type any of the following text strings to begin your search. Agile performs a Starts With search for any manufacturer name that starts with the letters you typed.

- mot
- motorla
- mo

Note: Agile automatically adds an asterisk character * to the end of the text string.

2. When you move the cursor out of the Manufacturer Name field, the validation process begins and the validation dialog appears. You can move the cursor out of the name field using any of the following methods:
   - Press the Tab key.
   - Click the Validate checkmark in the Manufacturer Name field: Java Client , Web Client.
   - Click another field in the dialog.
   - Attempt to exit the edit dialog by clicking OK (Java Client) or Save (Web Client).
   - Attempt to exit the create dialog by clicking OK (Java Client), or Continue or Finish (Web Client).

3. In the resolution dialog, select a manufacturer name in the search results and click OK. The resolution dialog closes and the selected manufacturer name appears in the Manufacturer Name field of the create or edit dialog.

   If the manufacturer name you want does not appear in the search results, you can:
   - Run another search.
   - Select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.)
   - Create a new manufacturer object.
     Click the Create button in the resolution dialog to create a manufacturer object; see Creating Manufacturers (on page 54).

See also: Where is Manufacturer Name Automatic Validation Used? (on page 59)

Creating a Manufacturer Part Using the Save As Feature

Using the Save As feature is a quick way to create a manufacturer part that is similar to an existing manufacturer part.

Caution: In general, you should not use Save As to create an object in a different class or subclass (type) from the original object. The different classes or subclasses may not have the same tabs or defined fields, and you may lose access to some data in the newly created object.

To create a manufacturer part using the Save As command in Java Client:

4. Select and open an existing manufacturer part.
5. Choose File | Save As.
6. If appropriate, select a different manufacturer part type (subclass) from the list.
7. Select the manufacturer of the new manufacturer part.

Note If you want to use the same manufacturer, you do not need to modify the Manufacturer Name field.

In the Manufacturer Name field, type the manufacturer name or a portion of the manufacturer name. Press the Tab key or click the Validate checkmark:

Java Client ☑️, Web Client ✓

- If you enter a valid and unique manufacturer name, Agile selects that manufacturer name and the Validate checkmark is disabled. Press the Tab key to continue with the next step.
- If you did not enter a valid and unique manufacturer name, the resolution dialog appears. In the resolution dialog, select the manufacturer you want and click OK.

If the manufacturer you want does not appear in the search results, you can perform another search or you can create a new manufacturer:

- Search – In the resolution dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited manufacturer (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.) In the search results, select the manufacturer you want, and click OK.
- Create – If you need to create a new manufacturer for the manufacturer part, click the Create link in the Select Objects dialog box. A dialog box opens that allows you to select the manufacturer type (subclass) in the Type drop-down list and enter the manufacturer name. Click OK. The resolution dialog box closes and the newly created manufacturer is selected.

For further details, see How to Use Manufacturer Name Automatic Validation (on page 59).

8. Enter the new manufacturer part number.
9. Complete any required fields.
10. Click OK.

The new manufacturer part opens with the General Info tab on top.

11. Make any necessary modifications to the other tabs.

To create a manufacturer part using the Save As command in Web Client:

1. Select and open an existing manufacturer part.
2. Choose Actions | Save As.
3. If appropriate, select a different manufacturer part type (subclass) from the list.
4. Select the manufacturer of the new manufacturer part.

Note If you want to use the same manufacturer, you do not need to modify the Manufacturer Name field.

In the Manufacturer Name field, type the manufacturer name or a portion of the manufacturer name. Press the Tab key or click the Validate checkmark:
Java Client ✔, Web Client ✔

- If you enter a valid and unique manufacturer name, Agile selects that manufacturer name and the Validate checkmark is disabled. Press the Tab key to continue with the next step.

- If you did not enter a valid and unique manufacturer name, the resolution dialog appears.

  In the resolution dialog, select the manufacturer you want and click OK.

  If the manufacturer you want does not appear in the search results, you can perform another search or you can create a new manufacturer:

  ▪ **Search** – In the resolution dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited manufacturer (Shortcuts). (For more information about searches, see *Getting Started with Agile PLM*) In the search results, select the manufacturer you want, and click OK.

  ▪ **Create** – If you need to create a new manufacturer for the manufacturer part, click the Create link in the Select Objects dialog box. A dialog box opens that allows you to select the manufacturer type (subclass) in the Type drop-down list and enter the manufacturer name. Click OK. The resolution dialog box closes and the newly created manufacturer is selected.

  For further details, see [How to Use Manufacturer Name Automatic Validation](on page 59).

5. Enter the new manufacturer part number.

6. Complete any required fields.

7. Click Save.

   The new manufacturer part opens with the General Info tab on top.

8. Make any necessary modifications to the other tabs.

See also: [Creating a Manufacturer Part in Java Client](on page 57), [Creating a Manufacturer Part in Web Client](on page 58).

**Modifying Manufacturing Objects**

Any user with the necessary privileges and licenses can modify information about a manufacturing object. Manufacturing objects are not required to go through the change control process; all modifications go into effect immediately.

**Caution** If you change a manufacturer part number or manufacturer name, these changes are automatically made to the Manufacturers tab of the items where the manufacturer or manufacturer part is listed and to any other tabs where the manufacturer is listed, such as the Where Used tab.

See also: [Creating Manufacturers](on page 54), [Creating Manufacturer Parts](on page 56).

**Deleting Manufacturing Objects**

For important details about deleting manufacturing objects, see [Deleting Agile Objects](on page 23).
Manufacturers Tab of an Item

This section includes the following topics:

- Manufacturers Tab Buttons (on page 63)
- Manufacturers Tab Fields (on page 63)

The Manufacturers tab displays information taken from related manufacturing objects. For more information, see Manufacturers Tab (on page 9).

See also: Working with Manufacturing Data on Preliminary Items (on page 65), Modifying Manufacturing Data from the Redlines Tab (on page 67).

Manufacturers Tab Buttons

The following table lists the buttons on the Manufacturers tab of an item.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Edit](Java Client)</td>
<td>Lets you edit the AML row by displaying the selected rows in edit mode. The editable fields are in the form of text boxes, list boxes, and so on.</td>
</tr>
<tr>
<td>![Remove](Java Client)</td>
<td>Removes the selected rows from the table.</td>
</tr>
<tr>
<td>![Add</td>
<td>Create](Java Client)</td>
</tr>
</tbody>
</table>

See also: Working with Manufacturing Data on Preliminary Items (on page 65).

Manufacturers Tab Fields

The following table lists the default fields on the Manufacturers tab of an item. The Agile administrator may have created additional fields.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mfr.Name</td>
<td>The name of the manufacturer.</td>
</tr>
<tr>
<td>Mfr. Part Number</td>
<td>The number assigned to the manufacturer part by the part’s manufacturer.</td>
</tr>
<tr>
<td>Mfr. Part Description</td>
<td>The description assigned to the manufacturer part by the part’s manufacturer.</td>
</tr>
<tr>
<td>Mfr. Part Lifecycle Phase</td>
<td>Indicates whether the manufacturer is an active manufacturer of the part.</td>
</tr>
<tr>
<td>Preferred Status</td>
<td>Indicates whether the manufacturer is preferred or an alternate for this part.</td>
</tr>
<tr>
<td>Sites</td>
<td>Lists the sites that use the manufacturer part.</td>
</tr>
</tbody>
</table>
### Viewing AML Information by Site

You can view the AML for a specific site by selecting a site from the Site drop-down list above the tabs. Sites included in the list are the ones specified on the item’s Sites tab that are also listed in the Sites field of your user profile.

When you select a site, the Manufacturers tab displays the common AML plus the AML of the site you selected. To view the AML for all sites at once, select ALL in the Site list.

You can perform actions only on the items associated with the selected site. For example, if you select San Francisco in the Site drop-down list, you see all manufacturer parts that are part of the common and San Francisco portions of the AML.

The Rev and Site drop-down lists work independently. For more details, see Working with Item Revisions (on page 13).

### Associating a Manufacturer Part with Its Corresponding Item

After you have created a manufacturer and a manufacturer part, you associate them with a part in the Agile PLM system. You do this by adding the manufacturer part to the Manufacturers tab of the Agile part only for preliminary items. Otherwise, this requires a change through an MCO, ECO, or SCO. This establishes the link between “your” part and “their” part, which makes it possible to track their part’s use throughout the system.

You can list more than one manufacturer part from the same manufacturer, or from more than one manufacturer. For example, if a manufacturer makes two parts that you sometimes use for that assembly, you can mark one as Preferred and the other as Alternate. (You can do the same thing if two different manufacturers supply a part.)

**Note**
If you want a manufacturer part to apply to a specific site, before adding the manufacturer part to the Manufacturers tab, select that site from the Site drop-down list above the tabs.

Depending on the state of an item (and your licenses and privileges), you can modify Manufacturers tab data by one of these methods:

- Add or modify directly on the Manufacturers tab of items. This method is for preliminary items.
Important Considerations When Working with Manufacturing Objects

Once a manufacturing object has been used on an item’s Manufacturers tab, any alterations you make to the manufacturing object are also made on that item’s Manufacturers tab. Because manufacturing objects are not required to go through the change control process, all modifications that are made go into effect immediately. Because these alterations are not made by means of a change, they won’t be passed to the ERP system by ChangeCAST or Agile Content Service. To avoid potential problems between the Agile PLM and ERP systems, it is important to bear this in mind when making changes to any manufacturing object that is in use on an item’s Manufacturers tab.

See also: Modifying Manufacturing Data from the Redlines Tab (on page 67).

Working with Manufacturing Data on Preliminary Items

The following sections describe how to modify data directly on the Manufacturers tab of an item has not been released and does not have a pending revision:

- Adding a Manufacturer Part to the Manufacturers Tab (on page 65)
- Deleting a Manufacturer Part from the Manufacturers Tab (on page 66)
- Modifying a Manufacturer Part on the Manufacturers Tab (on page 67)

Adding a Manufacturer Part to the Manufacturers Tab

You can add manufacturer parts to the Manufacturers tab of an item.

To add a manufacturer part to the Manufacturers tab in Java Client:

1. On the Manufacturers tab, select the site for which you want to add the manufacturer part from the Site drop-down list.
2. In the Add button drop-down list, choose either Add | Create or Add | Search.
3. If you chose Add | Create:
   a. Fill in the required information in the New dialog box. See Creating Manufacturers (on page 54).
      If you enter information for a manufacturer part that already exists, Agile displays a prompt asking if you want to use the existing manufacturer part when you click OK in step c.
   b. If you have not already done so, select the site to which you want to associate the manufacturer part for this item. Select Common if you want to associate the manufacturer part with no pending ECOs or MCOs. See Adding a Manufacturer Part to the Manufacturers Tab (on page 65).

   Use an ECO, MCO, or SCO to modify manufacturing data on the redlines tab. This method is for released items or items with pending ECOs or MCOs. See Adding a Manufacturer Part on the Redline Manufacturers Tab (on page 69).
part with this item for all sites assigned to this item.

c. Click OK.

4. If you chose **Add | Search**:  
   a. In the Select Objects dialog box, select a search method to search for an existing manufacturer part, or select a bookmarked or recently visited manufacturer part (Shortcuts). If you choose to perform a simple search, enter the value to search for. (For more information about searches, see *Getting Started with Agile PLM*.)
   
   b. If you have not already done so, select the site to which you want to associate the manufacturer part for this item. Select Common if you want to associate the manufacturer part with this item for all sites assigned to this item.
   
   c. Click OK.

**To add a manufacturer part to the Manufacturers tab in Web Client:**

1. On the Manufacturers tab, select the site for which you want to add the manufacturer part from the Site drop-down list.

2. In the Add button drop-down list, choose either **Add | Create New** or **Add | Search**.

3. If you chose **Add | Create New**:
   a. Fill in the required information in the New dialog box. See *Creating Manufacturers* (on page 54).
   
   If you enter information for a manufacturer part that already exists, Agile displays a prompt asking if you want to use the existing manufacturer part when you click OK in step c.
   
   b. If you have not already done so, select the site to which you want to associate the manufacturer part for this item. Select Common if you want to associate the manufacturer part with this item for all sites assigned to this item.
   
   c. Click OK.

4. If you chose **Add | Search**:
   a. In the Add Manufacturer Parts dialog box, select a search method to search for an existing manufacturer part, or select a bookmarked or recently visited manufacturer part (Shortcuts). If you choose to perform a simple search, enter the value to search for. (For more information about searches, see *Getting Started with Agile PLM*.)
   
   b. If you have not already done so, select the site to which you want to associate the manufacturer part for this item. Select Common if you want to associate the manufacturer part with this item for all sites assigned to this item.
   
   c. Click OK.

See also: *Modifying Manufacturing Data from the Redlines Tab* (on page 67).

**Deleting a Manufacturer Part from the Manufacturers Tab**

**To delete a manufacturer part from the Manufacturers tab of an item still in the Preliminary state in Java Client:**

1. On the Manufacturers tab, select the manufacturer part row to be deleted.

2. Click the Remove button on the Manufacturers tab.
Caution  Be sure to use the Remove button on the Manufacturers tab, not the Delete button in the item window. If you use the Delete button, the entire item is deleted.

To delete a manufacturer part from the Manufacturers tab of an item still in the Preliminary state in Web Client:

3. On the Manufacturers tab, select the manufacturer part row to be deleted.

4. Click the Remove button on the Manufacturers tab.

Caution  Be sure to use the Remove button on the Manufacturers tab, not the Delete button in the item window. If you use the Delete button, the entire item is deleted.

See also: Modifying Manufacturing Data from the Redlines Tab (on page 67).

Modifying a Manufacturer Part on the Manufacturers Tab

You can directly edit manufacturer part information from the Manufacturers tab of an item if the item is in the preliminary state, has never been released, and has no pending ECOs or MCOs against it.

To edit values for a manufacturer part in Java Client:

1. Open the item to be edited.

2. On the Manufacturers tab, select the rows that you want to edit.

3. Click the Edit button, and change the data as necessary in the Edit dialog box.
   You can use the navigation buttons in the open Edit dialog box to select other rows to edit.

4. Click OK.

To edit values for a manufacturer part in Web Client:

1. Open the item to be edited.

2. On the Manufacturers tab, select the rows that you want to edit.

3. Click Edit, and change the data as necessary.

4. Click Save.

See also: Modifying Manufacturing Data from the Redlines Tab (on page 67).

Modifying Manufacturing Data from the Redlines Tab

If you have the appropriate privileges and Agile system SmartRule settings allow it, you can modify AML information through the Redline Manufacturers tab of an ECO, MCO, or SCO.

This section contains the following topics:

- Overview of Redlining Manufacturing Data (on page 68)
- Redline Manufacturers Tab (on page 68)
- Adding a Manufacturer Part on the Redline Manufacturers Tab (on page 69)
- Adding Nonexistent Manufacturer Parts on the Redlines Tab (on page 70)
Overview of Redlining Manufacturing Data

On some systems, depending on how the Agile administrator has configured settings, you can make redline changes from ECOs, SCOs, and MCOs. MCOs can redline only manufacturer parts data; ECOs can redline manufacturer parts data, BOMs, and attachments; SCOs can redline manufacturer parts data and BOMs for specific sites only.

MCOs and SCOs do not advance, or roll, the revisions of the affected items; ECOs do.

Redlining manufacturing data from an ECO or SCO is the same as the process from an MCO. However, because you can use ECOs to redline manufacturing data, BOMs, or attachments, the ECO redlines include a Redline BOM tab, a Redline Manufacturers tab, and an Redline Attachments tab. The SCO redlines include a Redline BOM tab and a Redline Manufacturers tab.

Note: If a change includes conflicting redlines made from multiple manufacturing sites, those conflicting redlines are removed from the BOM and Manufacturers table for all associated sites.

For more information about changes, see the chapter Changes (on page 109).

Redline Manufacturers Tab

You display the Redline Manufacturers tab from the Affected Items tab of an ECO, MCO, or SCO.

To open the redlines for an item’s AML in Java Client:

1. Open the change through which you want to redline an item’s AML.
2. In the Affected Items table, select the item you want to redline.
   The View drop-down list has two settings: Hide Sites and Show Sites. When you select Hide Sites, the items are listed once on the Affected Items table. When you select Show Sites, the items are listed multiple times, once for each site. Simply select one row in the table; if needed, you can select a different site setting on the Redline Manufacturers tab.
3. In the bottom pane of the Affected Items tab, display the Redline Manufacturers tab.
4. In the Site drop-down list, select the site for which you want to redline manufacturer part information. Select ALL to redline manufacturer part information for all the item’s sites.
5. Select a row in the Redline Manufacturers table and use the buttons to make the modifications you want. See the following table for details.

<table>
<thead>
<tr>
<th>Java Client button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redline Manufacturer</td>
<td>Displays the selected row in the Redline Manufacturer dialog box so that you can redline editable fields. Use the buttons in the upper left corner to view and edit other rows in the table. Click OK when you are finished.</td>
</tr>
</tbody>
</table>
Java Client button | Action
--- | ---
>Add | Create | Lets you redline-add a manufacturer part to the item.
>Add | Search | 

Remove | Redline-deletes the selected rows from the Redline Manufacturers table.

Undo Redlines | Clears the redlines from the selected rows. See Undoing Changes to the Redline Manufacturers Tab (on page 71).

To open the redlines for an item’s AML in Web Client:

1. Open the change through which you want to redline an item’s AML.
2. On the Affected Items tab of the change, click the Do Redlining icon in front of the item for which you want to view or create redlines. If the item has already been redlined, click the icon to view the redlines or to create additional redlines.
   The redline tabs for this item are displayed.
3. Click the Redline Manufacturers tab to display it, if it is not displayed.

Select a row in the Redline Manufacturers table and use the buttons to make the modifications you want. See the following table for details.

Web Client button | Action
--- | ---
Edit | Displays the selected rows in edit mode so that you can redline editable fields.
Delete | Redline-deletes the selected rows from the Redline Manufacturers table.
Undo Redlines | Clears the redlines from the selected rows. See Undoing Changes to the Redline Manufacturers Tab (on page 71).
Add | Create New | Lets you redline-add a manufacturer part to the item.
Add | Search | 

If a row in the table has a red line through every cell, it means that manufacturer part was deleted from the Manufacturers table. If just a few of the cells have a short red line through them, it means the manufacturer part was modified. Any cell that was modified has a red line through the old value; the new value appears in red.

See also: Changes (on page 109), Affected Items of Changes (on page 129).

**Adding a Manufacturer Part on the Redline Manufacturers Tab**

To add a manufacturer part to the Redline Manufacturers tab:

1. Follow the instructions in Redline Manufacturers Tab (on page 68).
2. When the Manufacturers Redline tab is displayed, use the Add button drop-down list to choose
Add | Search to search for a manufacturer part.

3. Continue as described in Adding a Manufacturer Part to the Manufacturers Tab (on page 65).

Adding Nonexistent Manufacturer Parts on the Redlines Tab

Use the Add button drop-down list to choose Add | Create (Java Client) or Add | Create New (Web Client) to create a new manufacturer part to add to the Manufacturers tab. If you use this option, you must also select a manufacturer from a list of existing manufacturers or, if needed, create a new manufacturer. See Adding a Manufacturer Part to the Manufacturers Tab (on page 65).

Deleting a Manufacturer Part from the Redlines Tab

Redline-deleting a manufacturer part has these behaviors:
- If the selected row is red, redline-deleting it removes the row.
- If the selected row is black, redline-deleting it puts a red line through the row.

To delete a manufacturer part in Java Client:
1. Select the row to delete.
2. Click the Remove button on the Redline Manufacturers tab.

To delete a manufacturer part in Web Client:
1. Select the row to delete.
2. Click the Delete button on the Redline Manufacturers tab.

See also: Overview of Redlining Manufacturing Data (on page 68).

Editing Manufacturer Part Information on the Redline Manufacturers Tab

An item’s AML (approved manufacturers list) is represented by the rows of information on the item object Manufacturers tab. Each row in AML table represents a manufacturer part. If the item has not yet been released, you can edit this table on the item Manufacturers tab, for example, add or remove manufacturer parts, modify editable fields, including any editable custom fields that the Agile administrator has enabled. Your assigned roles and privileges determine which AML table fields you are allowed to edit. See Modifying a Manufacturer Part on the Manufacturers Tab (on page 67).

If the item has been released or has a pending revision, you must use the Redline Manufacturers tab to modify the item’s AML (Manufacturers tab). You display the Redline Manufacturers tab from the Affected Items tab of an ECO or MCO.

On the Redline Manufacturers tab you can make the same modifications that you are allowed to make on an unreleased item’s Manufacturers tab, including modifying any editable custom fields that the Agile administrator has enabled.

If the Agile administrator has enabled them, the item Manufacturers tab may also include read-through fields that display additional information derived from the manufacturer object or the
manufacturer part object, for example, the manufacturer address fields or the manufacturer part
Page Two fields. On both the item Manufacturers tab and the Redline Manufacturers tab, a read-through
field contains a read-only copy of attribute data from a manufacturer or manufacturer part.

Note: You cannot use the item Manufacturers tab or Redline Manufacturers tab to modify the read-
through fields nor to modify the attributes of the manufacturer part objects. The
Manufacturers tab and Redline Manufacturers tab are used only for defining the item’s AML –
the relationship between the item and the manufacturer parts.

To modify the attributes of a manufacturer or manufacturer part, you must open the manufacturer or
manufacturer part and then modify it with the edit feature. See Modifying Manufacturing Objects
(on page 62).

For more information about read-through fields and about which fields are editable on the item
Manufacturers tab, see the Administrator Guide.

Note: Your assigned roles and privileges also determine which attributes you are allowed to edit.

To edit a field on the redlines tab in Java Client:

1. Select one or more rows to edit, and click the Redline Manufacturer button.
2. In the Redline Manufacturers dialog box, make the required changes in the fields. Use the
   buttons in the upper left corner to display and edit other rows in the table.
3. When you are finished, click OK.

To edit a field on the redlines tab in Web Client:

1. Select one or more row, and click Edit.
   The row information is in edit mode.
2. Make the required changes in the fields.
3. Click Save.

Agile PLM draws a red line through the old information and enters the new information, in red,
below the old information.

See also: Changes (on page 109), Affected Items of Changes (on page 129).

Undoing Changes to the Redline Manufacturers Tab

The Undo Redlines button lets you undo modifications to the redlines tab. The Undo Redlines button
removes the red elements from the selected rows.

To undo a deletion (where Agile PLM has drawn a red line through the entire row):

1. Select a deleted row.
2. Click the Undo Redlines button.
   (In Java Client: )

To undo a modification (where Agile PLM has drawn a short red line through the modified value):

1. Select the modified row.
2. Click the **Undo Redlines** button.

   (In Java Client: 🔄 )

See also: [Modifying Manufacturing Data from the Redlines Tab](#) (on page 67).

### Printing Manufacturing Objects and AMLs

You can print object tabs and other data from your Agile PLM system. You can print the current tab or all tabs. Attachments are printed from their native applications or the Viewer.

In Java Client, with the object open, use the **Print** button 🖨.

In Web Client, with the object open, choose **Actions | Print**.

For additional information about printing objects, see *Getting Started with Agile PLM*. 

---

### See also:

- [Modifying Manufacturing Data from the Redlines Tab](#)
- [Getting Started with Agile PLM](#)
Chapter 4

Bills of Material

This chapter includes the following:

- About Bills of Material ................................................................. 73
- BOM Tab .................................................................................... 73
- Common and Site-specific Portions of the BOM .......................... 78
- Viewing BOMs by Site ................................................................. 78
- Opening Items on a BOM .............................................................. 79
- Revisions Listed on BOMs ......................................................... 82
- About Modifying the BOM Table ............................................... 83
- Working with Reference Designators ........................................ 93
- Redlining the BOM of a Released Item ....................................... 101
- Printing BOM Data ................................................................. 106

About Bills of Material

A bill of material (BOM) is a listing of all the subassemblies, parts, and raw materials that go into a parent assembly. It shows the quantity of each part required to make an assembly. Items on a BOM can be single items or assemblies of several items.

Documents may or may not have BOMs, depending on your system settings.

BOM items can apply to all manufacturing sites where the product is built, some sites, or just one site. The common portion of the BOM lists all the parts that the assembly shares between sites. Each site can add other objects to the BOM table that are site-specific—for example, documents containing assembly instructions that are specific to how something is built at that site. When you select Show Sites on the BOM tab, BOM items used by multiple sites are listed multiple times on the BOM tab, once for each site.

See also: Sites and Distributed Manufacturing (on page 33).

BOM Tab

This section includes the following topics:

- How the Agile Administrator Controls What You See (on page 74)
- BOM Tab Buttons (on page 74)
- BOM Table Fields (on page 77)

The BOM tab lists all the items on a BOM.

The BOM table displays the items on the BOM in a graphical hierarchy, using icons to indicate whether an item number represents:
How the Agile Administrator Controls What You See

The Agile administrator may assign to you:

- **Discovery privileges**, which determine and limit which Agile objects you can find, or discover, in the Agile PLM database.

- **Read privileges**, which determine and limit which discovered Agile objects you can open and read and which specific fields you can view on the Agile objects that you can open and read.

- **Sites**, which determine and limit the site-specific information you can see and modify on BOMs and AMLs.

If you do not have the Discovery privilege for an item, that item may not be displayed on the BOM table, depending on which SmartRule setting the Agile administrator has selected. For the BOM table only, the SmartRule setting is also applied to the fields for which you do not have Read privilege.

The items on the BOM for which you do not have Discovery privilege and the fields on the BOM table for which you do not have Read privilege are indicated by one of the following methods:

- Only the item number and rev are displayed on the BOM table. You cannot open the item if you do not have Discovery privilege.

- Only the item description is displayed on the BOM table. You cannot open the item if you do not have Discovery privilege.

- The item is not displayed on the BOM table. A message at the top of the BOM table tells you how many items have not been displayed.

There is no indicator for inaccessible site information.

If you have questions about your Discovery or Read privileges or the sites assigned to you, see the Agile administrator.

See also: [Opening Items on a BOM](on page 79).

**BOM Tab Buttons**

This section includes the topics:

- [Java Client BOM Tab Buttons](on page 75)

- [Web Client BOM Tab Buttons](on page 76)

See also: [BOM Table Fields](on page 77).
Java Client BOM Tab Buttons

You can print, send, export, and perform other activities from the BOM tab. Use the buttons on the top of the object window, including the More Actions menu (click the More button). Or, right-click in the item window to open the shortcut menu, and choose the command you want.

The following table explains the BOM tab buttons that appear in Java Client.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go To</td>
<td>Finds and highlights a specific BOM item based on the criteria you enter in the Go To dialog box.</td>
</tr>
<tr>
<td></td>
<td>The Go To search can be limited to a particular BOM column and to the specified number of levels.</td>
</tr>
<tr>
<td></td>
<td>For example, specifying level 3 searches through levels 1, 2, and 3.</td>
</tr>
<tr>
<td>Expand Tree or Collapse All</td>
<td>Select from menu. Expands or collapses all the subassemblies in the BOM. When expanded, all levels of the BOM are displayed.</td>
</tr>
<tr>
<td>Edit</td>
<td>Allows you to edit the a row in the BOM. You can edit the find number, quantity, reference designator and BOM notes. This button is available for introductory items that are not yet released, and have no changes pending against them.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds an item or an empty row to the BOM table. Depending on which option you choose, you can:</td>
</tr>
<tr>
<td></td>
<td>• Create an item while adding it.</td>
</tr>
<tr>
<td></td>
<td>• Search for an existing item.</td>
</tr>
<tr>
<td></td>
<td>• Type in Known Number(s) of one or more existing items.</td>
</tr>
<tr>
<td></td>
<td>• Add Blank Row — adds a blank row to the BOM table that can be filled in later. By default, the new item or row has a find number of zero (0) and a quantity of one (1).</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected rows from the BOM table.</td>
</tr>
<tr>
<td>View Redline</td>
<td>Opens the change that released this revision of the item, and displays the Affected Items tab and redline tabs. This button is disabled on pending revisions.</td>
</tr>
<tr>
<td>Select a BOM Item</td>
<td>double-click in a blank row with this symbol to select or create an item number to fill in the blank row.</td>
</tr>
</tbody>
</table>

See also: BOM Table Fields (on page 77), Web Client BOM Tab Buttons (on page 76).
# Web Client BOM Tab Buttons

The following table explains the BOM tab buttons that appear in Web Client.

Note: The Actions menu lets you print, email, export, and perform other activities from the BOM tab.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>Lets you redline the BOM by displaying the selected rows on an Edit page. The editable fields are in the form of text boxes, list boxes, and so on.</td>
</tr>
<tr>
<td><img src="image" alt="Remove" /></td>
<td>Removes the selected rows from the BOM table.</td>
</tr>
<tr>
<td><img src="image" alt="Add" /></td>
<td>Add — Adds an item or an empty row to the BOM table. Depending on which option you choose, you can:</td>
</tr>
<tr>
<td><img src="image" alt="Add" /></td>
<td>- Create an item while adding it.</td>
</tr>
<tr>
<td><img src="image" alt="Add" /></td>
<td>- Search for an existing item.</td>
</tr>
<tr>
<td><img src="image" alt="Add" /></td>
<td>- Type in Known Number(s) of one or more existing items.</td>
</tr>
<tr>
<td><img src="image" alt="Add" /></td>
<td>- Add Blank Row — adds a blank row to the BOM table that can be filled in later.</td>
</tr>
<tr>
<td><img src="image" alt="Multi-level" /></td>
<td>By default, the new item or row has a find number of zero (0) and a quantity of one (1).</td>
</tr>
<tr>
<td><img src="image" alt="Multi-level" /></td>
<td>Multi-level</td>
</tr>
<tr>
<td><img src="image" alt="Multi-level" /></td>
<td>Multi-level</td>
</tr>
<tr>
<td><img src="image" alt="Go To" /></td>
<td>Takes you to a specific BOM item based on the criteria you enter in the Go To dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Show BOM Tree" /></td>
<td>Click this symbol to create a new item to fill in the blank row.</td>
</tr>
</tbody>
</table>

See also: [BOM Table Fields](on page 77), [Java Client BOM Tab Buttons](on page 75).
# BOM Table Fields

BOM table fields and icons appear as listed in the following table.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="attachment_icon.png" alt="Attachment Icon" /></td>
<td>The appearance of this icon indicates that the item has an attachment. Click this icon to open the BOM item with its Attachments tab displayed.</td>
</tr>
<tr>
<td><img src="manufacturing_icon.png" alt="Manufacturing Icon" /></td>
<td>The appearance of this icon indicates that the item contains manufacturing data. Click this icon to open the BOM item with its Manufacturers tab displayed.</td>
</tr>
<tr>
<td><img src="pending_icon.png" alt="Pending Change Icon" /></td>
<td>The appearance of this icon indicates that the item has a pending change. Click this icon to open the BOM item with its Changes tab displayed.</td>
</tr>
<tr>
<td>Item Number</td>
<td>The Item Number field contains the item's number. Click an item number to open that item page.</td>
</tr>
<tr>
<td><img src="psr_icon.png" alt="PSR Icon" /></td>
<td>The appearance of this icon indicates that the item has a PSR that is not closed. Click this icon to open the BOM item with its Quality tab displayed.</td>
</tr>
<tr>
<td>Item Description</td>
<td>The Item Description field contains the description of that item.</td>
</tr>
<tr>
<td>Item Rev</td>
<td>The Item Rev field shows the revision number of the BOM item. By default, the latest released revision is displayed.</td>
</tr>
<tr>
<td>Qty</td>
<td>The Qty field shows the quantity of that item used in the assembly or subassembly.</td>
</tr>
<tr>
<td>Find Num</td>
<td>The Find Num field shows the internal number used to locate that item in an Agile BOM.</td>
</tr>
<tr>
<td>Ref Des</td>
<td>The Ref Des field contains the reference designators.</td>
</tr>
<tr>
<td>Sites</td>
<td>The Sites field shows which manufacturing site the item is associated with. Items associated with multiple sites are listed on the BOM once per site.</td>
</tr>
<tr>
<td>BOM Notes</td>
<td>The BOM Notes field contains notes about the item.</td>
</tr>
</tbody>
</table>

**Note**

The Effective From date is different from the Rev Release Date field on the Title Block tab. The rev release date is the release date of the ECO that released the current revision of the item.
Common and Site-specific Portions of the BOM

If your company is using distributed manufacturing, the BOM table may include both common portions and site-specific portions. The sites listed on an item’s Sites tab determine whether or not the item can be added to the common or site-specific portions of the BOM table.

In order to appear on common portion of the BOM table, an item’s Sites tab must include all the sites that appear on the parent item assembly’s Sites tab. For example, parent assembly 4444 includes the sites India and San Jose on its Sites tab. Items added to the common portion of the BOM table must also include at least India and San Jose on their Sites tab. If these items include additional sites on their Sites tab it does not prevent them from being included on the common portion of the BOM table of assembly 4444.

In a similar manner, items added to a site-specific portion of the BOM table must include at least that site on their Sites tab. For example, in order to be included on the India site-specific portion of the BOM table, items must include at least India on their Sites tab. If these items include additional sites on their Sites tab, it does not prevent them from being included in the India portion of the BOM table of assembly 4444.

Items that appear on the top level of the BOM must adhere to these rules. Items that appear on the BOM tables of subassemblies must appropriately match the sites list of their own parent item, but they do not need to match the top assembly item’s site list.

Important When you are creating or modifying a BOM table (adding by Search or Type in Known Numbers), if the appropriate sites are not associated with the added or modified item’s Sites tab, you will see a warning telling you that the item does not have the correct site association. Accept the warning to add the item anyway or cancel the action.

You will need to add the site associations to the child items before the assembly item is released. When an assembly is released, the item is audited for the proper site association of the items on the BOM table. Depending on Agile system SmartRule settings, you might not be able to release a change order or site change order if the site associations are not correct. See also Site-Specific Effectivity and Obsolete Dates (on page 122).

If you use Add | Create (Java Client) or Add | Create New (Web Client), the appropriate site associations are automatically added during the create process.

See also: Sites and Distributed Manufacturing (on page 33).

Viewing BOMs by Site

You can view the BOM for a specific manufacturing site by selecting a site from the Site drop-down list above the tabs. Sites included in the list are the ones specified on the item’s Sites tab. (For information about manufacturing sites, see Sites and Distributed Manufacturing (on page 33).)

When you select a site, the BOM tab displays the common BOM plus the BOM of the site you selected. To view the BOM for all sites at once, select ALL in the Site list.

If your organization assigns colors to sites, the rows in the BOM table may appear in different colors, distinguishing one site from another. Site colors are assigned on the site General Info tab.
You can perform actions only on the items that are displayed in the BOM table. For example, if you select San Francisco in the Site drop-down list, you see all items that are part of the common and San Francisco portions of the BOM, and you can modify the common portion of the BOM and the San Francisco portion of the BOM. However, you cannot modify the Hong Kong portion of the BOM; it is not displayed.

The Rev and Site drop-down lists work independently. For more details, see Working with Item Revisions (on page 13).

### Opening Items on a BOM

In general, you can open any item listed on a BOM by double-clicking its row (Java Client) or clicking its item number (Web Client). When you open an item, its page appears.

This section includes the following topics:
- Opening a Part, Assembly, or Document from the BOM Tab (on page 79)
- Expanding and Collapsing an Assembly (on page 79)
- Using BOM Go To (on page 81)

### Opening a Part, Assembly, or Document from the BOM Tab

#### Java Client:

You can open any item listed on a BOM by double-clicking its row.

#### Web Client:

You can open any item listed on a BOM by clicking its item number.

You can also view the BOM of a pending revision by selecting the pending revision (marked with parentheses, for example, Rev (B)) from the Rev drop-down list above the tabs.

See Working with Item Revisions (on page 13) for more information about viewing different revisions of the same item.

### Expanding and Collapsing an Assembly

To expand an assembly or subassembly, click ☑️ before its item number.

To collapse an assembly or subassembly, click ☐️ before its item number.
Close-up of the BOM tree, Java Client:

```
  P00002
  ├── MT11000
  │    └── 1232-02
  │         └── 1232-01
  │            ├── 1750-01
  │            │    └── 8768-01
  │            └── 1543-01
  │                  └── 301-1456
  │                      └── 4343-01
  │                             └── 4454-01
  │                                    └── 5322-01
```

Close-up of the BOM tree, Web Client:

```
  QAT2321
  ├── MTI1000
  │    └── MA11232
  │         └── 1543-01
  │                   └── 1232-01
  │                        └── 1232-02
  │                                └── 4343-01
  │                                       └── 5322-02
  │                                               └── 9876-01
  │                                                   └── 7654-02
  │                                                           └── 6598-01
  │                                                               └── 6642-01
```

See also: Opening Items on a BOM (on page 79).
Using BOM Go To

The BOM Go To feature allows you to search for a specific item in the BOM tree.

To use the BOM Go To feature in Java Client:

1. Click the item’s BOM tab to display it.

2. If you want to limit your search to a specific assembly, expand the BOM as needed, and select the assembly you want in the BOM table. Otherwise, go to the next step.

3. Click the Go To button.

4. In the Go To dialog box, define your search:
   a. Enter the text you want to find. The Go To search finds any item that includes (contains) the specified text in its attribute fields. You can use any type of character, including numerals and punctuation.
   b. In the drop-down list, choose which BOM table column you want to search. You can choose all columns or one specific column.
   c. Check Match case if you want to perform a case-sensitive search where text capitalization matters.
   d. Choose how many BOM levels you want to search: Enter a number or check All levels.
   e. If you selected an assembly in step 2, check Limit the search to the selected assembly to limit your search to the selected assembly. If you did not select an assembly, this checkbox is disabled.

5. To start the search, click Find.

   The search results are displayed in a search results dialog box. If it is not already expanded, the BOM table in the object window is expanded to show the number of levels specified in the search criteria dialog box.

   You can sort the search results in the following ways:
   • Drag and drop the column headers to rearrange the order in which the columns are displayed.
   • In the Add: [Available Columns] drop-down list, choose more columns to display. For example, add the Sites column to the results table so you can sort items by their sites.
   • To remove displayed columns, use the Remove: [Displayed Columns] drop-down list.

6. If you want to modify the search criteria and run the search again, click Criteria. The search results dialog box closes and the search criteria dialog box is displayed with the settings you last specified. To redefine the search, go to step 4 above.

7. Find the item you want in the search results table. Use the Next and Previous buttons to scroll up and down the search results list. You can also click an item’s row to select it. The selected item in the search results table is highlighted. At the same time, that item is also highlighted in the BOM table in the object window. Whenever you select a different item in the search results table, that item is then highlighted in the BOM table.

8. When you have found the item you want, click Close in the search results dialog box. The last item you selected in the search results table remains highlighted in the BOM table in the object window.

To use the BOM Go To feature in Web Client:

1. On the BOM tab, click the Go To.
2. In the Go To Item in BOM dialog box, define your search:
   a. Enter the text you want to find. The Go To search finds any item that includes (contains) the specified text in its attribute fields. You can use any type of character, including numerals and punctuation.
   b. In the drop-down list, choose which BOM table column you want to search. You can choose all columns or one specific column.
   c. Check Match Case if you want to perform a case-sensitive search where text capitalization matters.
   d. Choose how many BOM levels you want to search: Enter a number or check All levels.
3. To start the search, click Find Next. The first item that matches the search criteria is highlighted in the BOM table.
4. Use the Find Next and Find Previous buttons to scroll up and down the BOM table, highlighting items that match the search criteria.
5. When you have found the item you want, click Close in the Go To Item in BOM dialog box. The last item you highlighted in the BOM table remains highlighted.

See also: Opening Items on a BOM (on page 79).

Revisions Listed on BOMs

The revision number (or letter) that appears in the Item Rev field of the BOM table is calculated by checking the release date of the parent item (if already released), then locating the latest revision of the child item prior to that date and analyzing it. If the parent item hasn’t been released, the most recent revision of the child item is found. For details, see Details About Revision Display on BOMs (on page 181).

Caution Be aware that the unrelease and release of child items may affect the child revisions displayed on the parent BOM.

BOMs of Items Affected by an ECO

When you create an ECO against an item, Agile PLM creates a new revision of any item affected by that ECO. The new revision has an updated BOM based on the redlines.

For example, consider the following scenario in which someone does the following:
1. Creates an ECO that modifies part 1000-02 by replacing the currently used 1.0 GB disk with a 2.1 GB hard disk.
2. Releases the ECO.
3. Examines the BOM of item 1000-02.

When the ECO is released, Agile PLM displays the changed item as a new revision of item 1000-02. The new revision incorporates the modifications made by the ECO.

See also: Changes (on page 109), Affected Items of Changes (on page 129).
About Modifying the BOM Table

If an item is not yet released, and has no changes pending against it, you can modify the BOM table directly (add, delete, or edit items).

If the item has been released or has a pending MCO against it, you must write an ECO against the item and redline its BOM. (If the item already has a pending ECO against it, you can redline the BOM through the pending ECO without creating another ECO.) See Redlining the BOM of a Released Item (on page 101).

The following table illustrates how an item's BOM table can be modified as a preliminary item and as a production released item.

<table>
<thead>
<tr>
<th>Phase 1</th>
<th>Phase 2</th>
<th>Phase 3</th>
<th>Phase 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part_123</td>
<td>Part_123</td>
<td>Part_123</td>
<td>Part_123</td>
</tr>
<tr>
<td>Lifecycle = Preliminary</td>
<td>Lifecycle = Preliminary</td>
<td>Lifecycle = Production</td>
<td>Lifecycle = Production</td>
</tr>
<tr>
<td>Revision = Introductory</td>
<td>Revision = (A) ECO_001</td>
<td>Revision = A ECO_001</td>
<td>Revision = (B) ECO_005</td>
</tr>
<tr>
<td>No pending changes.</td>
<td>Pending ECO_001 has not yet been released. It creates pending Revision (A).</td>
<td>ECO_001 releases Part_123.</td>
<td>ECO_005 creates pending revision (B) of Part_123.</td>
</tr>
<tr>
<td>Part_123 has not yet been released. You may modify the BOM table as explained in Adding Items to the BOM Table of a Preliminary Item (on page 84).</td>
<td>Modify the BOM table of Part_123. by redlining the BOM through ECO_001.</td>
<td>You cannot modify the BOM table of Part_123 because it has been production released.</td>
<td>Part_123 is production released. You must make all changes to the BOM table by creating a change and redlining the BOM.</td>
</tr>
</tbody>
</table>

This section includes the following topics:

- Modifying Site-Specific Portions of the BOM of a Preliminary Item (on page 83)
- Adding Items to the BOM Table of a Preliminary Item (on page 84)
- Modifying the BOM Table of a Preliminary Item (on page 91)
- Removing Items from the BOM Table (on page 92)

Modifying Site-Specific Portions of the BOM of a Preliminary Item

If your organization practices distributed manufacturing, you can modify each manufacturing site’s portion of the BOM separately. To modify a site-specific item on the BOM, select the site in the Site drop-down list, then select the site-specific item you want to modify or edit. See Modifying the BOM Table of a Preliminary Item (on page 91). When adding an item to the BOM, you select the site you want. See Adding Items to the BOM Table of a Preliminary Item (on page 84).
Note  Modifying the site-specific portion of the BOM of a released item does not require a revision change and can be done through an SCO. Modifying the common portion of the BOM of a released item requires a revision change and can be done only through an ECO. For more information about modifying the BOM of an item that has been released, see Changes (on page 109) and Affected Items of Changes (on page 129).

Adding Items to the BOM Table of a Preliminary Item

There are several different ways to add items to the BOM tab. You can:

- Type in the number of an item. See Type in the Number of an Item to Add to the BOM Table (on page 84).
- Select one of the available search methods and search for the items you want to add. See Search for Items to Add to the BOM Table (on page 85).
- Create a new item. See Adding Nonexistent Items to the BOM Table (on page 90).
- Add a blank row, and select an item for that row later. See Adding a Blank Row to the BOM Table (on page 86).
  - Edit the blank row to enter BOM row details, including a temporary Item Number or item descriptions. See Editing a Blank Row in the BOM Table (on page 87).
  - Complete a blank row by selecting the item you want to use. See Completing a Blank Row in the BOM Table (on page 88).

See also: About Modifying the BOM Table (on page 83).

Type in the Number of an Item to Add to the BOM Table

If you know the number of the item you want to add to the BOM table, you can use the Type in Known Numbers option. The process is similar in both Java Client and Web Client.

Note  If you enter a non-existent item number, Agile displays a warning. If you accept the warning, Agile adds a placeholder row with the non-existent item number. See also Adding a Blank Row to the BOM Table (on page 86).

To add one or more known items to the BOM table:

1. Click the BOM tab.
2. If you want to add a site-specific item to the BOM tab, select the site you want in the item’s Site drop-down list. To add items to the common portion of the BOM, select ALL.
3. Click the Add drop-down menu button and choose the Type in Known Numbers option. A dialog appears.
4. In the Item Number(s) field, enter the item numbers you want, each number on a separate row.
   For example, type P00002, then press the Enter key to place the cursor on the next row. Now type P00044.
5. In the Add for Site drop-down list, select the site you want. To add an item to the common portion of the BOM, select Common.
   If you have already selected the site you want in the item’s Site drop-down list, it is preselected
for you in the dialog.

6. Click Add.
   The item appears in the BOM table.

7. To add items for a different site, select the site you want in the item's Site drop-down list and repeat the procedure.

For information about other methods of adding items to the BOM table, see Adding Items to the BOM Table of a Preliminary Item (on page 84).

Search for Items to Add to the BOM Table

You can use a saved search or define either a simple search or an advanced search to find items to add to the BOM table. You can also select items in your Bookmarks folder or Recently Visited folder.

To search for and add one or more items to the BOM table in Java Client:

When you add an item to the BOM, it is added below the selected item.

1. Click the BOM tab.

2. If you want to add a site-specific item to the BOM tab, select the site you want in the item’s Site drop-down list. To add items to the common portion of the BOM, select ALL.

3. Click the Add drop-down menu button and choose the Search option. The Add BOM dialog appears.

4. To edit the item information immediately after adding items, ensure that Edit rows after adding is checked.

5. Search for one or more existing items. In the Add BOM dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.)

6. In the search results, select the items you want by moving them into the Selected Item(s) list. You can run multiple searches to find and select additional items.

7. If you have not already done so, select a site in the Site field. To add the selected items to the Common portion of the BOM, select Common. If you previously selected a specific site in the item’s Site drop-down list, that site is preselected for you in the dialog.

8. Click OK.

9. If Edit rows after adding was checked, edit the item information in the Editing Added Rows dialog and click OK.

   All the items in the Selected Item(s) list are added to the BOM. The BOM tab Site column is automatically completed with the selected site as the associated site. If you added items to the Common portion of the BOM, then the Site column is blank to indicate that the item is common to all sites, instead of being specific to one site.

10. To add items for a different site, select the site you want in the item’s Site drop-down list and repeat the procedure.
Note: You cannot add a site-specific row to the BOM table for an item that belongs to a subclass for which the Site-Specific BOM property is set to Disallow. If you have questions, contact the Agile administrator.

To search for and add one or more items to the BOM table in Web Client:

1. Click the BOM tab.
2. If you want to add a site-specific item to the BOM tab, select the site you want in the item’s Site drop-down list.
3. Click the Add drop-down menu button and choose the Search option.
   The Add BOM Items wizard appears.
4. Search for one or more existing items. In the Add BOM Items dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.)
5. In the search results, select the items you want by moving them into the Selected list.
   You can run multiple searches to find and select additional items.
6. If you have not already done so, select a site in the Add for Site field. To add the selected items to the Common portion of the BOM, select Common. If you previously selected a specific site in the item’s Site drop-down list, that site is preselected for you in the dialog.
7. Click OK.
8. If Edit rows after adding was checked, edit the item information in the displayed dialog and click Save.
   All the items in the Selected list are added to the BOM. The BOM tab Site column is automatically completed with the selected site as the associated site. If you added items to the Common portion of the BOM, then the Site column is blank to indicate that the item is common to all sites, instead of being specific to one site.
9. To add items for a different site, select the site you want in the item’s Site drop-down list and repeat the procedure.

For information about other methods of adding items to the BOM table, see Adding Items to the BOM Table of a Preliminary Item (on page 84).

Adding a Blank Row to the BOM Table

You can add a blank row to the BOM table as a place holder, editing the BOM Notes field to specify which type of object you want to add later.

For example, Bob is creating a BOM for a computer. He is not sure which specific power cord he wants to use. He adds a blank row to the BOM, then edits the blank row. He specifies the find number, reference designator, and quantity. In the BOM Notes field, he types a note about the type of power cord that should be included in the BOM. Later, when he views the BOM again, Bob sees the blank row. It reminds him that he must select the appropriate item number to complete the information needed in that BOM row. See also Completing a Blank Row in the BOM Table (on page 88).
To add a blank row to the BOM table in Java Client:

When you add a blank row to the BOM, it is added above the selected rows.

1. Click the BOM tab.

2. If you want to add the blank row to a site-specific portion of the BOM, select the site from the item’s Site drop-down list. If you want to add the blank row to the common portion of the BOM, select ALL in the item’s Site drop-down list. (Items or blank rows must be associated with the site for which you want to add them. See Associating a Site with an Item (on page 42) for information.)

   Note You cannot add a site-specific row to the BOM table for an item that belongs to a subclass for which the Site-Specific BOM property is set to Disallow. If you have questions, contact the Agile administrator.

3. Click the Add drop-down menu button and choose the Add a blank row option.

   A blank row is added to the appropriate section of the BOM table with a default find number and a default quantity. The default find number is zero (0). The default quantity is set by the Agile administrator.

To add a blank row to the BOM table in Web Client:

1. Click the BOM tab.

2. If you want to add the blank row to a site-specific portion of the BOM, select the site from the item’s Site drop-down list. If you want to add the blank row to the common portion of the BOM, select ALL in the item’s Site drop-down list. (Items or blank rows must be associated with the site for which you want to add them. See Associating a Site with an Item (on page 42) for information.)

   Note You cannot add a site-specific row to the BOM table for an item that belongs to a subclass for which the Site-Specific BOM property is set to Disallow. If you have questions, contact the Agile administrator.

3. Click the Add drop-down menu button and choose the Blank Row option.

   A blank row is added to the appropriate section of the BOM table. By default, the find number is zero (0) and the quantity is one (1).

For information about other methods of adding items to the BOM table, see Adding Items to the BOM Table of a Preliminary Item (on page 84).

Editing a Blank Row

In the same manner that you can edit any BOM row, you can also edit a blank row, which allows you to fill in some BOM table fields before you specify the object you want to add. For example, you can fill in the Quantity, Find Number, Reference Designators, and additional custom fields that the Agile administrator had defined.

You can also provide a temporary Item Number or a temporary description for the item by following the instructions below.

To edit a blank row (including entering or editing a temporary Item Number or Item Description) using Java Client:

1. Select one or more BOM rows, including the blank rows you want to modify and click the Edit button.
The Edit BOM window appears.

2. Make the modifications in the table.

3. To provide a temporary description for the blank row, in the BOM Description field, type the text you want to use as the temporary item description.

   The Item Description field of a blank row cannot be edited. However, Agile uses the text in BOM Description field as a temporary description of the item when you save your modifications.

4. To provide a temporary item number, in the Item Number field, type a number that does not exist in the Agile database.

5. When you are finished, click **OK**.

   If you entered a temporary item number, Agile displays a Warnings and Errors dialog box which includes a warning that the item number does not exist. To finish specifying the temporary item number, check the **Accept** checkbox and click **OK**.

   If you entered text for a temporary description in the BOM Description field, that text is now also displayed in the Item Description field of the blank row.

**To edit a blank row (including entering or editing a temporary Item Number or Item Description) using Web Client:**

1. Select one or more BOM rows, including the blank rows you want to modify and click the **Edit** button.

   The **BOM** tab is now in edit mode. The editable fields are in the form of text boxes, list boxes, and so on.

2. Make the modifications you want.

3. To provide a temporary description for the blank row, in the BOM Description field, type the text you want to use as the temporary item description.

   The Item Description field of a blank row cannot be edited. However, Agile uses the text in BOM Description field as a temporary description of the item when you save your modifications.

4. To provide a temporary item number, in the Item Number field, type a number that does not exist in the Agile database.

5. When you are finished, click **Save**.

   If you entered a temporary item number, Agile displays a Warnings and Errors dialog box which includes a warning that the item number does not exist. To finish specifying the temporary item number, check the **Accept** checkbox and click **Save**.

   If you entered text for a temporary description in the BOM Description field, that text is now also displayed in the Item Description field of the blank row.

For information about methods of adding items to the BOM table, see [Adding Items to the BOM Table of a Preliminary Item](on page 84).

**Completing a Blank Row in the BOM Table**

You can complete a blank row in a BOM table using the procedures below. The following conditions apply:
You can perform a blank BOM row replacement in the item BOM table provided that there is no pending change against the item.

You can perform a blank BOM row replacement in the change order Redline BOM tab provided that the change order has not been released.

Temp BOM row replacement (a blank BOM row with a name) can take place outside of the BOM table edit process:
- When you create an item with that Temp name, for example, from the main Create menu.
- When an existing item is renamed to the same name as the Temp BOM item.
- On a Save As of an exiting item to a new item with the same name as the Temp BOM item.

To complete a blank row in the BOM table using Java Client:
1. On the BOM table, double-click the blank row, which displays this symbol: ?.
2. In the Replace Temporary Item dialog box, select the method you want to use:
   - Create a new Item
     a. In the Replace Temporary Item dialog box, select Create a new Item and click OK.
     b. In the New dialog box, select the item type in the Type drop-down list, fill in the required fields, and click OK. If an autonumber is not required, the New dialog Number field is prepopulated with the temporary number; you can use the temporary number or you can replace it. If an autonumber is required, the temporary number is automatically replaced with an autonumber.
   - Search for an Item
     a. In the Replace Temporary Item dialog box, select Search for an Item and click OK.
     b. In the Select Objects dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.) You can run multiple searches until you find the item you want.
     c. In the search results, select the one item you want by moving it into the Selected Object(s) list and click OK.
   - Replace it with Item
     a. In the Replace Temporary Item dialog box, select Replace it with Item.
     b. Enter the item number of an existing item and click OK.

To complete a blank row in the BOM table using Web Client:
1. On the BOM table, click this symbol in the blank row ?.
2. In the Replace Temporary Item dialog box, select the method you want to use:
   - Create a New Item
     a. In the Replace Temporary Item dialog box, select Create New Item and click OK.
     b. In the Create New Item dialog box, select the item type in the Type drop-down list, fill in the
required fields, and click OK. If an autonumber is not required, the New dialog Number field is prepopulated with the temporary number; you can use the temporary number or you can replace it. If an autonumber is required, the temporary number is automatically replaced with an autonumber.

Search for a Replacement

a. In the Replace Temporary Item dialog box, select Search for a Replacement and click OK.
b. In the Search for Items dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.) You can run multiple searches until you find the item you want.
c. In the search results, select the one item you want by moving it into the Selected list and click OK.

Replace it with Item

a. In the Replace Temporary Item dialog box, select Replace it with Item.
b. Enter the item number of an existing item and click OK.

For information about methods of adding items to the BOM table, see Adding Items to the BOM Table of a Preliminary Item (on page 84).

Adding Nonexistent Items to the BOM Table

You can add to a BOM an item that hasn’t been created yet.

Adding nonexistent items to the BOM table using Java Client:

1. Click the BOM tab.
2. If you want to add a site-specific item to the BOM tab, select the site you want in the item’s Site drop-down list. To add an item to the Common portion of the BOM, select ALL.
3. Click the Add drop-down menu button and choose the Create option. The New dialog appears.
4. In the New dialog box, use the Type drop-down list to select the type (subclass) of item you want to create.
5. Assign a number to the item. To do so, either accept the number that appears, click the Autonumber button to use the next autonumber, or type a number.
6. In the Add for Site drop-down list, select the site you want. To add an item to the common portion of the BOM, select Common.
   If you have already selected the site you want in the item's Site drop-down list, it is preselected for you in the dialog.
7. Complete any required fields.
8. Click OK.

Note: If you create a new item and decide you do not wish to keep it, you should delete it from the database with the Delete button in the object window. For more information about deleting items from the BOM, see Removing Items from the BOM Table (on page 92).
Adding nonexistent items to the BOM table using Web Client:

1. Click the BOM tab.

2. If you want to add a site-specific item to the BOM tab, select the site you want in the item’s Site drop-down list. To add an item to the Common portion of the BOM, select ALL.

3. Click the Add drop-down menu button and choose the Create New option. The New dialog appears.

4. In the New dialog box, use the Type drop-down list to select the type (subclass) of item you want to create.

5. Assign a number to the item. To do so, either accept the number that appears, click the Autonumber button to use the next autonumber, or type a number.

6. In the Add for Site drop-down list, select the site you want. To add an item to the common portion of the BOM, select Common.

   If you have already selected the site you want in the item’s Site drop-down list, it is preselected for you in the dialog.

7. Complete any required fields.

8. Click OK.

   Note If you create a new item and decide you do not wish to keep it, you should delete it from the database with the Delete command on the Actions menu. For more information about deleting items from the BOM, see the section, Removing Items from the BOM Table (on page 92).

For information about other methods of adding items to the BOM table, see Adding Items to the BOM Table of a Preliminary Item (on page 84).

Modifying the BOM Table of a Preliminary Item

You can directly modify the BOM table of an item that has not been released and has no pending changes.

When you create a new item and then click the BOM tab, the object window displays a blank BOM tab.

To modify items in the BOM table of a preliminary item in Java Client:

1. Open the unreleased item.

2. Click the BOM tab.

3. If the BOM information you need is on a site-specific portion of the BOM, select the site from the Site drop-down list.

4. Select one or more items to modify.

   Click the Edit button.

   The Edit BOM window appears.

5. Make the modifications in the table.

   When you are finished, click OK.
To modify items in the BOM table of a preliminary item in Web Client:

1. Open the unreleased item.
2. Click the BOM tab.
3. If the BOM information you need is on a site-specific portion of the BOM, select the site from the Site drop-down list.
4. Select one or more items to modify.
5. Click the Edit button.
   
   The BOM tab is now in edit mode. The editable fields are in the form of text boxes, list boxes, and so on.
6. Make the modifications you want.
   
   When you are finished, click Save.

See also: Adding Items to the BOM Table of a Preliminary Item (on page 84).

Removing Items from the BOM Table

To remove an item from the BOM table in Java Client:

1. If you want to remove an item from a site-specific portion of the BOM that is not currently displayed, select the site (or ALL) from the Site drop-down list to display the site-specific rows.
2. Select one or more items to remove from the BOM table.
3. Click the Remove button on the BOM tab.
   
   The items are deleted from the BOM table.

Caution  Be sure to use the Remove button on the Manufacturers tab, not the Delete button in the item window. If you use the Delete button, the entire item is deleted.

To remove an item from the BOM table in Web Client:

4. If you want to remove an item from a site-specific portion of the BOM that is not currently displayed, select the site (or ALL) from the Site drop-down list to display the site-specific rows.
5. Select one or more items to remove from the BOM table.
6. Click the Remove button on the BOM tab.
   
   The items are deleted from the BOM table.

Caution  Be sure to use the Remove button on the Manufacturers tab, not the Delete button in the item window. If you use the Delete button, the entire item is deleted.

See also: Adding Items to the BOM Table of a Preliminary Item (on page 84).
Working with Reference Designators

Reference designators are commonly used in the electronics industry as a labeling system to refer to components. If your company uses reference designators, you can assign and edit reference designators in Agile BOMs.

This section includes the following topics:
- Viewing Reference Designators (on page 93)
- Adding Reference Designators (on page 94)
- Deleting Reference Designators (on page 99)
- Modifying Reference Designators (on page 100)

Viewing Reference Designators

Reference designators may appear in the BOM table in an expanded display (R1, R2, R3) or a collapsed display (R1-R3). The Agile administrator sets the following system preference to select the method of reference designator display used on your Agile system.

This section includes the topics:
- Reference Designators Allow Range Expand Collapse Preference Setting (on page 93)
- Viewing Reference Designators in Java Client (on page 94)
- Viewing Reference Designators in Web Client (on page 94)

Reference Designators Allow Range Expand Collapse Preference Setting

Depending on the setting of the Reference Designators Allow Range Expand Collapse system preference, ranges of reference designators appear in the Ref Des field as either collapsed or expanded. For example, the range of reference designators R1, R2, R3, R4, R5 appear as follows:

- **Expanded**: R1, R2, R3, R4, R5
  Each reference designator is displayed in the Ref Des field.

- **Collapsed**: R1-R5
  Ranges of three or more reference designators are represented by the first reference designator in the sequence (R1), followed by the Reference Designator Range Indicator character (~ the hyphen character), followed by the last reference designator in the sequence (R5). The hyphen character is the default reference designator character, however, the Agile administrator may choose a different character, if needed.
  
  If the reference designators include leading zeros, in collapsed mode the reference designators are displayed in groups according to the number of leading zeros. For example, the 100 reference designators:
  R0001, R0002, R0003, R0004, ... R0099, R0100
  Are displayed in collapsed mode as:
  R0001-R0009, R0010-R0099, R0100
Viewing Reference Designators in Java Client

When there are many reference designators to display, Java Client displays one line of reference designators, followed by an ellipsis (… ) to indicate that there are more reference designators in the Ref Des field.

To display all the reference designators in the Ref Des field:

- Click the Ref Des field cell in the BOM table.
  - A drop-down pane appears. The entire list of reference designators are displayed in this pane. If needed, a scroll bar is included in the pane.
  - Regardless of the Expand/Collapse system preference setting, the reference designators are displayed in expanded mode in the pane. Each reference designator appears in the pane.

See also: Bills of Material (on page 73), Adding Reference Designators (on page 94).

Viewing Reference Designators in Web Client

When there are many reference designators to display, Web Client displays several lines of reference designators in the Ref Des cell and a scroll bar in the cell allows you to scroll through the reference designators.

To display all the reference designators in the Ref Des field:

- Use the scroll bar in the Ref Des cell in the BOM table to scroll up and down to view the reference designators. In addition, you can resize the Ref Des column width.
  - The reference designators are displayed according to the Expand/Collapse system preference setting.

See also: Bills of Material (on page 73), Adding Reference Designators (on page 94).

Adding Reference Designators

This section includes the topics:

- Reference Designator Entry Format Guidelines (on page 95)
- Leading Zeros in Reference Designators (on page 96)
- Multi-segmented Reference Designator Entry Format Guidelines (on page 96)
- Editing the Reference Designator Field (on page 98)
- Duplicate Reference Designators and Sites (on page 99)

You can enter, delete, and modify reference designators, either individually or several at once. If you have very few reference designators, you can enter them one by one (that is, R1, R2, R3). If you need to enter a larger set, you may use the format (Rx–Ry), where x and y are any numbers, but whose difference is less than 5000 (for example: R6–R2055).

Reference designators are limited to 5000 per BOM row. If you need more than 5000 reference
designators, add a duplicate item to the BOM with a different find number (same item number) to define additional reference designators.

Reference designators are not sorted until you complete edits to the current item.

If the number in the Qty field does not match the number of reference designators, you see a message indicating that the reference designators and quantity don’t match.

If Qty is not an integer, Agile treats the contents of the Qty field as text characters and does not verify that Qty and the number of reference designators match. Decimal numbers (for example, 7.8) are not integers and are therefore considered a text entry.

The length of an individual reference designator may be a minimum of 1 character and a maximum of 19 characters.

Duplicate reference designators are not allowed in the same unique single BOM row. If you enter the same reference designator twice (for example: A1, A1), Agile PLM resolves this to one reference designator (A1).

A unique BOM row is defined by a unique find number. If BOM table rows have the same find number, the Duplicate Ref Des SmartRule is ignored for those BOM table rows. However, if Find Number is blank for multiple BOM rows, Agile PLM validates Duplicate Ref Des SmartRule as if all those rows have Find Number = 0. For more information about the Duplicate Ref Des SmartRule, see the Administrator Guide.

See also: Deleting Reference Designators (on page 99), Modifying Reference Designators (on page 100).

Reference Designator Entry Format Guidelines

The following rules apply when entering reference designators:

- Entering ranges — You can always use ranges when entering reference designators, regardless of the setting of the Reference Designators Allow Range Expand Collapse system preference. If the preference is set to Expand, the reference designators are displayed in expanded format after you save your edits. For example:
  
  Enter: R1-R5
  
  Expanded Display: R1, R2, R3, R4, R5
  
  Collapsed Display: R1-R5

  **Note** Whenever you edit the reference designator field, the existing reference designators are displayed in Expand format while the BOM table row is in edit mode. If, during the same edit session, you navigate away from the Ref Des edit field, and return to the Ref Des edit field again, any ranges you entered previously are now displayed in Expanded format.

  For more information, see Reference Designators Allow Range Expand Collapse Preference Setting (on page 93).

- To add groups of reference designators that begin with different letters, you must separate each letter group with commas. For example, to enter the 10 designators A1, A2, A3, B4, B5, B6, B7, C8, C9, and C10, you would type:

  A1-A3,B4-B7,C8-C10
Leading Zeros in Reference Designators

You can use leading zeros when you enter individual reference designators or ranges of reference designators. For example,

- R001, R002, R010
- B001-B100

- The number of numeric characters in each segment of the range do not need to match. For example:
  - R0001-R100
- When the number of numeric characters in each segment of the range do not match, the number of numeric characters in the first segment is used for all the reference designators in the range. In the above example, the range is saved as:
  - R0001, R0002, R0003, R0004, ... R0099, R0100

When you exit edit mode, the reference designators are displayed according to the Reference Designators Allow Range Expand Collapse preference setting. For more information, see Reference Designators Allow Range Expand Collapse Preference Setting (on page 93).

Multi-segmented Reference Designator Entry Format Guidelines

Note: These rules apply when using a suffix, as defined below.

Reference designators may be separated into a maximum of three parts:

- Prefix < Number > < Suffix >

- Prefix — may be any character that is not defined as the range indicator (for example, [- hyphen] the default range indicator) or a delimiter (for example, [, comma] used to separate – delimit – a list of reference designators).

- Number — must be a number (numerals 0 through 9)

- Suffix — may be any character that is not designated as the range indicator or a delimiter, and does not start with 0 (zero).

Only the last number string is considered the reference designator < Number >. For example,

- A10B30D
  - Prefix = A10B < Number > = 30 < Suffix > = D

A segmented reference designator may also include characters that divide the segments as long as they meet the requirements outlined above. If the Agile administrator has selected a non-hyphen character as the range indicator, then the hyphen character can be used. Contact the Agile administrator if you have questions about which characters you may use in a multi-segmented reference designator. For example:
A\(^{10}\)B\(^{30}\)D

\(<\text{Prefix}> = A^{10}B^{*} <\text{Number}> = 30 <\text{Suffix}> = D\)

**Note**  
If the Agile administrator has selected a non-hyphen character as the range indicator, then the hyphen character can be used. Contact the Agile administrator if you have questions about which characters you may use in a multi-segmented reference designator.

See also: [Working with Reference Designators](#) (on page 93), [Adding Reference Designators](#) (on page 94).

**Entering Multi-segmented Reference Designator Ranges**

When you enter a range, Agile evaluates the formats of the begin-range designator and the end-range designator to ensure that the formats are compatible and, therefore, the range is valid.

When you enter a multi-segmented range, both the prefix and the suffix must be identical in the begin-range designator and end-range designator. (For details, refer to step 3 below.)

The number segment may use leading zeros as described in [Leading Zeros in Reference Designators](#) (on page 96).

Agile uses the following rules to evaluate the number portions of a multi-segmented range and the validity of the entered range:

1. Agile determines the number segments by scanning from right to left to find the first whole number in both the begin-range designator and the end-range designator.

2. Agile evaluates the begin-range number and the end-range number to ensure that they are the same formats.
   a. The numbers are the same precision (number of characters) from the end of the designator.
   b. The end-range designator number is greater than the begin-range designator number.

3. Agile evaluates the suffixes and prefixes to ensure that they match:
   a. The string of characters to the right of the whole number (suffix) are the same in both the begin-range designator and the end-range designator.
   b. The string of characters to the left of the whole number (prefix) are the same in both the begin-range designator and the end-range designator.

   Optionally, the prefix can be omitted in the end-range designator. Agile will use the same prefix as the start-range designator. This satisfies the rule that both prefixes must be the same. The following two ranges are equivalent:

   \[\text{A1B1C - A1B3C}\]
   \[<\text{Prefix}> = A1 <\text{Number}> = 1 <\text{Suffix}> = C\]
   \[<\text{Prefix}> = A1 <\text{Number}> = 3 <\text{Suffix}> = C\]

   \[\text{A1B1C - 3C}\]
   \[<\text{Prefix}> = A1 <\text{Number}> = 1 <\text{Suffix}> = C\]
   \[<\text{Prefix}> = \text{<use start-range designator prefix>} <\text{Number}> = 3 <\text{Suffix}> = C\]
The following table shows examples of valid multi-segmented reference designator ranges; the range indicator is - (hyphen):

<table>
<thead>
<tr>
<th>Range entered as:</th>
<th>Reference designators saved as:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1B*A3B</td>
<td>A1B*A3B</td>
</tr>
<tr>
<td>A<em>001</em>TT - A<em>3</em>TT</td>
<td>A<em>001</em>TT, A<em>002</em>TT, A<em>003</em>TT</td>
</tr>
<tr>
<td>A<em>001 - A</em>3</td>
<td>A<em>001, A</em>002, A*003</td>
</tr>
<tr>
<td>A1B1 - A1B3</td>
<td>A1B1, A1B2, A1B3</td>
</tr>
<tr>
<td>A1B1C - A1B3C</td>
<td>A1B1C, A1B2C, A1B3C</td>
</tr>
<tr>
<td>A1B1C - 3C</td>
<td>A1B1C, A1B2C, A1B3C</td>
</tr>
<tr>
<td>A1B1CD - 3CD</td>
<td>A1B1CD, A1B2CD, A1B3CD</td>
</tr>
<tr>
<td>A1B1C1 - A1B1C3</td>
<td>A1B1C1, A1B1C2, A1B1C3</td>
</tr>
</tbody>
</table>

See also: [Working with Reference Designators](on page 93), [Adding Reference Designators](on page 94).

## Editing the Reference Designator Field

**To add reference designators in Java Client:**

1. Select the item to modify. You can select multiple items.
2. Click the Edit button 📝.
   
The Edit BOM window appears.
3. Click the Ref Des field you want to modify. A drop-down edit pane appears.
4. Type the reference designators in this pane. Make any other required modifications to the row.
   
   **Note** If you need to, you can enter a new number in the Qty field.
5. When you are finished, click OK.

**To add reference designators in Web Client:**

1. Select the row or rows you want to edit.
2. Click Edit on the BOM tab to display the Edit page.
3. Type the reference designators in the Ref Des field. Make any other required modifications to the row.
   
   **Note** If you need to, you can enter a new number in the Qty field.
4. When you have finished your edits, click Save.

See also: [Working with Reference Designators](on page 93), [Adding Reference Designators](on page 94).
Duplicate Reference Designators and Sites

The same reference designator can be used in more than one site-specific portion of the BOM, regardless of the Duplicate Ref Des SmartRule setting. (See the Administrator Guide.) For example, reference designator B22 can be used for Part 123 in the India portion of the BOM and also for Part 556 in the San Jose portion of the BOM.

If the SmartRule is set to Disallow, then the same reference designator cannot be used in the common portion of the BOM and in a site-specific portion of the BOM, for example, using reference designator C55 for both Part 333 on the common portion of the BOM and for Part 678 on the Milpitas portion of the BOM. Nor can the same reference designator be used more than once in the same site-specific portion of the BOM, for example, using reference designator D46 for both Part 989 on the Milpitas portion of the BOM and for Part 765, also on the Milpitas portion of the BOM.

See also: Working with Reference Designators (on page 93), Adding Reference Designators (on page 94).

Deleting Reference Designators

You can delete reference designators either individually or several at once.

**Caution**  Be sure to use the keyboard Delete key, not the Remove button on the BOM tab. If you click the BOM Remove button, the entire item is removed from the BOM.

To delete reference designators in Java Client:

1. Select the item to modify by clicking its row.
2. Click the **Edit** button.
   The Edit BOM window appears.
3. Click the **Ref Des** field you want to modify. A drop-down edit pane appears.
4. Select the appropriate reference designators.
   To select the appropriate single reference designator, use the Shift and arrow keys. To select several contiguous reference designators, use the Ctrl+Shift and arrow keys.
5. Press the keyboard Delete key.
6. When you have finished your edits, click **OK**.

To delete reference designators in Web Client:

1. Select the row or rows you want to edit.
2. Click **Edit** on the BOM tab to display the Edit page.
3. Click the **Ref Des** field.
4. Select the appropriate reference designators.
   To select a single reference designator, either double-click the appropriate reference designator, or use the Shift and arrow keys. To select several contiguous reference designators, use the Ctrl+Shift and arrow keys.
5. Press the keyboard Delete key.
6. When you have finished your edits, click **Save**.

**Caution**  Be sure to use the keyboard **Delete** key, not the **Remove** button on the **BOM** tab. If you click the **BOM** **Remove** button, the entire item is removed from the BOM.

See also: [Working with Reference Designators](on page 93), [Adding Reference Designators](on page 94).

**Modifying Reference Designators**

You can modify reference designators, either singly or several at once.

To modify reference designators in Java Client:

1. Select one or more items to modify.
2. Click the **Edit** button 📋.
   The Edit BOM dialog box appears.
3. Click the **Ref Des** field you want to modify. A drop-down edit pane appears.
4. Select the appropriate reference designators.
   - To select a single reference designator, position your cursor in the list of reference designators and use the Shift and arrow keys.
   - To select several contiguous reference designators, use the Ctrl+Shift and arrow keys.
   - To add a reference designator, position the pointer at the end of the list of reference designators.

**Note**  Although you may position the cursor anywhere in the list to add a reference designator, it is not necessary to insert the reference designator in a particular place in the list because the list is sorted after you save your modifications.

5. Type the modified reference designator.
6. When you are finished, click **OK**.

To modify reference designators in Web Client:

1. Select the row or rows you want to edit.
2. Click **Edit** on the **BOM** tab to display the Edit page.
3. Click the **Ref Des** field.
4. Select the appropriate reference designators.
   - To select a single reference designator, either double-click the appropriate reference designator, or use the Shift and arrow keys.
   - To select several contiguous reference designators, use the Ctrl+Shift and arrow keys.
   - To add a reference designator, position the cursor at the end of the list of reference designators.

See also: [Working with Reference Designators](on page 93), [Adding Reference Designators](on page 94).
Redlining the BOM of a Released Item

This section includes the following topics:

- Overview of BOM Redlining (on page 101)
- Redline BOM Tab (on page 102)
- Adding an Item to a Redline BOM Table (on page 104)
- Removing an Item from a Redline BOM Table (on page 104)
- Editing Item Information on a Redline BOM Table (on page 105)
- Undoing Changes to a Redline BOM Table (on page 106)

Overview of BOM Redlining

If an item is released, or has pending changes against it, you must create a change against that item and redline it to modify the BOM table. You can use an ECO or SCO to redline the BOM:

- Use an ECO to modify common or site-specific portions of the BOM on the latest released revision of the item. Using an ECO creates a new revision of the item.
- Use an SCO to modify site-specific portions of the BOM on the latest released revision. Using an SCO does not create a new revision of the item. For more information about SCOs, see Site Change Orders (on page 122).

When you add an item that has pending changes to the Affected Items tab, Agile PLM displays a warning that informs you that the item has a separate pending change, and allows you to choose whether or not to add it to the Affected Items tab. If you choose to add it, you can open the item from the Affected Items table. To view the pending changes, click the item’s Changes tab.

Note: If you do not have the Discovery privilege for an item on the BOM table, you cannot redline that item. You cannot replace an item on the BOM table with an item that you cannot discover.

If you have the appropriate privileges, you can modify a redlined BOM. For details, see the following sections:

- Editing Item Information on a Redline BOM Table (on page 105)
- Adding an Item to a Redline BOM Table (on page 104)

Note: You can add nonexistent items to the Redline BOM table. See Adding Items to the BOM Table of a Preliminary Item (on page 84).

- Removing an Item from a Redline BOM Table (on page 104)
Redline BOM Tab

You display the Redline BOM tab from the Affected Items tab of an ECO or SCO.

To display the Redline BOM tab for an item in Java Client:
1. Open the ECO or SCO through which you want to redline an item’s BOM.
2. Click the Affected Items tab of the change.
3. In the Affected Items table, click the row of the item for which you want to view or create redlines.
   In the redline pane under the Affected Items table, the Redline BOM tab, Redline Manufacturers tab, and Redline Attachments tab (on ECOs only) appear, displaying the item’s BOM data, manufacturing data, and attachments respectively.

   Note: If your Agile PLM system does not use the Manufacturers tab or, on documents, the BOM tab, then those redline tabs do not appear in the redlines pane.

4. Display the Redline BOM tab, if it is not displayed.

To display the Redline BOM page for an item in Web Client:
1. Open the ECO or SCO through which you want to redline an item’s BOM.
2. Click the Affected Items tab of the change.
3. Click the icon in front of the item for which you want to create redlines.
   If the item has already been redlined, the icon appears in front of the item row. Click this icon to view or modify existing redlines.
   The Redline BOM tab, Redline Manufacturers tab, and Redline Attachments tab (on ECOs only) appear on the Redlines page, displaying the item’s BOM data, manufacturing data, and attachments respectively.

   Note: If your Agile PLM system does not use the Manufacturers tab or, on documents, the BOM tab, then those redline tabs do not appear in the redlines page.

4. Click the Redline BOM tab to display it (if it is not already displayed).
   • If a row in the table has a red line through every cell in the row, it means that item was deleted from the BOM.
   • If just a few of the cells have a short red line through them, it means the item was modified, but not deleted. For example, redlines in only the Qty and Find Number cells indicate that the Qty and Find Number of that BOM item have been modified, while other values remain unchanged.
   • Any cell that was modified has a red line through the old value; the new value appears in red. For example, in the Qty cell, a numeral seven with a redline through it 7 and a red numeral ten 10 indicates that the old quantity was 7 and the new quantity is 10.

For information about other BOM redlining actions, see Redlining the BOM of a Released Item (on page 101).
Redline BOM Tab Buttons

The following table lists the buttons on the Redline BOM tab in Java Client:

<table>
<thead>
<tr>
<th>Button</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Redline BOM" /></td>
<td>Redline BOM — Displays the selected rows in a Redline BOM window so that you can change editable fields.</td>
</tr>
<tr>
<td><img src="image" alt="Add" /></td>
<td>Add — Adds an item or an empty row to the Redline BOM table. Depending on which option you choose, you can:</td>
</tr>
<tr>
<td><img src="image" alt="Create" /></td>
<td>Create an item while adding it.</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Search for an existing item.</td>
</tr>
<tr>
<td><img src="image" alt="Type in Known Number(s)" /></td>
<td>Type in Known Number(s) of one or more existing items.</td>
</tr>
<tr>
<td><img src="image" alt="Add Blank Row" /></td>
<td>Add Blank Row — adds a blank row to the Redline BOM table that can be filled in later. By default, the new item or row has a find number of zero (0) and a quantity of one (1). See Adding Items to the BOM Table of a Preliminary Item (on page 84).</td>
</tr>
<tr>
<td><img src="image" alt="Remove" /></td>
<td>Remove — Removes the selected row from the Redline BOM table.</td>
</tr>
<tr>
<td><img src="image" alt="Undo Redlines" /></td>
<td>Undo Redlines — Clears the redlines from the selected rows. See Undoing Changes to a Redline BOM Table (on page 106).</td>
</tr>
</tbody>
</table>

The following table lists the buttons on the Redline BOM tab in Web Client:

<table>
<thead>
<tr>
<th>Button</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>The Edit button displays the selected rows on an Edit page so that you can change editable fields.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>The Delete button removes the selected row from the Redline BOM table.</td>
</tr>
<tr>
<td><img src="image" alt="Undo Redlines" /></td>
<td>The Undo Redlines button clears the redlines from the selected rows. See Undoing Changes to a Redline BOM Table (on page 106).</td>
</tr>
<tr>
<td><img src="image" alt="Add" /></td>
<td>Add — Adds an item or an empty row to the Redline BOM table. Depending on which option you choose, you can:</td>
</tr>
<tr>
<td><img src="image" alt="Create" /></td>
<td>Create an item while adding it.</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Search for an existing item.</td>
</tr>
<tr>
<td><img src="image" alt="Type in Known Number(s)" /></td>
<td>Type in Known Number(s) of one or more existing items.</td>
</tr>
<tr>
<td><img src="image" alt="Add Blank Row" /></td>
<td>Add Blank Row — adds a blank row to the Redline BOM table that can be filled in later. By default, the new item or row has a find number of zero (0) and a quantity of one (1). See Adding Items to the BOM Table of a Preliminary Item (on page 84).</td>
</tr>
</tbody>
</table>
For information about BOM redlining actions, see Redlining the BOM of a Released Item (on page 101).

Adding an Item to a Redline BOM Table

To add an item to the Redline BOM table in Java Client:

1. Click the Add drop-down menu button and choose one of the add options: Create, Type in Known Numbers, Search, or Add Blank Row.
2. Adding items to the Redline BOM table is similar to adding items to the BOM table. For more information about how to complete the dialogs, see:
   - Adding Nonexistent Items to the BOM Table (on page 90)
   - Type in the Number of an Item to Add to the BOM Table (on page 84)
   - Search for Items to Add to the BOM Table (on page 85)
   - Adding a Blank Row to the BOM Table (on page 86) and Completing a Blank Row in the BOM Table (on page 88)

To add an item to the Redline BOM table in Web Client:

1. Click the Add drop-down menu button and choose one of the add options: Create New, Search, Type in Known Numbers, or Blank Row.
2. Adding items to the Redline BOM table is similar to adding items to the BOM table. For more information about how to complete the dialogs, see:
   - Adding Nonexistent Items to the BOM Table (on page 90)
   - Type in the Number of an Item to Add to the BOM Table (on page 84)
   - Search for Items to Add to the BOM Table (on page 85)
   - Adding a Blank Row to the BOM Table (on page 86) and Completing a Blank Row in the BOM Table (on page 88)

For information about other BOM redlining actions, see Redlining the BOM of a Released Item (on page 101).

Removing an Item from a Redline BOM Table

You use the buttons on the Redline BOM tab to remove one or more rows and items.

- If a selected row is red (indicating that the row is redline-added to the BOM), it is removed.
- If a selected row is black, a red line is drawn through it, thus redline-deleting the item from the BOM.

To remove an item from a redline BOM table in Java Client:

1. Select one or more rows to delete.
2. Click the Remove button on the Redline BOM tab.
To remove an item from a redline BOM table in Web Client:

1. Select one or more rows to delete.
2. Click the Delete button on the Redline BOM tab.

For information about other BOM redlining actions, see Redlining the BOM of a Released Item (on page 101).

Editing Item Information on a Redline BOM Table

On the Redline BOM tab you can modify any editable BOM tab field, including any editable custom fields that the Agile administrator has enabled. Editable BOM tab fields usually describe or define the relationship between the parent item (the item BOM you are redlining) and the child item (the item that appears on the BOM table). For example, the Qty, Find Number, and Ref Des fields define the relationship between the assembly (parent item) and the BOM item (child item).

When you modify information on the Redline BOM tab, Agile PLM enters the new information, in red, below the old information.

When you redline the BOM Notes field, you can add, replace, or edit text. In the BOM Notes field, the new text and any redlined text are displayed.

You cannot modify the Redline BOM table Sites, Item Description, and Item Rev fields.

Redlining reference designators in the Redline BOM table is the same as editing reference designators on the BOM table. For more information, see Working with Reference Designators (on page 93). Any new reference designators appear in red. Any deleted reference designators have a red line drawn through them.

Note: You cannot use the Redline BOM tab to modify the attributes of the items that are listed on the BOM table. You cannot use the Redline BOM tab to modify non-editable BOM table fields.

If the Agile administrator has enabled them, the item BOM tab may also include read-through fields that allow you to conveniently view additional information derived from the items that are listed on the BOM table, for example, a child item’s Page Two fields. A read-through field contains a read-only copy of attribute data from a child item. BOM tab read-through fields cannot be edited on the BOM tab, nor can they be edited on the Redline BOM tab.

To modify the attributes of an item listed on the BOM table, if it is a Preliminary item with no pending revisions, you can open it and use the Edit feature to modify it. See Editing an Unreleased Item (on page 26). If an item listed on the BOM table has been released, you must use a change order to modify it. See Editing a Released Item (on page 27).

For more information about read-through fields and about which fields are editable on the item BOM tab, see Agile PLM Administrator Guide.

Your assigned roles and privileges also determine which attributes you are allowed to edit.

To edit a field on the Redline BOM table in Java Client:

1. Select the rows to edit, and click the Edit button 🖌️.
   The Redline BOM dialog box appears.
2. Make the modifications.
3. When you are finished, click OK.

To edit a field on the Redline BOM table in Web Client:

**Select the rows to edit, and click Edit.**

1. Click inside each field and make the required changes.
2. Click Save.

For information about other BOM redlining actions, see [Redlining the BOM of a Released Item](#) (on page 101).

### Undoing Changes to a Redline BOM Table

The **Undo Redlines** button lets you undo modifications to the **Redline BOM** tab. It removes the red elements from the selected row.

**Note** In Java Client, the **Undo Redlines** button is indicated with this icon: 🔄.

**To undo a deletion (where Agile PLM has drawn a red line through the entire row):**

1. Select the deleted row. You can select more than one row.
2. Click **Undo Redlines**.

**To undo a modification (where Agile PLM has drawn a short red line through the modified value):**

1. Select the modified row (or rows).
2. Click **Undo Redlines**.

**To undo a newly added item (remove it from the Redline BOM table):**

1. Select the added row (or rows).
2. Click **Undo Redlines**.

For information about other BOM redlining actions, see [Redlining the BOM of a Released Item](#) (on page 101).

### Printing BOM Data

You can print object tabs and other data from your Agile PLM system. You can print the current tab or all tabs. Attachments are printed from their native applications or the Viewer.

In Java Client, with the object open, use the **Print** button 📒.

In Web Client, with the object open, choose **Actions | Print**.

For additional information about printing objects, see *Getting Started with Agile PLM*.

In Java Client, to print only the BOM tab data, use the **Print** button drop-down menu and choose **BOM**. Complete the BOM Printing Options dialog, including the number of BOM levels you want to print and whether to include the AML.
In Web Client, you can print BOM information from your Web browser. Go to the BOM tab of an item and choose Actions | Print. You can print just the BOM tab or all tabs. When printing the BOM, select the BOM Printing Option you want, including the number of BOM levels to print and whether to include the AML.

See also: Working with Product Reports and Process Reports (on page 155).
Chapter 5

Changes

This chapter includes the following:

- Change Classes .................................................................................................................................................. 109
- Change Objects .................................................................................................................................................. 110
- Workflow Routings Inbox ..................................................................................................................................... 120
- Changes and Manufacturing Sites ....................................................................................................................... 120
- The Relationship of Changes to Item Revisions .................................................................................................. 123
- Creating Changes ................................................................................................................................................ 124
- Modifying Changes .............................................................................................................................................. 124
- Agile Change Control Workflows ......................................................................................................................... 125
- Redlining through ECOs, MCOs, and SCOs ........................................................................................................ 125
- Deleting Changes ................................................................................................................................................ 126
- Printing Change Tabs .......................................................................................................................................... 127
- Routing Managers: Change Analyst and Component Engineer ............................................................................ 127

Change Classes

The following classes, or types, of changes are available in Agile PLM:

- Change Orders class, including engineering change orders (ECOs)
- Change Requests class, including engineering change requests (ECRs)
- Manufacturer Orders class, including manufacturing change orders (MCOs)
- Site Change Orders class, including site change orders (SCOs)
- Deviations class
- Stop Ships class

Change Subclasses

Each Agile class has at least one out-of-the-box subclass. The Agile administrator may decide to use some or all of these change classes and subclasses, and may have created additional subclasses. For example, under the Change Orders class, you might have ECOs, Mechanical ECOs, Software ECOs, and so on.

The purpose of each change subclass is listed in the following table. Corresponding change icons are also listed. These icons are displayed next to the change number on the Cover Page, and next to each change in search results.
<table>
<thead>
<tr>
<th>Change type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECO</td>
<td>An engineering change order tells users that changes need to be made to specific items, and to go ahead and do the work. ECOs can affect common and site-specific portions of the BOM and AML. ECOs also let you release new items and redline BOMs, manufacturer data, and attachments. See Redlining through ECOs (on page 126).</td>
</tr>
<tr>
<td>ECR</td>
<td>An engineering change request is used to request a change to be made to items. You can create an ECR against a non-latest released revision of an item. ECRs do not have any redlining functions.</td>
</tr>
<tr>
<td>MCO</td>
<td>A manufacturer change order tells users that changes need to be made to the manufacturing data of specific items. MCOs can affect common and site-specific portions of the AML. MCOs allow you to redline the manufacturer data of an item, release new items, and change the lifecycle phase of items. See Redlining through MCOs (on page 126).</td>
</tr>
<tr>
<td>SCO</td>
<td>A site change order tells users that changes need to be made to site-specific items, and to go ahead and do the work. SCOs affect only the site-specific portion of the BOM and AML; they do not affect the common portion. You can create an SCO against a non-latest released revision of an item. SCOs let you redline BOMs and AMLs.</td>
</tr>
<tr>
<td>Deviation</td>
<td>A deviation is used to switch from one part to another for a specific amount of time. You can create a deviation against a non-latest released revision of an item. Deviations do not have any redlining functions.</td>
</tr>
<tr>
<td>Stop Ship</td>
<td>A stop ship alerts users to stop shipping or using an item. You can create a stop ship against a non-latest released revision of an item. Stop ships do not have any redlining functions.</td>
</tr>
</tbody>
</table>

For information about changing the subclass of a change, see the chapter on workflows in Getting Started with Agile PLM.

### Change Objects

This section includes the following topics:

- [Cover Page Tab](#) (on page 111)
- [Affected Items Tab](#) (on page 114)
- [Workflow Tab](#) (on page 115)
- [Relationships Tab](#) (on page 117)
- [Attachments Tab](#) (on page 118)
- [History Tab](#) (on page 118)
When you view a change in Java Client, information about it is displayed on tabs in its object window.

When you view a change in Web Client, information about it is displayed on tabs in the right pane.

The following table shows the tabs and the default fields for changes.

The Agile administrator may have added additional tabs or sections, called Page Two and Page Three by default. These tabs or sections contain custom fields defined by the administrator.

<table>
<thead>
<tr>
<th>Tab name</th>
<th>Tab information includes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover Page</td>
<td>General information about the change plus any unique fields defined by the Agile administrator.</td>
</tr>
<tr>
<td>Affected Items</td>
<td>Which items are affected by the change. ECOs include redlined BOMs, AMLs, and file folders. SCOs include redlined BOMs and AMLs for a site. MCOs include redlined AMLs.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Approvers and observers of the change and the results of their reviewing the change.</td>
</tr>
<tr>
<td>Relationships</td>
<td>The Relationships tab allows you to create relationships and dependencies between the current change object and other Agile objects, both routable objects and lifecycle objects. For more information about relationships, see Getting Started with Agile PLM.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Attached files and URLs.</td>
</tr>
<tr>
<td>History</td>
<td>All actions taken on the change.</td>
</tr>
</tbody>
</table>

**Cover Page Tab**

The Cover Page tab of a change shows the information traditionally shown on a paper ECO form. Agile PLM completes some of the fields; you complete the rest.

This section contains the following topics:

- Fields on the Cover Page Tab
- Status on the Cover Page Tab

**To edit fields on the Cover Page tab in Java Client:**

Modify the fields and click Save.

**To edit fields on the cover page tab in Web Client:**

Click the Edit button, modify the fields, and click the Save button.

Sometimes you cannot edit a field. A field may be uneditable for three reasons:

- The change has been released.
- You do not have sufficient privileges to modify that field.
- The field is automatically filled in as the change progresses through its workflow statuses, for example, Status, Date Released, or Final Complete Date.
For information about all change object tabs, see Change Objects (on page 110).

**Fields on the Cover Page Tab**

The following table summarizes the Cover Page fields and what they contain. The fields on the Cover Page tab vary from one change type to another.

In Web Client, the Cover Page can contain two additional sections, called Page Two and Page Three by default. In Java Client, these are separate tabs. The Agile administrator determines whether these sections are enabled, and what they are called.

<table>
<thead>
<tr>
<th>Field</th>
<th>How completed</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number</strong></td>
<td>Automatically, when created.</td>
<td>The number assigned to the change when you create it.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Automatically, when created; updated as the change moves through the assigned workflow.</td>
<td>Change status, described in Status on the Cover Page Tab (on page 113); if no workflow has been selected, this field is Unassigned.</td>
</tr>
<tr>
<td><strong>Change Type</strong></td>
<td>Automatically, when created.</td>
<td>The type of change selected when you create the change.</td>
</tr>
<tr>
<td><strong>Change Category</strong></td>
<td>Usually manually; can contain a default.</td>
<td>Category defined by the Agile administrator (can be selected from a drop-down list).</td>
</tr>
<tr>
<td><strong>Description Of Change</strong></td>
<td>Usually manually; can contain a default.</td>
<td>Maximum number of bytes is set by the Agile administrator; can be up to 1023 bytes, including spaces and carriage returns (which count as 2 bytes).</td>
</tr>
<tr>
<td><strong>Reason For Change</strong></td>
<td>Usually manually; can contain a default.</td>
<td>Maximum number of bytes is set by the Agile administrator; can be up to 1023 bytes, including spaces and carriage returns (which count as 2 bytes).</td>
</tr>
<tr>
<td><strong>Reason Code</strong></td>
<td>Usually manually; can contain a default.</td>
<td>Code defined by the Agile administrator (can be selected from a drop-down list).</td>
</tr>
<tr>
<td><strong>Workflow</strong></td>
<td>Automatically (if only one workflow applies to the change), when the change is moved to the next status from the Unassigned status. If more than one workflow applies to the change, the workflow is selected manually; the workflow selection can be changed as long as the change is in the Pending status type. Selecting the blank field in the Workflow drop-down list switches the change to the Unassigned status.</td>
<td>The name of the workflow being used to move this change through the change control process.</td>
</tr>
<tr>
<td>Field</td>
<td>How completed</td>
<td>Contents</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Analyst or Component Engineer</td>
<td>May be provided automatically by the workflow; otherwise selected manually from an address book list of change analysts or component engineers.</td>
<td>Default routing manager. If the workflow is defined to notify the default change analyst or component engineer, the user in this field receives notifications about the change. If this field is left blank, then the notifications are sent to every change analyst or component engineer on the list. If the notification definition in the workflow is blank, no notifications are sent.</td>
</tr>
<tr>
<td>Originator</td>
<td>Usually automatically, when created (with the default set by the Agile administrator).</td>
<td>The user who created the change (can be selected from a drop-down list).</td>
</tr>
<tr>
<td>Date Originated</td>
<td>Usually automatically, when created.</td>
<td>The date the change was created.</td>
</tr>
<tr>
<td>Date Released</td>
<td>Automatically, when released.</td>
<td>The date the change was released.</td>
</tr>
<tr>
<td>Final Complete Date</td>
<td>Automatically, when the change enters the Complete status type.</td>
<td>The date the change moved into the Complete status type.</td>
</tr>
<tr>
<td>Product Line(s)</td>
<td>Usually manually; can contain a default.</td>
<td>Product line defined by the Agile administrator (can be selected from a drop-down list).</td>
</tr>
<tr>
<td>Effective From</td>
<td>Manually.</td>
<td>Deviations only. The date the deviation goes into effect.</td>
</tr>
<tr>
<td>Effective To</td>
<td>Manually.</td>
<td>Deviations only. The date the deviation is no longer in effect.</td>
</tr>
<tr>
<td>Resume Date</td>
<td>Manually.</td>
<td>Stop Ships only. The date the stop ship is no longer effective and the company can resume shipping of the item.</td>
</tr>
</tbody>
</table>

The **Cover Page** tab for deviations has two unique fields, **Effective From** and **Effective To**. The **Cover Page** tab for stop ships has one unique field, **Resume Date**.

The **Cover Page** tab for MCOs has a **Component Engineer** field (in the place of a **Change Analyst** field).

For information about all change object tabs, see **Change Objects** (on page 110).

### Status on the Cover Page Tab

A “stamp” in the top right corner of a change indicates the status of the change. The Agile administrator defines the name of each status in each workflow.

**Note** The Agile administrator may have created customized workflows and statuses for your company. The table below lists only the 12 Agile default workflow statuses.

<table>
<thead>
<tr>
<th>Status name</th>
<th>Status definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unassigned (no status type)</td>
<td>No workflow has been assigned to this change. The originator may still be developing the change. No statuses are displayed on the Workflow tab.</td>
</tr>
<tr>
<td>Status name</td>
<td>Status definition</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pending (Pending status type)</td>
<td>The originator may still be developing the change. It has not yet been approved or perhaps even completed.</td>
</tr>
<tr>
<td>Submitted (Submit status type)</td>
<td>The change has been routed to the change analyst or component engineer for review and analysis.</td>
</tr>
<tr>
<td>CCB (Review status type)</td>
<td>The change has been routed to the members of the change control board (CCB) for approval.</td>
</tr>
<tr>
<td>Released (Released status type)</td>
<td>The change has been signed off by the CCB members and released.</td>
</tr>
<tr>
<td>Closed (Complete status type)</td>
<td>The change is an ECR that has been accepted and implemented.</td>
</tr>
<tr>
<td>Expired (Complete status type)</td>
<td>The change is a deviation where the “Effective To” date has been reached.</td>
</tr>
<tr>
<td>Implemented (Complete status type)</td>
<td>The change is an ECO or SCO that has been implemented or incorporated into new drawings.</td>
</tr>
<tr>
<td>Hold (Hold status type)</td>
<td>The change has been placed on hold while information is being gathered by the component engineer.</td>
</tr>
<tr>
<td>Resumed (Complete status type)</td>
<td>The change is a stop ship that has been lifted. Production of affected items can resume.</td>
</tr>
<tr>
<td>Canceled (Cancel status type)</td>
<td>The change has been canceled due to a fundamental flaw or rejection by several people.</td>
</tr>
<tr>
<td>First Article Complete (Complete status type)</td>
<td>The manufacturer part has been received and passed incoming inspection or quality assurance. The physical part has been validated against design documents or specifications (MCO only).</td>
</tr>
</tbody>
</table>

The **Workflow** tab shows all the statuses the change has been through, and the statuses remaining to complete the change control process. See Workflow Tab.

With appropriate privileges, you can switch a change to another status with the **Workflow** tab or the **Next Status** button. For more information, see the chapter on workflows in *Getting Started with Agile PLM*.

For information about all change object tabs, see [Change Objects](on page 110).

**Affected Items Tab**

The **Affected Items** tab lists the items that are affected by a change. Users with sufficient privileges can complete the **Affected Items** tab and use it to redline BOMs, manufacturing data, and attachments.
Note If you do not have Discovery and Read privileges for an item, it does not appear on the Affected Items tab. You may see a message telling you how many items are not displayed.

To open an item listed on the Affected Items tab:
- In Java Client, double-click the affected item row. The item opens with the Title Block tab on top.
  Or, right-click the item row, choose Open, then choose a tab. The item opens with the selected tab on top.
- In Web Client, click the item number. The item opens with the Title Block tab on top.

The revision associated with the change is selected in the Rev drop-down list.

For information about all change object tabs, see Change Objects (on page 110).

Workflow Tab

The Workflow tab shows all the statuses the change has passed through, and which statuses remain to be completed. It also shows all the approvals and rejections made during each approval cycle.

For example, suppose a change is returned to the originator, reworked, and then resubmitted for a second approval cycle. The Workflow tab shows the approvals and rejections of the change made during the first approval cycle, and during the second approval cycle.

Depending on where the change is in the workflow, the Workflow tab can have up to three sections:
- Workflow Overview Section (on page 115)
- Summary Table (on page 116)
- Signoff History Table (on page 116)

For information about all change object tabs, see Change Objects (on page 110).

See also: User Action Timestamp (on page 117).

Workflow Overview Section

The top section of the Workflow tab (visible for all changes that have been assigned a workflow) displays the name of the assigned workflow and a flowchart of the workflow, highlighting the current status of the change.

Some of the statuses in the flowchart are links. Links are underlined. You can switch the change to one of these statuses by clicking the link and filling in the Notify field. You need sufficient privileges to do this.

In Java Client, the status with a yellow background is the current status.

In Web Client, the status with an orange background is the current status.

See also: Workflow Tab (on page 115), User Action Timestamp (on page 117).
Summary Table

The Summary table (visible for changes in a Review or Released status) lists the signoff information for the current status. It has the following columns by default; the Agile administrator may have modified the table:

- **Action** – the action taken by the reviewer.
- **Req'd** – whether the reviewer is a required reviewer (approver) or not (observer).
- **Reviewer** – the user who reviewed the change. This can be an approver or an observer, and it can be a single user or a user group.
- **Signoff User** – the name of the user who actually approved or rejected the change.
- **Local Client Time** – the date and time of the action.
- **Signoff Comments** – any comments made by the reviewers (approvers and observers) during signoff.

See also: [Workflow Tab](#) (on page 115), [User Action Timestamp](#) (on page 117).

Signoff History Table

The History table of the **Workflow** tab lists past workflow and signoff information for the change. It has the following columns by default; the Agile administrator may have modified the table:

- **Workflow** – the name of the workflow that the change is following.
- **Workflow Status** – the name of the status.
- **Action** – the action taken by the reviewer.
- **Req'd** – whether the reviewer is a required reviewer (approver) or not (observer).
- **Reviewer** – the user who reviewed the change. This can be an approver or an observer, and it can be a single user or a user group.
- **Signoff User** – the name of the user who actually approved or rejected the change.
- **Status Changed By** – the name of the user who switched the status.
- **Local Client Time** – the date and time of the action.
- **Signoff Comments** – any comments made by the reviewers (approvers and observers) during signoff.

The Add Approvers/Observers and Remove Approvers/Observers actions are controlled by the Ad Hoc Approvers/Observers property settings for each workflow. In addition, you must have the appropriate privileges to add or remove approvers and observers. If the Agile administrator has not granted the appropriate privileges to you, the buttons on the **Workflow** tab are not available, and you cannot perform the actions.

In Java Client, the **Add Approvers/Observers** and **Remove Approvers/Observers** buttons appear at the top left of the **Workflow** tab. To add approvers or observers, and click **Add Approvers/Observers** and select...
the workflow status you want in the dialog. To remove an approver or observer, click \(-\) and choose the status you want in the dialog.

In Web Client, the \(\text{Add Approvers/Observers} \quad \text{and} \quad \text{Remove Approvers/Observers}\) buttons appear at the top left of the Workflow tab. Click the button for the action you want to perform, then follow the wizard steps.

See also: Workflow Tab (on page 115), User Action Timestamp (on page 117).

User Action Timestamp

Agile PLM provides two ways to record the date and time of any action taken against the change:

- **Local Client Time** – This is the date and time as shown on the local client computer of the user who is viewing the timestamp. Local client time is the default method of viewing timestamps.
  
  For example, if Mary approves a change at 12 noon in New York (Eastern time), when John looks at the Workflow tab of the change in California, he sees the time Mary approved the change as 9 o’clock in the morning (Pacific time).

- **User Action Time** – This is the date and time on the computer where the action was performed. User action time is optional.

  If Mary approves a change at 12 noon in New York, when John in California looks at the Workflow tab of the change, he sees the following:
  
  - In the Local Client Time column, the time Mary approved the change is 9 o’clock in the morning (Pacific time).
  - In the User Action Time column, the time Mary approved the change is 12 noon (Eastern time).

  When Mary looks at the Workflow tab of the change, she sees the following:
  
  - In the Local Client Time column, the time she approved the change is 12 noon (Eastern time).
  - In the User Action Time column, the time she approved the change is 12 noon (Eastern time).

Local Client Time always appears on the Workflow tab and History tab. User Action Time is optional, and is displayed on the Workflow tab of changes and the History tab of any Agile object only if the Agile administrator specifies this.

See also: Workflow Tab (on page 115).

Relationships Tab

The change object Relationships tab allows you to create relationships and dependencies between the change object and other routable objects and lifecycle objects. The Rule column displays the rule that defines how the workflow status or lifecycle phase of other objects affect the workflow progression of the current change object, or how the workflow progression of the current change object affects the workflow progression of the objects.

A relationship without a specified rule does not limit or affect the workflow progression or lifecycle status of either the current change object or the related object. You can use non-rule relationships to record objects that are somehow related to the current change object, but do not have any
dependencies with the current change object.

For more information about relationships and how to use this tab, see the chapter about working with business objects in *Getting Started with Agile PLM*.

For information about all change object tabs, see *Change Objects* (on page 110).

**Attachments Tab**

All objects have an *Attachments* tab. On the *Attachments* tab, you can attach files and URLs to the object by referencing those files and URLs in a file folder object. On the *Attachments* tab, you can view, copy (get), or print attached files if you have the appropriate privileges.

Individual attached files are stored in file folder objects and can be attached to multiple objects. The files in a file folder object can be drawings or scanned images, documents, non-viewable files, compressed files, and so on.

For detailed information about working with file folder objects and the *Attachments* tab, see *Getting Started with Agile PLM*.

**Note** Files that pertain to an item should be referenced on the *Attachments* tab of the *item*, rather than the *Attachments* tab of a change that affects the item.

For information about all change object tabs, see *Change Objects* (on page 110).

**History Tab**

The *History* tab shows a summary of actions taken against an object, including a description of the action, which user took the action, the date of the action, and other details.

**Note** If you do not have the appropriate Read privilege for an object, you cannot see the contents of the fields on the *History* tab. See *Details about Discovery and Read Privileges* (on page 177).

The *History* tab shows a summary of actions taken against the change, including:

- The current status of the change
- The next status of the change
- A description of the action
- Which user took the action
- The date and time of the action (local client time)
- The user action time (optional; see *User Action Timestamp* (on page 117))
- Which affected object was the subject of the action
- The find number of the component of the affected item
- Details of the action
- Comments made by users
Users notified

While the change status is Unassigned or Pending, the following actions are recorded on the History tab:

- The creation of the change.
- Any subclass modifications.
- Any actions on the Relationships tab and the Attachments tab.

**Note**  
Actions for changes that have not moved out of the Pending status types are recorded for modifications to the Relationships tab and Attachments tab only. A change must have a status type other than Pending, such as Submit or Review, before other actions are recorded on the History tab.

The types of actions recorded after a change moves out of the Pending status are:

- Modify or remove an item on the Affected Items tab
- Redline an item on the redlines tab of the Affected Items tab
- Add, get, or check in or out a file attachment through the Attachments tab of the change
- Add or remove approvers
- Approvals and rejections
- Reminder notifications
- Escalation notifications
- Field change, any tab
- Status change
- Autopromotion failure
- Attempt to change status without satisfying status-specific criteria
- Subclass change
- Comments
- Send
- Print
- Subscribe
- Save As
- Share

When you make modifications to a date field on a change after the change has exited the Pending status type, Agile PLM records the dates and times in the Details column of the History tab using the local date and time on the computer where the Agile Application Server is installed. Agile PLM uses a static format, for example, **2003/08/02 15:00:23 (GMT - 07:00) (yyyy/MM/dd)** (Greenwich Mean Time).

Comments on the History tab are different from the comments on the Workflow tab. Comments on the Workflow tab come from approvers and observers when they perform the online approval process. Comments on the History tab can be made by anyone with sufficient privileges at any time.
For information about all change object tabs, see Change Objects (on page 110).

**Workflow Routings Inbox**

You can view Agile changes that have been submitted to you in the Agile Workflow Routings Inbox.

**To view the Workflow Routings Inbox in Java Client:**

In the menu bar, click the small down arrow next to the Inbox button 📫, and choose Workflow Routings.

**To view the Workflow Routings Inbox in Web Client:**

In the menu bar, click the Home button (or click the Inbox button, if it is displayed). Depending on the Preferred Inbox View setting in your user profile, either the Workflow Routings page appears, or you can click Workflow Routings under Inbox to display it.

You can also open your inbox from the shortcuts section of the navigation pane.

See also: Routing Managers: Change Analyst and Component Engineer (on page 127).

For detailed information about working with routable objects, see Getting Started with Agile PLM.

**Changes and Manufacturing Sites**

Changes can affect site-specific information. Before you add affected items to a change, specify the manufacturing site that you want to affect. For general information about sites, see the chapter Sites and Distributed Manufacturing (on page 33).

This section includes the following topics.

- Site Information Affected by Changes (on page 121)
- Sites and ECOs (on page 121)
- Sites and MCOs (on page 122)
- Site Change Orders (on page 122)
For information about working with the Affected Items tab, see the chapter *Affected Items of Changes* (on page 129).

### Site Information Affected by Changes

The following data is subject to change control:

- Site-specific portion of the BOM
- Site-specific portion of the AML
- Dispositions
- Effectivity dates
- Release of a site association after the item is released

All of the above data can be directly edited before it is released. After the data is released, BOM and AML data may be redlined via an ECO, MCO, or SCO. A new item revision is not required, but will be made if the modification is made using an ECO.

See also: *Changes and Manufacturing Sites* (on page 120).

### Sites and ECOs

You can use an ECO to perform the following site-related actions:

- Modify the common or site-specific BOM of an item.
- Modify the common or site-specific AML of an item.
Modify dispositions site-specifically.
Modify the effectivity and obsolete dates of site-specific items.

See also: Changes and Manufacturing Sites (on page 120).

Sites and MCOs

You can use an MCO to modify the common and site-specific AML of an item or change the lifecycle phase of an item.

You can use MCOs for all sites. For example, let’s say there are two competing MCOs with site-specific information. When the first MCO is released, the pending MCO is rebased to the newly released MCO. In a similar manner, if a pending MCO has competing site-specific redlines with a pending ECO or SCO, when the ECO or SCO is released, the pending MCO is rebased to the newly released ECO or SCO.

See also: Changes and Manufacturing Sites (on page 120).

Site Change Orders

You can use site change orders (SCOs) to make site-specific changes to an item without changing the revision of the parent item.

With SCOs, you can modify the effectivity and obsolete dates, and the dispositions of previous revisions of an item, on a site-by-site basis. This allows you to use an explicit process to propose, review, and approve the modification of effectivity dates and to record the reasons why the effectivity dates were changed.

Note: You cannot use an SCO to make redline modifications to a previous revision of an item. All redline modifications must be made to the latest released revision of an item.

You can use an SCO to do the following:
- Modify the site-specific BOM of an item for latest revisions.
- Modify the site-specific AML of an item for the latest revisions.
- Modify the site-specific dispositions. Includes latest and non-latest revisions.
- Modify the effectivity and obsolete dates of site-specific items. Includes latest and non-latest revisions.

More than one site can be affected by an SCO, however, each row on the Affected Items tab applies to only one site. Duplicate items are not allowed; for example, if you add item P001 for site A, you cannot also add P001 for site B. You cannot use an SCO to modify the common site portion of the BOM or AML. Also, you cannot use an SCO to modify the BOM of an item that has not been released by an ECO; that is, an SCO cannot modify preliminary BOMs.

See also: Changes and Manufacturing Sites (on page 120).

Site-Specific Effectivity and Obsolete Dates

You can use an SCO to add site-specific effectivity and obsolete dates of an item without creating a
new revision of the item. (Use an ECO if you want to create a new revision.)

When items are added to the Affected Items tab of the SCO, the system checks to see if each of the BOM items lists the site on the Sites tab. Depending on Agile SmartRule settings, if a site is not listed, the SCO may not be released, and the site must be added to the item in order to release the SCO.

Note Releasing the SCO sends the item and BOM information to the ERP system of the site. Depending on your ERP system, if the SCO is against a revision of the item other than the latest revision, this could result in a different current revision in the ERP system.

At the time you add an item to the Affected Items tab of an SCO, you select an ECO-released item revision. The dispositions and the effectivity and obsolete dates on the SCO Affected Items tab are initially set to be the same as the latest effectivity and obsolete date of that revision. (The latest effectivity and obsolete dates are derived from the ECO-released revision or from a previously released SCO based on the ECO-released revision.) You can then specify site-specific dispositions and site-specific effectivity and obsolete dates. If the dispositions and effectivity and obsolete dates of the ECO-released item revision are modified after you have added the item to the SCO Affected Items tab, these fields are not automatically updated on the SCO Affected Items tab. Instead, your site-specific dispositions and effectivity and obsolete dates are maintained on the SCO.

Note If you rebase the SCO Affected Items tab row by selecting a different ECO-released item revision, the dispositions and the effectivity and obsolete dates on the SCO Affected Items tab row are also rebased and set to be the same as the newly selected ECO-released revision.

See also: Changes and Manufacturing Sites (on page 120), Site Change Orders (on page 122).

The Relationship of Changes to Item Revisions

This section describes the rules Agile PLM uses to determine which revision of an item is affected by the change and offers additional guidelines. For more information about item revisions, see Working with Item Revisions (on page 13).

Items with an ECO Revision Only

- A pending or released SCO can be based only on a revision created by a released ECO.
- An ECO cannot be unreleased if there is a pending or released SCO based on it.

MCOs on Items with ECO Revisions

- When a new ECO is created and released, and a pending MCO exists against a previous revision of the item, the MCO changes to be based on the new ECO revision, and it inherits content from the new revision.
- An MCO cannot be unreleased if there is a released SCO based on it.

Items with an Initial MCO Revision Only

When an MCO is released against the item before the item is released by an ECO (called an initial MCO revision, or blank revision), a pending SCO cannot be based on the blank revision.
Creating Changes

To create a change, you must have the appropriate privilege.

In Java Client, you can create a change with the File | New | Change command, the New Object button 📝, or the Save As command, on the More Actions menu (click the More button 🎲 at the top of the object window) and on the right-click shortcut menu.

In Web Client, you can create an item with the Create 📝 | Change command or the Actions | Save As command.

Note For a site change order (SCO), when you add an item to the Affected Items table, if the selected site is not listed on the Sites tab of the item, you are prompted to add it to the Sites tab of the item. If you later cancel the SCO, or remove the item from the Affected Items table, the new site assignment remains on the Sites tab of the item.

In Web Client, when you create a change, the create wizard allows you to add items to the Affected Items table of the change. If you cancel the change creation wizard, and do not complete the creation of the SCO, any new site assignments remain on the Sites tabs of the items.

For more information about creating changes and other objects, see Getting Started with Agile PLM.

Note Once a change is created, it exists until you delete it. If you create a new change, then decide you do not wish to keep it, be sure to delete the change (soft-delete, then hard-delete); otherwise, the new change remains in the database, and the number cannot be reused. For information, see Deleting Changes (on page 126).

See also: Modifying Changes (on page 124).

Site Change Order Save As Limitations

You cannot initiate Save As from a non-Site Change Order (SCO) change object in order to create an SCO object, nor can you initiate Save As from an SCO object in order to create a non-SCO change object. Because Site Change Orders (SCOs) affect only site-specific information, and other types of changes are not limited to site-specific information (for example, ECOs and MCOs), SCOs can be Save-As-created only from another SCO. The Site Change Order's site-specific only usage makes it incompatible with other change types when using the Save As feature.

Modifying Changes

With sufficient privileges, you can modify editable fields. You can modify only fields that have been made editable by the Agile administrator.

To edit a change:

1. On the Cover Page tab:
   * In Java Client, modify the appropriate fields. Click Save when you finish editing the Cover
In Web Client, click **Edit** to put the **Cover Page** tab in edit mode. Modify the appropriate fields. Click **Save** when you are finished.

2. On the **Affected Items** tab, you can remove, add, and edit rows of affected items. (For more information, see [Adding an Item to the Affected Items Tab](#) (on page 136).)

3. On the **Relationships** tab, you can add, edit, or remove relationships, and you can add, edit, or remove relationship rules. (For more information, see [Getting Started with Agile PLM](#).)

4. On the **Attachments** tab, you can add and remove references to files and URLs in file folder objects. (For more information, see [Getting Started with Agile PLM](#).)

You cannot edit information on the **Workflow** or **History** tabs; those tabs are completed automatically.

See also: [Creating Changes](#) (on page 124).

### Agile Change Control Workflows

An Agile workflow is a sequence of statuses that a change follows as it goes through the change control process. The Agile administrator specifies the name of the workflow, the number and names of the statuses, and the properties that define each status.

See also: [Routing Managers: Change Analyst and Component Engineer](#) (on page 127).

For more information about routing changes and other Agile objects through workflows, see [Getting Started with Agile PLM](#).

### Redlining through ECOs, MCOs, and SCOs

*Redlining* highlights, in red, changes made to an object. ECOs, MCOs, and SCOs are the only changes that have redlining functions. Use these changes when you need to modify a released item. For information about the functions of these types of changes, see [Change Classes](#) (on page 109).

This section contains the following topics:

- [Redlining through ECOs](#) (on page 126)
- [Redlining through MCOs](#) (on page 126)
- [Redlining through SCOs](#) (on page 126)

Depending on your company policy, when you redline manufacturing data, use an ECO when you want to advance the revision of an item, or use an MCO when you *don’t* want to advance the revision of an item.

For information about redlining a BOM, see [Redlining the BOM of a Released Item](#) (on page 101).

For information about redlining an AML, see [Modifying Manufacturing Data from the Redlines Tab](#) (on page 67).

For information about redlining attachments, see [Getting Started with Agile PLM](#).
Redlining through ECOs

You can redline BOM and AML data and attachments using an ECO.

ECOs let you release new items and modify previously released items. When you create an ECO, a preliminary revision is created for any items modified by the change (the ones listed on the Affected Items tab). When the ECO is released, the preliminary revision is converted to a released revision for each modified item.

Redlining through MCOs

You can redline AML data using an MCO.

MCOs are similar in appearance and function to an ECO. However, MCOs do not change the revision of an item, unlike an ECO. Instead, the MCO number is displayed alongside the corresponding revision number in the Rev drop-down list. For example, if there is a pending MCO #M12345 against Rev B of an item, then, on the Rev drop-down list, that revision is listed as (B) M12345.

MCOs can be used to:
- Release a new item without a revision (but you can select its lifecycle phase)
- Modify the lifecycle phase of an item without changing its revision
- Redline manufacturing data (add, modify, or delete) on items (Manufacturers tab)

Redlining through SCOs

You can redline site-specific BOM and AML data using an SCO, but only against the latest released revision.

SCOs are similar in appearance and function to an ECO. However, SCOs do not change the revision of an item, unlike an ECO. Instead, the SCO number is displayed alongside the corresponding revision number in the Rev drop-down list. For example, if there is a pending SCO S12345 against revision B of an item, then, on the Rev drop-down list, that revision is listed as (B) S12345.

Deleting Changes

For important details about deleting change objects, see Deleting Agile Objects (on page 23).

Undeleting Changes

Since soft-deleted changes still exist in the database, you can undelete them if you have the necessary privileges, and if the change has no items on the Affected Items tab.

For more information on undeleting changes and other objects, see Getting Started with Agile PLM.
Printing Change Tabs

You can print object tabs and other data from your Agile PLM system. You can print the current tab or all tabs. Attachments are printed from their native applications or the Viewer.

In Java Client, with the object open, use the Print button.

In Web Client, with the object open, choose Actions | Print.

For additional information about printing objects, see Getting Started with Agile PLM.

When you print the Affected Items tab, redline information is also included.

Routing Managers: Change Analyst and Component Engineer

Note For detailed information about how to perform routing manager tasks, see Getting Started with Agile PLM, Chapter 8, Routing Objects with Workflows.

The user who oversees the routing and approval process of a change is the routing manager. The routing manager for changes is called the change analyst, and the routing manager for manufacturing change orders (MCOs) is called the component engineer. The Change Analyst or Component Engineer field on the Cover Page tab of the change lists the routing manager for that change. These fields are filled in automatically (as designated by the Agile administrator in the workflow settings) or selected manually by the user from a drop-down list.

Routing managers evaluate and assign changes, and they receive email notifications pertaining to the change objects to which they are assigned. Specific roles and privileges are required to perform the tasks of a routing manager. If you have questions about your assigned roles, contact the Agile administrator.

The following is an example of a typical change control process for a change using default Agile workflows:

1. A change (for example, an ECO or MCO) is created, and a workflow is selected.
2. The change is submitted to the change analyst (ECO) or component engineer (MCO).
3. The change analyst or component engineer switches the change to the next status, which routes the change to the specified approvers (members of the change control board) and observers.
4. The members of the change control board (CCB) either approve or reject the change, and their approval or rejection is recorded on the Workflow tab of the change.
5. If all the approvers approve the change, it is automatically promoted to the Released status (the next status).

Note Agile Administrator settings, including workflow settings and SmartRule settings, control when a change can be autopromoted. These settings determine the required fields that must be completed, the required actions of the approvers, and other conditions that must be met for autopromotion.

If any approvers reject the change, the change analyst or component engineer is notified and
either:

- Cancels the change by switching the status to Canceled.
  - Returns the change to the originator by switching the status to Pending.
  - Releases the change in spite of the rejection.

Depending on the workflow settings, the change may automatically be switched to a specified status when an approver rejects it.

For detailed information about working with and managing changes, see the chapter about routing objects with workflows in *Getting Started with Agile PLM*.

See also: [Agile Change Control Workflows](on page 125).
Chapter 6

Affected Items of Changes

This chapter includes the following:

- Affected Items Tab ................................................................. 129
- Affected Items by Manufacturing Site .................................... 135
- Viewing the Disposition of Parts in an ECO or SCO ........... 136
- Adding an Item to the Affected Items Tab .......................... 136
- Working with the Affected Items Table ................................. 144
- Removing an Item from the Affected Items Tab .................. 149
- Editing Rows in the Affected Items Tab .............................. 150
- Viewing the Redlines of an Affected Item ............................ 153

Affected Items Tab

This section includes the following topics:

- Buttons on the Affected Items Tab (on page 130)
- Fields on the Affected Items Tab (on page 131)

The Affected Items tab of a change lists the items that are affected by the change. If an item belongs to multiple manufacturing sites, then the default Affected Items row values are the default value for each site row. Users with sufficient privileges can use the Affected Items tab to:

- List the items affected by a change and give those items a pending revision (ECOs)
- Specify the revision of the item that is affected by the change (SCOs, ECRs, Deviations, Stop Ships)

Note: ECOs and MCOs affect only the most recently released revision of the item.

- View items listed on the Affected Items tab
- Create, view, or modify the Redline BOM tab data of affected items (ECOs and SCOs)
- Create, view, or modify the Redline Manufacturers tab data of affected items (SCOs, and MCOs; ECOs if SmartRule is set to allow it)
- Add redlines to attachments of items through the Redline Attachments tab (ECOs only)
- Specify the disposition of existing parts (ECOs, MCOs, SCOs, ECR, Deviation, and Stop Ship)

Users with Read privileges can:

- Open affected items
- Redline affected items (ECOs, MCOs, and SCOs)
- View the disposition of existing parts (ECOs, MCOs, and SCOs); you must scroll to the right to
bring the disposition fields into view.

**Note**  
If you do not have the Discovery privilege for an item, it does not appear on the **Affected Items** tab. You may see a message telling you how many items are not displayed. Depending on your Read privileges, you may not be able to view all the fields on the **Affected Items** tab.

**To open an item listed on the** Affected Items **tab:**

- In Java Client, double-click the affected item row. The item opens with the **Title Block** tab on top.  
  Or, right-click the item row, choose **Open**, then choose a tab. The item opens with the selected tab on top.
- In Web Client, click the item number. The item opens with the **Title Block** tab on top.

The revision associated with the change is selected in the **Rev** drop-down list.

**Buttons on the Affected Items Tab**

The following buttons on the **Affected Items** tab in Java Client are available or unavailable, depending on your privileges and whether it is appropriate to use them.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit Affected Items</strong></td>
<td>Displays the selected (checked) item in edit mode.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Deletes the selected item from the Affected Items table.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>Adds an item below the selected item. Depending on which option you choose, you can:</td>
</tr>
</tbody>
</table>
| - **Create** | an item while adding it.  
| - **Search** | for an existing item.  
| - **Type in Known Number(s)** | of one or more existing items. |
| **Fill Down Rows, Fill Up Rows** | Copies the values in each column of the first selected row (for Fill Down) or the last selected row (Fill Up), and pastes them into the corresponding cells of all other selected rows. See Fill Up Rows and Fill Down Rows Buttons in Java Client (on page 150). |
| **BOM Bulk Change** | Applies a change of an item to multiple BOMs that use the item. |
| **Manufacturer Part Bulk Change** | Applies a change of an item to multiple AMLs that use the item. |
| **View** drop-down list | Select **Show Sites** to list the site-specific information for each affected item. Each item is listed in multiple rows in the table, once for the default or common display of the item (the **Sites** field is blank) and once for each site associated with the item (the **Sites** field contains the appropriate site name.)  
Select **Hide Sites** to list only the default or common information of the item. Each item is listed only once in the table, and the **Sites** field is blank. |
The following buttons on the Affected Items tab in Web Client are available or unavailable, depending on your privileges and whether it is appropriate to use them.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Displays the selected (checked) item in edit mode.</td>
</tr>
<tr>
<td>Remove</td>
<td>Deletes the selected item from the Affected Items table.</td>
</tr>
<tr>
<td>Add</td>
<td>Add — Adds an item below the selected item. Depending on which option you choose, you can:</td>
</tr>
<tr>
<td></td>
<td>Create an item while adding it.</td>
</tr>
<tr>
<td></td>
<td>Search for an existing item.</td>
</tr>
<tr>
<td></td>
<td>Type in Known Number(s) of one or more existing items.</td>
</tr>
<tr>
<td>Bulk Change</td>
<td>Applies a change of an item to multiple BOMs or AMLs that use the item.</td>
</tr>
<tr>
<td>Fill Up</td>
<td>(Appear in Edit mode only. Appear next to each attribute that can be filled up or down.)</td>
</tr>
<tr>
<td>Fill Down</td>
<td>Copies the value of the field where the button is clicked to the fields above (Fill Up) or below (Fill Down) in the column of the selected rows.</td>
</tr>
<tr>
<td>Copy</td>
<td>Appear in Edit mode only. Allows you to copy and paste data from one row to another.</td>
</tr>
<tr>
<td>Paste</td>
<td>Use the column header checkboxes or Copy button menu selection to select the columns you want to copy. Select the row, then click Copy. Select another and click Paste.</td>
</tr>
<tr>
<td>View drop-down list</td>
<td>Select Show Sites to list the site-specific information for each affected item. Each item is listed in multiple rows in the table, once for the default or common display of the item (the Sites field is blank) and once for each site associated with the item (the Sites field contains the appropriate site name.)</td>
</tr>
<tr>
<td></td>
<td>Select Hide Sites to list only the default or common information of the item. Each item is listed only once in the table, and the Sites field is blank.</td>
</tr>
</tbody>
</table>

### Fields on the Affected Items Tab

The following table shows the Affected Items fields for each change class.

<table>
<thead>
<tr>
<th>Affected Items tab field</th>
<th>ECO</th>
<th>MCO</th>
<th>SCO</th>
<th>ECR</th>
<th>Stop ship</th>
<th>Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sites</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Affected Items tab field

<table>
<thead>
<tr>
<th>Field</th>
<th>ECO</th>
<th>MCO</th>
<th>SCO</th>
<th>ECR</th>
<th>Stop ship</th>
<th>Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Number</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Old Rev</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Old Lifecycle Phase</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Obsolete Date</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Rev</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Revision</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Effective Date</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lifecycle Phase</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Change Function</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Old Item Description (appears only if enabled)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item Description</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>On Order</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stock</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Work in Progress</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finished Goods</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

### Note

All required fields must be completed before a change can be released. (A user with Override privilege can release a change without filling in the required fields.) The Agile administrator determines which fields are required, but the New Rev field on an ECO is always required and cannot be overridden. Perform a status audit or release audit to verify that all required fields have been completed. For more information about auditing, see the chapter on workflows in *Getting Started with Agile PLM*. See the Agile administrator if you have questions about required fields.

### Sites Field in Affected Items Table

The Sites field indicates the manufacturing site for which the affected item was added. When the Sites field is blank, it indicates that the row shows information about the item that is common among all sites assigned to the item.
Old Item Description and Item Description

If the Agile administrator has configured the Agile system so that a released item’s Description field can be changed only by using the Affected Items tab of a change order, the affected items table will include both the Old Item Description field and the Item Description field (which might be renamed to New Item Description).

If your Agile system is configured for change order modification of the item’s Description field, the Old Item Description field is filled in automatically when you add the item to the Affected Items tab. You cannot modify the Old Item Description field on the Affected Items tab. However, if you have the appropriate privileges, you can enter a new description in the affected items table (New) Item Description field. This description appears in the Description field of the pending revision of the item.

The Item Description field (or New Item Description field) of a released change order cannot be used to modify an item’s Description field; the released item’s Description field can only be modified through the item’s Title Block tab, with the appropriate modify item privileges. Once the change order with the item on its Affected Items tab is released, even though you may have a modify privilege for released change orders, the change order Item Description field of released change orders cannot be modified, and therefore cannot be used to modify the item’s Description field.

For more information about modifying the item Description field, see Editing a Released Item’s Description Field (on page 27).

Important The item Description field cannot be modified through an MCO because an MCO does not create a new item revision. The MCO uses the Description field information from the ECO revision or Introductory revision on which it is based.

Revision

The Revision field indicates which revision of the item is affected by the change. The following table explains which item revisions can be affected by each kind of Agile change.

<table>
<thead>
<tr>
<th>Change class</th>
<th>Can be edited?</th>
<th>Default revision when item is added to Affected Items table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order (ECO)</td>
<td>No</td>
<td>When an item is added to the Affected Items table of a change order, the most recently released revision of the item appears in the Old Rev field. You cannot edit the ECO Affected Items table Old Rev field. Change orders always affect the most recently released revision of the item. If the item has never been released, then the change order affects the Introductory revision of the item. An ECO creates a new revision of the item and you must specify a new revision number or letter in the Affected Items table New Rev field. Note: A change order is the only Agile change object that can create a new item revision. For more information about ECOs, see Special Considerations for ECOs (on page 145)</td>
</tr>
</tbody>
</table>

Note: A change order is the only Agile change object that can create a new item revision.
<table>
<thead>
<tr>
<th>Change class</th>
<th>Can be edited?</th>
<th>Default revision when item is added to Affected Items table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer Change Order (MCO)</td>
<td>—</td>
<td>Manufacturer change orders always affect the most recently released revision of the item. If the item has never been released, then the MCO affects the Introductory revision of the item. The item revision number upon which the MCO is based is not displayed on the Affected Items tab if an MCO. For more information about MCOs, see Special Considerations for MCOs (on page 146).</td>
</tr>
<tr>
<td>Site Change Order (SCO)</td>
<td>Yes</td>
<td>When an item is added to the Affected Items table of a site change order, the most recently released revision of the item appears in the Revision field. You can edit the SCO Affected Items table Revision field to select a different item revision. An SCO can affect any released revision of the item. An SCO cannot affect an Introductory revision of an item. Only one revision of an item can be included on the Affected Items table of an SCO.</td>
</tr>
<tr>
<td>Engineering Change Request (ECR)</td>
<td>Yes</td>
<td>When an item is added to the Affected Items table of an engineering change request, the Revision field is blank. When the Revision field is blank, the ECR will affect the most recently released revision. Only released revisions are available for selection in this field. Pending revisions do not appear in this field. If the item has never been released, then the engineering change request affects the Introductory revision of the item. You can edit the ECR Affected Items table Revision field to select a different item revision.</td>
</tr>
<tr>
<td>Deviation</td>
<td>Yes</td>
<td>When an item is added to the Affected Items table of a deviation, the Revision field is blank. When the Revision field is blank, the deviation will affect the most recently released revision of the item. If the item has never been released, then the deviation affects the Introductory revision of the item. You can edit the deviation Affected Items table Revision field to select a different item revision.</td>
</tr>
<tr>
<td>Stop Ship</td>
<td>Yes</td>
<td>When an item is added to the Affected Items table of a stop ship, the Revision field is blank. When the Revision field is blank, the stop ship will affect the most recently released revision of the item. If the item has never been released, then the stop ship affects the Introductory revision of the item. You can edit the stop ship Affected Items table Revision field to select a different item revision.</td>
</tr>
</tbody>
</table>

**Obsolete Date and Effective Date**

The **Obsolete Date** field applies to the prior revision of the affected item, not the new revision. The...
obsolete date is the date the old revision becomes obsolete.

The **Effective Date** field applies to the new revision, and reflects the date that the new revision becomes effective.

**Lifecycle Phase and Old Lifecycle Phase**

By default, the **Lifecycle Phase** list has the following entries (the Agile administrator can add more):

- **Inactive** – Temporarily not in use and may be reactivated.
- **Obsolete** – Permanently discontinue the item.
- **Pilot** – Build with limited initial quantities as a pilot project.
- **Production** – Release for regular production.
- **Prototype** – Produce in very limited quantities for testing.

The **Old Lifecycle Phase** field is filled in automatically when you add the item to the **Affected Items** tab. You cannot modify the **Old Lifecycle Phase** field on the **Affected Items** tab.

If the item has been released, when you add it to the **Affected Items** tab, the **Lifecycle Phase** field is automatically filled in with the item’s current lifecycle phase; you can then modify the **Lifecycle Phase** field. If the item has never been released, when you add it to the **Affected Items** tab, initially both the **Old Lifecycle Phase** field and the **Lifecycle Phase** field are blank. You can then modify the **Lifecycle Phase** field.

**Note** If you leave the **Affected Items** table **Lifecycle Phase** field blank and release the change order, Agile uses the **Old Lifecycle Phase** to determine the lifecycle phase of the released object.

**Affected Items by Manufacturing Site**

With a change order (for example, an ECO), you can view and work with affected items for a specific manufacturing site by selecting Show Sites in the **View** drop-down list on the **Affected Items** tab. Each item on the table is expanded to display a row for each site associated with the item. Sites displayed are the ones to which you have access.

For example, to work with part number P345 for the Hong Kong site, select the row for part P345 with the site name Hong Kong in the **Sites** field of the row.

With a site change order (SCO), you view and work with items for a specific manufacturing site by selecting the appropriate site when you add the item to the **Affected Items** table. The modifications you specify on an SCO apply only to the site selected for the item.

**Fields That Allow Site-Specific Values**

The following fields in the **Affected Items** table can contain values that differ by site:

- Disposition fields: On Order, Work in Progress, Finished Goods, Stock, Field
- Effective Date
Obsolet Date

The following fields in the Affected Items table cannot contain values that differ by site:

- Item Description
- Old Item Description
- Lifecycle Phase
- Old Lifecycle Phase
- Old Rev
- New Rev

The Agile administrator uses the Site-Specific Field property to determine whether the other fields in the Affected Items table can contain values that differ by site.

**Site-Specific Effectivity and Obsolete Dates**

To modify or set the effective and obsolete date for a specific site, and nothing else is being done with the ECO, add the item to the **Affected Items** tab and create a new revision. If you do not want to create a new revision just for this modification, create an SCO and modify the effective and obsolete dates for the site on the SCO **Affected Items** tab.

**Viewing the Disposition of Parts in an ECO or SCO**

ECOs and SCOs have fields on the Affected Items table that specify what to do with existing parts affected by the change: On Order, Stock, Work In Progress, or Finished Goods. ECOs also include Field (for "in the field"). Each of these fields can have a list of disposition types defined by the Agile administrator. Examples of dispositions are Use, Scrap, and Rework.

**Adding an Item to the Affected Items Tab**

You can use the Add button to add an item to the **Affected Items** tab.

In Java Client, if you create a change from an open item by using the Create Change command on the More Actions menu (click the More button at the top of the object window) and on the right-click shortcut menu. That item is added to the **Affected Items** tab automatically.

In Web Client, if you create a change from an open item by using Actions | Create Change, that item is added to the **Affected Items** tab automatically.

This section contains the following topics:

- Using the Add Affected Items Wizard (on page 137)
- Performing Bulk Changes (on page 138)
- Special Considerations for ECOs (on page 145)
- Special Considerations for MCOs (on page 146)
Removing an Item from the Affected Items Tab (on page 149)

Note You cannot add an item that is locked by another user. An item is locked if a user has made modifications to the item, but has not yet saved those modifications. Once the item is saved, it is unlocked.

Using the Add Affected Items Wizard

Note Tip: An easy way to use the Add button on the Affected Items tab in both clients is to click it once. The dialog appears that allows you to enter the number of an item, if you know it. In this dialog, click the Create or Search link to use those add item methods. If you are adding affected items to an SCO, the Create link is not available.

To add an item to the Affected Items tab in Java Client:

Open a change, and display the Affected Items tab.

1. Click the Add drop-down menu button and choose one of the add options: Search, Type in Known Numbers, or Create.

Note If you are adding affected items to an SCO, the Create option is not available.

2. Depending on your menu selection, do one of the following:
   • Search – Search for one or more existing items. In the Add Affected Item dialog box, select a search method. If you choose to perform a simple search, enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.) In the search results, select the items you want, and click OK. All the items in the Selected Affected Item(s) list are added to the Affected Items table.
   • Type in Known Numbers – enter one or more numbers and click Add.
   • Create – Select a type from the Type drop-down list. If appropriate, enter an object number. Click OK.

Note If you are adding affected items to an SCO, in the Add for Site drop-down list, select the site you want.

Adding items to the Affected Items table is similar to adding items to the BOM table. For more information about how to complete the dialogs, see Search for Items to Add to the BOM Table (on page 85), Type in the Number of an Item to Add to the BOM Table (on page 84), and Adding Nonexistent Items to the BOM Table (on page 90).

To add an item to the Affected Items tab in Web Client:

1. Open a change, and display the Affected Items tab.

2. On the BOM tab, click the Add button and choose one of the add options: Search, Type in Known Numbers, or Create New.

Note If you are adding affected items to an SCO, the Create New option is not available.

3. Depending on your menu selection, do one of the following:
   • Search – Search for one or more existing items. In the Add Affected Items dialog box, select a search method. If you choose to perform a simple search, enter the value to
search for and click Search. You can also define an advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). (For more information about searches, see Getting Started with Agile PLM.) In the search results, select the items you want, and click OK. All the items in the Selected list are added to the Affected Items table.

- **Type in Known Numbers** – enter one or more numbers and click Add.
- **Create New** – Select a type from the Type drop-down list. If appropriate, enter an object number. Click OK.

**Note** If you are adding affected items to an SCO, in the Add for Site drop-down list, select the site you want.

Adding items to the Affected Items table is similar to adding items to the BOM table. For more information about how to complete the dialogs, see Search for Items to Add to the BOM Table (on page 85), Type in the Number of an Item to Add to the BOM Table (on page 84), and Creating an Item Using Add (on page 22).

### Performing Bulk Changes

You can create an ECO that automatically adds, replaces, or removes an item from the assemblies on several BOMs at one time. Likewise, you can create an ECO or MCO that automatically replaces or removes a manufacturer part on the AML (Manufacturers tab) of several assemblies at one time. Such changes are called *bulk changes* and are created with a Bulk Change wizard.

The following sections explain how to use the bulk change features:

- **BOM Bulk Changes Overview** (on page 138)
- **Java Client BOM Bulk Change Wizard** (on page 139)
- **Web Client BOM Bulk Change Wizard** (on page 140)
- **Manufacturer Part (AML) Bulk Changes Overview** (on page 142)
- **Java Client Manufacturer Part Bulk Change Wizard** (on page 142)
- **Web Client Manufacturer Part Bulk Change Wizard** (on page 143)

### BOM Bulk Changes Overview

BOM bulk changes are available only from ECOs. The BOM Bulk Change wizard from an ECO gives you two options in the first wizard step:

- Add an item to multiple assemblies.
- Replace or remove an item from multiple assemblies.

If you select the option to replace or remove an item from multiple assemblies, the BOM Bulk Change wizard gives you the option to:

- Remove an item from all or some of the assemblies that use the item, and automatically redline the BOM of the assemblies affected by the Bulk Change.
- Replace an item in all or some of the assemblies that use the item, and automatically redline the BOM of the assemblies affected by the Bulk Change.
- Just add the selected assemblies to the Affected Items tab and manually redline their BOMs.
Java Client BOM Bulk Change Wizard

The Java Client BOM Bulk Change wizard allows you to specify modifications to multiple assemblies at one time. You have two BOM bulk change options:

- Add one item to multiple assemblies.
- Replace or remove one item from multiple assemblies.

The two procedures vary slightly; however, each wizard dialog guides you through the process. Both procedures are described below.

To add an item to multiple assemblies, Java Client:

1. From a pending or unassigned change, click the Affected Items tab to bring it forward. (You can use an existing change or create a new one.)
2. Click the BOM Bulk Change button.
   The BOM Bulk Change wizard appears.
3. Select the option Add an Item to multiple Assemblies, and click Next.
4. In the next wizard dialog, you specify the item that you want to add to multiple assemblies. Type an item number, or click to search for the item. In the Select Objects dialog, you can click the Create link to create a new item. After you specify an item number, click Next.
5. In the next wizard dialog, you specify which assemblies this bulk change will affect. Click the Add button to search for the assemblies to which you want to add the item selected in step 4. After you specify the assemblies, click Finish.

The redlined assemblies are added to the Affected Items table. You can view the change on the Redline BOM tab.

To replace or remove an item from multiple assemblies, Java Client:

1. From a pending or unassigned change, click the Affected Items tab to bring it forward. (You can use an existing change or create a new one.)
2. Click the BOM Bulk Change button.
   The BOM Bulk Change wizard appears.
3. Select Replace or remove and item from multiple Assemblies, and click Next.
4. In the next wizard dialog, you specify the item that you want to redline (replace, delete, or otherwise modify) in the assemblies that use it. Type an item number, or click to search for the item. After you specify an item number, click Next.
5. In the next wizard dialog, you specify which assemblies this bulk change will affect. From the displayed list of assemblies that use the item specified in step 4, select the assemblies you want to affect, then click Next.
6. In the next wizard dialog, you specify which action to perform. Your options are:
   - Replace <item> on all selected assemblies with <item>.
     That is, on the assemblies you selected in step 5, replace the item you selected in step 4 with the item you specify here. Type an item number, or click to search for the item.
When you are done, click **Next**.

The redlined assemblies (selected in step 5) will be added to the Affected Items table. You can view the changes on the **Redline BOM** tab.

- **Remove <item> from all selected assemblies**

  That is, remove the item you selected in step 4 from the assemblies you selected in step 5.
  
  Click **Next**.

  The redlined assemblies (selected in step 5) will be added to the Affected Items table if they are not already in the Affected Items table. You can view the changes on the **Redline BOM** tab.

- **Just add the selected assemblies to the Affected Items table and I will redline the BOMs myself.**

  That is, add the assemblies you selected in step 5 to the Affected Items table (if they are not already in the Affected Items table), but do not make any redline changes to the assemblies.

  Click **Finish**.

  The assemblies (selected in step 5) will be added to the Affected Items table if they are not already in the Affected Items table, and no redline changes will be made to them. Select an assembly in the Affected Items table, then make the redline changes you want on the **Redline BOM** tab.

  The assemblies are added to the Affected Items table according to the option you selected in step 6 above.

### Web Client BOM Bulk Change Wizard

The Web Client BOM Bulk Change wizard allows you to specify modifications to multiple assemblies at one time. You have two BOM bulk change options:

- **Add one item to multiple assemblies.**
- **Replace or remove one item from multiple assemblies.**

The two procedures vary slightly; however, each wizard page guides you through the process. Both procedures are described below.

**To add an item to multiple assemblies, Web Client:**

1. From a pending or unassigned change, click the **Affected Items** tab to bring it forward. (You can use an existing change or create a new one.)
2. Click the **Bulk Change** button and choose **BOM** from the menu.
3. In the Select Action wizard page, select **Add an Item to Multiple assemblies**, then click **Next**.
4. In the Identify Item To Add wizard page, you specify the item that you want to add to multiple assemblies. Type an item number, or click ![Search](image) to search for the item. In the Search Objects dialog, you can click the **Create** link to create a new item. After you specify an item number, click **Next**.
5. In the Identify Items to Add the item (**item number**) wizard page, you specify which assemblies this bulk change will affect. Click the ![Add](image) button to search for assemblies to which you want
to add the item selected in step 4. After you specify the assemblies, click Finish.

The redlined assemblies are added to the Affected Items table. You can view the change on the Redline BOM tab.

To replace or remove an item from multiple assemblies, Web Client:

1. From a pending or unassigned change, click the Affected Items tab to bring it forward. (You can use an existing change or create a new one.)
2. Click the Bulk Change button and choose BOM from the menu.
3. In the Select Action wizard page, select Replace or remove an item from multiple assemblies, then click Next.
4. In the Identify Item To Replace or Remove wizard page, you specify the item that you want to redline (replace, delete, or otherwise modify) in the assemblies that use it. Type an item number, or click Search to search for the item. After you specify an item number, click Next.
5. In the next wizard dialog, you specify which assemblies this bulk change will affect. From the displayed list of assemblies that use the item specified in step 4, select the assemblies you want to affect, then click Next.
6. In the Select Modify Action wizard dialog, you specify which action to perform. Your options are:
   - Replace Item Number on all selected assemblies with Item Number.
     That is, on the assemblies you selected in step 4, replace the item you selected in step 5 with the item you specify here. Type an item number, or click Search to search for the item. When you are done, click Finish.
     The redlined assemblies (selected in step 4) will be added to the Affected Items table if they are not already in the Affected Items table. You can view the changes on the Redline BOM tab.
   - Remove Item Number from all selected assemblies
     That is, remove the item you selected in step 4 from the assemblies you selected in step 5. Click Finish.
     The redlined assemblies (selected in step 4) will be added to the Affected Items table if they are not already in the Affected Items table. You can view the changes on the Redline BOM tab.
   - Just add the selected assemblies to the affected items table and I will redline the BOMs myself.
     That is, add the assemblies you selected in step 5 to the Affected Items table (if they are not already in the Affected Items table), but do not make any redline changes to the assemblies.
     Click Finish.
     The assemblies (selected in step 4) will be added to the Affected Items table and no redline changes will be made to them. Select an assembly in the Affected Items table, then make the redline changes you want on the Redline BOM tab.
     The assemblies are added to the Affected Items table according to the option you selected in step 6 above.
Manufacturer Part (AML) Bulk Changes Overview

You can perform a manufacturer part bulk change from an ECO (with AML capabilities) or an MCO, which automatically replaces or removes a manufacturer part from the Manufacturers tab of several items at one time. Manufacturer part bulk changes are created with the Manufacturer Part Bulk Change wizard.

You can use MCOs to bulk-change manufacturers data without rolling the revision, and use ECOs to bulk-change manufacturers data when you want to roll the revision. Depending on your company policy, use an ECO or an MCO to determine if the revision of an item advances when you redline manufacturers data.

The Manufacturer Part Bulk Change wizard, from an MCO or an ECO, gives you the option to:

- Remove a manufacturer part from all or some of the parts that use it, and automatically redline the Manufacturers tab of the assemblies affected by the manufacturer part bulk change.
- Replace a manufacturer part in all or some of the parts that use it, and automatically redline the Manufacturers tab of the assemblies affected by the manufacturer part bulk change.
- Just add the selected manufacturer part to the Manufacturers tabs, and then go back later to manually redline it.

Java Client Manufacturer Part Bulk Change Wizard

To replace or remove a manufacturer part from multiple items, Java Client:

1. From a change that has not been released, click the Affected Items tab to bring it forward. (You can use an existing change or create a new one.)

2. Click the Manufacturer Part Bulk Change button.

   The Manufacturer Part Bulk Change wizard appears.

3. In the first wizard dialog, you specify the manufacturer part that you want to redline (replace, delete, or otherwise modify) in the items that use it. Enter a manufacturer name and manufacturer part number, or click to search for the manufacturer part you want. After you specify a manufacturer part, click Next.
4. In the next wizard dialog, you specify which items this bulk change will affect. From the displayed list of items that use the manufacturer part specified in step 3, select the items you want to affect, then click Next.

5. In the next wizard dialog, you specify which action to perform. Your options are:
   - Replace <manufacturer part> on all selected assemblies with <manufacturer part>. That is, on the items you selected in step 4, replace the manufacturer part you selected in step 3 with the manufacturer part you specify here. Enter a manufacturer name and manufacturer part number, or click Search to search for the manufacturer part you want.
     For additional information about selecting a manufacturer name, see How to Use Manufacturer Name Automatic Validation (on page 59).
     When you are done, click Next.
     The redlined items (selected in step 4) will be added to the Affected Items table if they are not already in the Affected Items table. You can view the changes on the Redline Manufacturers tab.
   - Remove <manufacturer part> from all selected assemblies. That is, remove the manufacturer part you selected in step 3 from the items you selected in step 4.
     Click Next.
     The redlined items (selected in step 4) will be added to the Affected Items table if they are not already in the Affected Items table. You can view the changes on the Redline Manufacturers tab.
   - Just add the selected assemblies to the affected items table. That is, add the items you selected in step 4 to the Affected Items table (if they are not already in the Affected Items table), but do not make any redline changes to the items.
     Click Finish.
     The items (selected in step 4) will be added to the Affected Items table and no redline changes will be made to them. Select an item in the Affected Items table, then make the redline changes you want on the Redline Manufacturers tab.
     The items are added to the Affected Items table according to the option you selected in step 5 above.

**Web Client Manufacturer Part Bulk Change Wizard**

**To replace or remove a manufacturer part from multiple items, Web Client:**

1. From a change that has not been released, click the Affected Items tab to bring it forward. (You can use an existing change or create a new one.)
2. Click the Bulk Change button and choose Manufacturer Part from the menu.
   The Bulk Change wizard appears.
3. In the Identify Manufacturer Part wizard page, you specify the manufacturer part that you want to redline (replace, delete, or otherwise modify) in the items that use it. Enter a manufacturer name and manufacturer part number, or click Search to search for the manufacturer part you want. After you specify a manufacturer part, click Next.
4. In the Identify items to do bulk change operation wizard page, you specify which items this bulk
change will affect. From the displayed list of items that use the manufacturer part specified in step 3, select the items you want to affect, then click Next.

5. In the Select Action wizard page, you specify which action to perform. Your options are:
   - Just add the selected assemblies to the affected items table.
     That is, add the items you selected in step 4 to the Affected Items table (if they are not already in the Affected Items table), but do not make any redline changes to the items.
     Click Next.
     The items (selected in step 4) will be added to the Affected Items table and no redline changes will be made to them. Select an item in the Affected Items table, then make the redline changes you want on the Redline Manufacturers tab.
   - Replace Manufacturer Part Number `<manufacturer part>` on all selected assemblies with Manufacturer Part Number `<manufacturer part>`.
     That is, on the items you selected in step 4, replace the manufacturer part you selected in step 3 with the manufacturer part you specify here. Enter a manufacturer name and manufacturer part number, or click Search to search for the manufacturer part you want or to create a new manufacturer part.
     For more information about selecting a manufacturer name, see How to Use Manufacturer Name Automatic Validation (on page 59).
     When you are done, click Next.
     The redlined items (selected in step 4) will be added to the Affected Items table if they are not already in the Affected Items table. You can view the changes on the Redline Manufacturers tab.
   - Remove Manufacturer Part Number `<manufacturer part>` from all selected assemblies
     That is, remove the manufacturer part you selected in step 3 from the items you selected in step 4.
     Click Finish.
     The redlined items (selected in step 4) will be added to the Affected Items table if they are not already in the Affected Items table. You can view the changes on the Redline Manufacturers tab.

The assemblies are added to the Affected Items table according to the option you selected in step 5 above.

**Working with the Affected Items Table**

Once items have been added to the Affected Items table, there are additional steps required to complete each type of Agile change. The following sections summarize those steps.

- Special Considerations for ECOs (on page 145)
- Special Considerations for MCOs (on page 146)
- Special Considerations for SCO (on page 147)
- Special Considerations for ECRs (on page 147)
- Special Considerations for Deviations (on page 148)
Special Considerations for Stop Ships (on page 148)

Special Considerations for ECOs

The basic steps to complete an ECO are:

1. Add the items you want to modify to the Affected Items tab.
   See Adding an Item to the Affected Items Tab (on page 136).
   
   **Note** If you add a released item that has pending changes against it, Agile PLM tells you that the item has pending changes.

2. Edit the Affected Item tab fields, including the required fields, as described in Fields Required to Release an ECO (on page 145).
   See Editing Rows in the Affected Items Tab (on page 150).

3. If you added a released item that has BOM data or manufacturing data, you can redline the BOM data or manufacturing data and attachments (referenced in file folder objects) on the Redlines pane (Java Client) or page (Web Client).
   
   **Note** If you use the Create Change command to create an ECO from an open item, Agile PLM adds the item to the Affected Items table and, for released items, automatically prompts you to redline any BOM or manufacturer data.

In Java Client, the Create Change command is available on the item More Actions menu (click the More button at the top of the object window) and on the right-click shortcut menu. In Web Client, use Actions | Create Change in the item Actions menu.

Fields Required to Release an ECO

Required fields are defined for each status in the workflow. Use the audit feature to determine if all the required fields have been filled in.

In addition to the required fields defined in the workflow, the following Affected Items tab fields must always be completed before Agile PLM releases the ECO:

- New Rev
- Item Number

**Note** The Item Number field is completed automatically when you add the item to the Affected Items tab.

To complete the fields required to release an ECO:

- In the New Rev field, type the new revision number.

  If you leave the New Rev field blank, Agile PLM places a question mark (?) in the Rev field of the item.
You cannot release an ECO with a blank value in the affected item’s `Rev` field.

**Note** Other tabs may also have required fields that must be completed. The specific fields on your system may vary, depending on the workflow settings.

In Java Client, use the **Audit Release** button on the object window toolbar to verify that all required fields have been completed. Use the **Audit Status** button to verify that status required fields have been completed.

In Web Client, use the **Audit Release** command on the **Actions** menu to verify that all required fields have been completed. Use the **Audit Status** command on the **Actions** menu to verify that status required fields have been completed.

You cannot change the `New Rev` field on the **Affected Items** tab on a released change, even if you have the appropriate privileges to modify released changes. If you do not have the appropriate privilege to modify the Lifecycle Phase on the **Affected Items** tab of a released change, you can use an MCO to modify the lifecycle phase of an item without changing its revision level. See [Redlining through MCOs](on page 126) or more information.

### Special Considerations for MCOs

The basic steps to complete an MCO are:

1. Add the items you want to modify to the **Affected Items** tab.
   
   See [Adding an Item to the Affected Items Tab](on page 136).

2. Edit the **Affected Item** tab fields, including the required fields. MCOs allow you to select a new Lifecycle Phase.
   
   See [Editing Rows in the Affected Items Tab](on page 150).

3. If you added a released item that has manufacturing data, redline the manufacturers data.
   
   See [Modifying Manufacturing Data from the Redlines Tab](on page 67).

**Note** If you use the **Create Change** command to create an MCO from an open item, Agile PLM adds the item to the Affected Items table and, for released items, automatically prompts you to redline any manufacturer data.

In Java Client, the Create Change command is available on the item More Actions menu (click the **More** button at the top of the object window) and on the right-click shortcut menu. In Web Client, use Fields Required to Release an MCO

In addition to the required fields defined in the workflow, the **Item Number** field on the **Affected Items** tab must be completed before Agile PLM releases the MCO. This field is completed automatically when you add items to the **Affected Items** tab.

**Note** Other tabs also have required fields that must be completed. The specific fields on your system may vary, depending on the workflow settings.

In Java Client, use the **Audit Release** button on the object window toolbar to verify that all required fields have been completed.

In Web Client, use the **Audit Release** command on the **Actions** menu to verify that all required fields
have been completed.

**Special Considerations for SCOs**

**The basic steps to complete an SCO are:**

1. Add the items you want to modify to the **Affected Items** tab.
   - See [Adding an Item to the Affected Items Tab](on page 136).
   - **Note** If you add a released item that has pending changes against it, Agile PLM tells you that the item has pending changes.

2. Edit the **Affected Item** tab fields, including the required fields. You can modify the site-specific dispositions and the effective and obsolete dates of site-specific items for both the latest and non-latest revisions.
   - See [Site Change Orders](on page 122).

3. If you added the most recently released revision of an item to the SCO, you can redline site-specific BOM and AML data, but only against the latest released revision.
   - See [Redlining through ECOs, MCOs, and SCOs](on page 125).
   - See [Redlining the BOM of a Released Item](on page 101).
   - See [Modifying Manufacturing Data from the Redlines Tab](on page 67).

   **Note** Only the most recently released revision of an item can be redlined with an SCO.

   **Note** Other tabs also have required fields that must be completed. The specific fields on your system may vary, depending on the workflow settings.

In Java Client, use the **Audit Release** button on the object window toolbar to verify that all required fields have been completed. Use the **Audit Status** button to verify that status required fields have been completed.

In Web Client, use the **Audit Release** command on the **Actions** menu to verify that all required fields have been completed. Use the **Audit Status** command on the **Actions** menu to verify that status required fields have been completed.

**Special Considerations for ECRs**

**The basic steps to complete an ECR are:**

1. Add the items to the **Affected Items** tab.
   - See [Adding an Item to the Affected Items Tab](on page 136).
   - **Note** If you add a released item that has pending changes against it, Agile PLM tells you that the item has pending changes.

2. Edit the **Affected Item** tab Revision field and any custom fields that may be defined for your Agile
system.

See Editing Rows in the Affected Items Tab (on page 150).

**Note** Other tabs also have required fields that must be completed. The specific fields on your system may vary, depending on the workflow settings.

In Java Client, use the Audit Release button on the object window toolbar to verify that all required fields have been completed.

In Web Client, use the Audit Release command on the Actions menu to verify that all required fields have been completed.

**Special Considerations for Deviations**

The basic steps to complete a Deviation are:

1. Add the items to the Affected Items tab.
   
   See Adding an Item to the Affected Items Tab (on page 136).
   
   When adding by Type in Knows Numbers, you can enter the revision, preceded by a space character, when you type the number. For example:

   - 1000-02 A
   - P003872 D

   **Note** If you add a released item that has pending changes against it, Agile PLM tells you that the item has pending changes.

2. Edit the Affected Item tab Revision field and any custom fields that may be defined for your Agile system.
   
   See Editing Rows in the Affected Items Tab (on page 150).

**Note** Other tabs also have required fields that must be completed. The specific fields on your system may vary, depending on the workflow settings.

In Java Client, use the Audit Release button on the object window toolbar to verify that all required fields have been completed.

In Web Client, use the Audit Release command on the Actions menu to verify that all required fields have been completed.

**Special Considerations for Stop Ships**

The basic steps to complete a Stop Ship are:

1. Add the items to the Affected Items tab.
   
   See Adding an Item to the Affected Items Tab (on page 136).
   
   When adding by Type in Knows Numbers, you can enter the revision, preceded by a space character, when you type the number. For example:

   - 1000-02 A
   - P003872 D
Note: If you add a released item that has pending changes against it, Agile PLM tells you that the item has pending changes.

2. Edit the Affected Item tab Revision field and any custom fields that may be defined for your Agile system.

   See Editing Rows in the Affected Items Tab (on page 150).

Note: Other tabs also have required fields that must be completed. The specific fields on your system may vary, depending on the workflow settings.

In Java Client, use the Audit Release button on the object window toolbar to verify that all required fields have been completed.

In Web Client, use the Audit Release command on the Actions menu to verify that all required fields have been completed.

Removing an Item from the Affected Items Tab

When you delete an item from the Affected Items tab, any attachments added to the item under the pending revision defined in that change are lost. This is true for all pending revisions, including items that have never been released and have only one change against them. If there is only one change pending against the item, and you delete the item from that change, the item reverts to a preliminary item with no changes against it, and any attachments added under that last change are lost.

When you remove an item from the Affected Items tab, any item redlines made through that change are dropped and discarded. Any attachments added to the pending revision created by that change are removed from the item. Agile PLM displays warnings before dropping redlines or removing attachments; accept the warnings to complete the item removal.

To remove an item from the Affected Items tab in Java Client:

1. If necessary, select Show Sites in the View drop-down list to expand the table to show an item row for each site assigned to the item.
2. Click to select the row for the item that you want to delete. (You can select multiple items.)
3. Click the Remove button.

Caution: Be sure to use the Remove button on the Affected Items tab to remove items from that tab. If you use the Delete button on the object window toolbar (Java Client) or the Delete command on the object Actions menu (Web Client), Agile PLM deletes the entire change.

To remove an item from the Affected Items tab in Web Client:

4. If necessary, select Show Sites in the View drop-down list to expand the table to show a row for each site assigned to the item.
5. Check the box for the item that you want to delete. (You can check multiple items.)
6. Click the Remove button.
Caution  Be sure to use the Remove button on the Affected Items tab to remove items from that tab. If you use the Delete button on the object window toolbar (Java Client) or the Delete command on the object Actions menu (Web Client), Agile PLM deletes the entire change.

Editing Rows in the Affected Items Tab

You can edit rows on the Affected Items table, including rows associated with a specific site. You can also copy and paste information between these rows.

Note  You cannot edit the item description from MCOs, ECRs, deviations, or stop ships. The item description is inherited from the latest released ECO.

This section includes the topics:

- Editing Affected Items Tab Rows in Java Client (on page 150)
- Editing Affected Items Tab Rows in Web Client (on page 151)

Editing Affected Items Tab Rows in Java Client

To edit affected item information in Java Client:

1. If necessary, select Show Sites in the View drop-down list to expand the table to show a row for each site assigned to the item.
2. Click to select the rows you want to edit. You can use Ctrl-click and Shift-click to select multiple rows.
3. Click the Edit button.
   The Edit Affected Items dialog box appears.
4. Make the modifications you want.
5. When you are finished, click OK.

Fill Up Rows and Fill Down Rows Buttons in Java Client

By selecting a group of fields in one column, you can use the Fill Up Rows button to copy the contents of the bottom-most selected field into all the selected fields above it. You can use the Fill Down Rows button to copy the contents of the top-most selected field into all the selected fields below it. You can use Ctrl-click to select non-contiguous fields, and you can use Shift-click to select contiguous fields.

You can fill up and fill down in multiple columns at one time. Once you have selected fields in one column, you can select multiple additional columns using Ctrl-click (non-contiguous columns) and Shift-click (contiguous columns). The Fill Up Rows button copies the contents of the bottom-most selected field in each column into all the selected fields in each column. The Fill Down Rows button copies the contents of the topmost selected fields in each column into all the selected fields in each column.
Note Fill Up and Fill Down are available in edit mode for any editable table. Attributes that require unique identifier data or other unique data do not have Fill Up and Fill Down capability, for example: Item Number on the Affected Items tab, Manufacturer Name and Manufacturer Part Number on the Item Manufacturers tab, or Item Number and Find Number on the Item BOM tab.

To copy information between rows in Java Client:

1. If necessary, select Show Sites in the View drop-down list to expand the table to show a row for each site assigned to the item.
2. Click to select the rows you want to edit. You can use Ctrl-click and Shift-click to select multiple rows.
3. Click the Edit button.
   The Edit Affected Items dialog box appears.
4. Click to select the fields you want to fill in. Use Shift-click and Ctrl-click to select the fields in each column and to select additional columns you want to fill in. The fill up and fill down action is defined by the selected (highlighted) fields in each column in the Affected Items table.
   Both the source row and the target rows must be highlighted. The top-most row or the bottom-most row is the source row.
   You may want to edit the top-most or bottom-most row in the Affected Items table, then use the Fill Up Rows and Fill Down Rows buttons to complete the remaining rows in the table.
5. Click the Fill Up Rows or Fill Down Rows button to fill in the selected Affected Items table fields.
6. When you are finished, click OK.

Editing Affected Items Tab Rows in Web Client

To edit affected item information in Web Client:

1. If necessary, select Show Sites in the View drop-down list to expand the table to show a row for each site assigned to the item.
2. Select the row of item that you want to edit. (You can select multiple items and multiple site rows for each item.)
3. Click Edit. Text boxes, drop-down lists, and calendar wizard buttons appear in the editable columns.
4. Make any changes, then click Save to save the changes, or click Cancel to cancel the changes.

Fill Up Rows and Fill Down Rows Buttons in Web Client

To copy information between rows in Web Client:

1. If necessary, select Show Sites in the View drop-down list to expand the table to show a row for each site assigned to the item.
2. Select the rows of items that you want to edit. (You can select multiple items and multiple site rows for each item.)
3. Click Edit. Text boxes, drop-down lists, and calendar wizard buttons appear in the editable
columns.

A set of Fill Down and Fill Up buttons appear next to each field that can be copied between rows.

4. Select (highlight) the target rows, the rows to which you want to copy cell values.

5. Click the Fill Down button to copy the contents of that cell to all the cells in the highlighted rows in the column below the current cell.

6. Click the Fill Up button to copy the contents of that cell to all the cells in the highlighted rows in the column above the current cell.

Note If you click Fill Down or Fill Up next to an empty cell, the cells in the column below (fill down) or above (fill up) the current cell are cleared; the empty cell is copied down or up the column.

7. When you are finished editing the affected items, click the Save button.

Copy and Paste Buttons in Web Client

To copy information between rows in Web Client:

1. If necessary, select Show Sites in the View drop-down list to expand the table to show a row for each site assigned to the item.

2. Select the rows of items that you want to edit. (You can select multiple items and multiple site rows for each item.)

3. Click Edit. Text boxes, drop-down lists, and calendar wizard buttons appear in the editable columns.

   The column headers now have checkboxes so that you can specify which information to copy and paste.

4. Click the row from which you want to copy information. The row changes color to indicate that it is selected. (To deselect a row, just click it again.)

5. Click the Copy button. The row you selected is now outlined with a dashed line. This indicates that this is the row from which you are going to copy information.

   You can now use the Copy button menu selections. The Copy button menu has the following menu commands:

   - Select All Columns
   - Deselect All Columns
   - Cancel Copy

6. Click the row into which you want to paste the information. You can select multiple rows using the Shift or Ctrl key and the arrow keys.

7. Select the checkboxes of the columns into which you want to paste data. To select or deselect all columns, click the Copy button and choose Select All Columns or Deselect All Columns.

8. To paste the information, click the Paste button.
9. To paste information from a different row, click the \( \text{Copy} \) button and choose \text{Cancel Copy}. This clears the copy/paste Clipboard.

To cancel a copy operation, before pasting, click the \( \text{Copy} \) button and choose \text{Cancel Copy}.

10. When you are finished editing the affected items, click the \text{Save} button.

**Viewing the Redlines of an Affected Item**

In Java Client, if an affected item has a BOM, an AML, or attachments, you can view its Redlines tabs by clicking in its row in the Affected Items table. The Redline tabs for the selected item appear in the bottom portion of the \text{Affected Items} tab.

In Web Client, if an affected item has a BOM, an AML, or attachments, you can view its Redlines page by clicking the \( \text{or} \) button in its row in the Affected Items table.

- For information about the Redline BOM tab, see \text{Redlining the BOM of a Released Item} (on page 101).
- For information about the Redline Manufacturers tab, see \text{Modifying Manufacturing Data from the Redlines Tab} (on page 67).
- For information about the Redline Folders tab, see \text{Getting Started with Agile PLM}.
Chapter 7

Working with Product Reports and Process Reports

This chapter includes the following:

- About Agile Reports ................................................................. 155
- About Product Reports and Process Reports ......................... 156
- Agile Products Reports ............................................................ 157
- Agile Process Reports ............................................................... 168

About Agile Reports

Reports allow you to display the values of your product records. By accessing this information and summarizing it in a meaningful way, reports provide insight into your business processes and can help guide better-informed decisions. Agile PLM provides a robust reporting platform that allows you to:

- Measure and monitor business performance using standard out-of-the-box reports. These standard reports capture the best practices in product lifecycle management business processes.
- Configure reports with Agile’s custom reporting to obtain the specific information you need.
- Use a single point of access to all relevant reports—even those developed outside of the Agile PLM application—through Agile’s external reporting capability.

For detailed information about using all types of Agile reports, see the Working with Agile Reports chapter in Getting Started with Agile PLM, which includes information about:

- How your roles and privileges affect reports
- Report object tabs
- Creating and modifying report layouts
- Creating custom and external reports
- Running, scheduling, saving, and deleting reports
- Report output window

This chapter covers the Agile standard reports that are included as part of Agile Product Collaboration: product reports and process reports.
About Product Reports and Process Reports

Standard reports provide you with the information you commonly need to analyze your business processes. Product reports and process reports are the standard out-of-the-box reports for Product Collaboration. You select predefined criteria and specify the results you want. You can run them as they are, modify the default layouts, or create your own layouts. You can run Agile product reports and process reports from Agile Web Client or Java Client.

Accessing Product Reports and Process Reports

To access product reports in Java Client:
1. Click the Analytics and Reports tab in the left pane to display the reports folders.
2. Open the Standard Reports folder to locate the Product Reports folder or the Process Reports folder.
3. Open the Product Reports folder or the Process Reports folder and double-click the report you want. Web Client opens and displays the report page you selected.

To access product reports in Web Client:
1. Click the Analytics and Reports icon in the left pane to display the reports folders.
2. Open the Standard Reports folder to locate the Product Reports folder or the Process Reports folder.
3. Open the Product Reports folder or the Process Reports folder and click the report you want. The report page is displayed in the right pane.

Products Reports

The Products Reports folder lists the following reports:
- Assembly Cost (Item Master) Report (on page 158)
- BOM Comparison Report (on page 159)
- BOM Explosion Report (on page 160)
- Consolidated BOM Report (on page 161)
- Effective BOM Explosion Report (on page 163)
- Item Activity Report (on page 164)
- Item Manufacturers Report (on page 164)
- Manufacturer BOM Report (on page 165)
- Where Used Report (on page 167)

For more information about specific product reports, see Agile Products Reports (on page 157).

Process Reports

The Process Reports folder lists the following reports:
For more information about specific product reports, see Agile Process Reports (on page 168).

**Agile Products Reports**

The Products Reports folder under Standard Reports in the navigation pane lists the Product Collaboration reports.

<table>
<thead>
<tr>
<th>Report</th>
<th>Displays...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill of Materials (BOM) reports</td>
<td></td>
</tr>
<tr>
<td>Assembly Cost (Item Master) Report (on page 158)</td>
<td>The Assembly Cost report takes the bill of material for a specified assembly and computes the cost of the BOM and each subassembly.</td>
</tr>
<tr>
<td>BOM Comparison Report (on page 159)</td>
<td>The BOM Comparison report shows the differences between two or more bills of material.</td>
</tr>
<tr>
<td>BOM Explosion Report (on page 160)</td>
<td>The BOM Explosion report displays the bill of material for a specified assembly up to the desired number of levels.</td>
</tr>
<tr>
<td>Consolidated BOM Report (on page 161)</td>
<td>The Consolidated BOM report takes the bill of material for a specified assembly and consolidates it into a single-level bill, computing the total quantity of each item.</td>
</tr>
<tr>
<td>Effective BOM Explosion Report (on page 163)</td>
<td>The Effective BOM report displays the bill of material for a specified assembly that is effective during a specific time period.</td>
</tr>
<tr>
<td>Item Activity Report (on page 164)</td>
<td>The Item Activity report shows the items that were processed during a specified period of time.</td>
</tr>
<tr>
<td>Where Used Report (on page 167)</td>
<td>The Where Used report shows where the component or subassembly is used, up to any practical number of levels.</td>
</tr>
<tr>
<td>Manufacturer reports</td>
<td></td>
</tr>
<tr>
<td>Item Manufacturers Report (on page 164)</td>
<td>The Manufacturer Item report displays a list of all the items matching a query and shows the manufacturers that are used for each item. (Requires AML server license.)</td>
</tr>
<tr>
<td>Manufacturer BOM Report (on page 165)</td>
<td>The Manufacturer BOM report runs the BOM Explosion report and includes the manufacturers that are used for each item in the bill of material. (Requires AML server license.)</td>
</tr>
</tbody>
</table>
Assembly Cost (Item Master) Report

This report generates a cost rollup by determining the cost and quantity of each component and assembly and calculating the total cost. The report shows the same data as the BOM Explosion report with the addition of three columns:

- Individual Cost
- Total Cost
- Assembly Cost

To run the Assembly Cost report:


2. Click the Execute button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in Getting Started with Agile PLM. Click Next.

3. Select the items you want to include in the report. Click Add to open the Add Items wizard. You can then select Search or Advanced Search to find items, or locate them using saved searches or shortcuts (My Bookmarks list or Recently Visited list). Select the items you want in the Search Results window; the selected items appear in the Selected Items list. Click OK to close the wizard.

4. By default, the most recently released revision of the item is selected in the Select Items for Report page of the report wizard. To select a different revision, use the drop-down list in the Revision column of the table.

5. To select multiple revisions of an item or to select site-specific revisions of an item, use the following procedure:
   a. Select one item in the table, then click the Select Multiple Revisions button. You can expand only one item at a time.

   Note: An unexpanded item has a drop-down list in the revision column.

   b. In the displayed dialog, select the sites for which you want to expand the item revisions. To expand the revisions of the common BOM, select All Sites. Click OK.

   If your company does not have the Sites server license, this step is omitted.

   c. When Select Multiple Revisions is complete, all revisions of the item for each selected site are displayed on separate rows of the table. For example, you might see both Revision B for the India site and Revision B for the Hong Kong site.

   If your company does not have the Sites server license, all revisions of the item are displayed, each revision on a separate row of the table.

   d. If you do not want to include every revision displayed in the Select Items for Report table, select the rows you do not want to use, then click Remove.

   e. Repeat step a through step d for each item for which you want to expand the revisions.

6. Specify the item types by clicking the button and selecting from the list.

7. Select values from the Cost Field and Option drop-down lists. The options are Part Cost Only,
Chapter 7

Assembly Level Cost only, or Assembly Level Cost Plus Rolled-Up Cost.

8. Click Finish to run and display the report.

<table>
<thead>
<tr>
<th>Report layout fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>The BOM level, for example, 0, 1, 2, or 3.</td>
</tr>
<tr>
<td>Individual Cost</td>
<td>The part cost selected in the Cost Field in the report wizard.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Individual Cost * total quantity (Qty) for that row</td>
</tr>
<tr>
<td>Assembly Cost</td>
<td>Cost of the assembly.</td>
</tr>
<tr>
<td>Item fields as specified in the selected</td>
<td>Depending on the layout, the report can include any attributes from the</td>
</tr>
<tr>
<td>layout</td>
<td>selected item's Title Block, Page Two or BOM tabs.</td>
</tr>
<tr>
<td></td>
<td>For detailed information about layouts, see the Working with Agile Reports</td>
</tr>
<tr>
<td></td>
<td>chapter in Getting Started with Agile PLM.</td>
</tr>
</tbody>
</table>

**BOM Comparison Report**

The BOM (Bills of Material) Comparison report shows the differences between two or more bills of material. It compares the first-level BOM of the selected items to the BOMs of the other items on the report and shows you which components are not common to both.

Only those items that have differences are listed in the report. Components that match exactly are not listed. An item may be listed multiple times to indicate the differences in find number and reference designator information.

You can compare the BOMs by item number or by find number. The comparison will be sorted by item number and by find number.

**To run the BOM Comparison report:**


2. Click the Execute button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM. Click Next.

3. Select the items you want to include in the report. Click Add to open the Add Items wizard. You can then select Search or Advanced Search to find items, or locate them using saved searches or shortcuts (My Bookmarks list or Recently Visited list). Select the items you want in the Search Results window; the selected items appear in the Selected Items list. Click OK to close the wizard.

4. By default, the most recently released revision of the item is selected in the Select Items for Report page of the report wizard. To select a different revision, use the drop-down list in the Revision column of the table.

5. To select multiple revisions of an item or to select site-specific revisions of an item, use the following procedure:
a. Select one item in the table, then click the Select Multiple Revisions button. You can expand only one item at a time.

Note An unexpanded item has a drop-down list in the revision column.

b. In the displayed dialog, select the sites for which you want to expand the item revisions. To expand the revisions of the common BOM, select All Sites. Click OK.

If your company does not have the Sites server license, this step is omitted.

c. When Select Multiple Revisions is complete, all revisions of the item for each selected site are displayed on separate rows of the table. For example, you might see both Revision B for the India site and Revision B for the Hong Kong site.

If your company does not have the Sites server license, all revisions of the item are displayed, each revision on a separate row of the table.

d. If you do not want to include every revision displayed in the Select Items for Report table, select the rows you do not want to use, then click Remove.

e. Repeat step a through step d for each item for which you want to expand the revisions.

6. Specify the item types you want to include in the report.

By default, all the item types are selected; if you want to include all item types in your report, you do not need to modify this list. If you want to specify which item types to include, click the button. Move the item types you do not want to include from the Selected Values list to the Available Values list. When you are finished, click OK.

7. Select the attribute used to match items being compared: Item Number or Find Number.

8. Click Finish to run and display the report.

<table>
<thead>
<tr>
<th>Report layout fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comparison Data</td>
<td>The report includes one column for each item revision selected in the Select Items for Report wizard page.</td>
</tr>
<tr>
<td>Item fields as specified in the selected layout</td>
<td>Depending on the layout, the report can include any attributes from the selected item’s Title Block, Page Two or BOM tabs.</td>
</tr>
<tr>
<td></td>
<td>For detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM.</td>
</tr>
</tbody>
</table>

BOM Explosion Report

The BOM Explosion report displays the items that are in the bill of material for a specified assembly, up to the desired number of levels.

To run the BOM Explosion report:


2. Click the Execute button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For
more detailed information about layouts, see the Working with Agile Reports chapter in *Getting started With Agile PLM*. Click Next.

3. Select the items you want to include in the report. Click Add to open the Add Items wizard. You can then select Search or Advanced Search to find items, or locate them using saved searches or shortcuts (My Bookmarks list or Recently Visited list). Select the items you want in the Search Results window; the selected items appear in the Selected Items list. Click OK to close the wizard.

4. By default, the most recently released revision of the item is selected in the Select Items for Report page of the report wizard. To select a different revision, use the drop-down list in the Revision column of the table.

5. To select multiple revisions of an item or to select site-specific revisions of an item, use the following procedure:
   a. Select one item in the table, then click the Select Multiple Revisions button. You can expand only one item at a time.
   b. In the displayed dialog, select the sites for which you want to expand the item revisions. To expand the revisions of the common BOM, select All Sites. Click OK.
   c. When Select Multiple Revisions is complete, all revisions of the item for each selected site are displayed on separate rows of the table. For example, you might see both Revision B for the India site and Revision B for the Hong Kong site.
   d. If your company does not have the Sites server license, all revisions of the item are displayed, each revision on a separate row of the table.
   e. If you do not want to include every revision displayed in the Select Items for Report table, select the rows you do not want to use, then click Remove.
   f. Repeat step a through step d for each item for which you want to expand the revisions.

6. Specify the depth, or number of levels in the BOM, you want to include. Specify the item types by clicking the button and selecting from the list.

7. Click Finish to run and display the report

<table>
<thead>
<tr>
<th>Report layout fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>The BOM level, for example, 0, 1, 2, or 3.</td>
</tr>
<tr>
<td>Item fields as specified in the selected layout</td>
<td>Depending on the layout, the report can include any attributes from the selected item's Title Block, Page Two or BOM tabs. For detailed information about layouts, see the Working with Agile Reports chapter in <em>Getting started With Agile PLM</em>.</td>
</tr>
</tbody>
</table>

**Consolidated BOM Report**

The Consolidated BOM report takes the bill of material for a specified assembly and consolidates it
into a single-level bill, computing the total quantity of each item. It shows a summary of all parts for a given assembly, regardless of level, including total quantities in the whole assembly.

To run the Consolidated BOM report:


2. Click the Execute button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM. Click Next.

3. Select the items you want to include in the report. Click Add to open the Add Items wizard. You can then select Search or Advanced Search to find items, or locate them using saved searches or shortcuts (My Bookmarks list or Recently Visited list). Select the items you want in the Search Results window; the selected items appear in the Selected Items list. Click OK to close the wizard.

4. By default, the most recently released revision of the item is selected in the Select Items for Report page of the report wizard. To select a different revision, use the drop-down list in the Revision column of the table.

5. To select multiple revisions of an item or to select site-specific revisions of an item, use the following procedure:
   a. Select one item in the table, then click the Select Multiple Revisions button. You can expand only one item at a time.

   Note An unexpanded item has a drop-down list in the revision column.

   b. In the displayed dialog, select the sites for which you want to expand the item revisions. To expand the revisions of the common BOM, click OK.

   If your company does not have the Sites server license, this step is omitted.

   c. When Select Multiple Revisions is complete, all revisions of the item for each selected site are displayed on separate rows of the table. For example, you might see both Revision B for the India site and Revision B for the Hong Kong site.

   If your company does not have the Sites server license, all revisions of the item are displayed, each revision on a separate row of the table.

   d. If you do not want to include every revision displayed in the Select Items for Report table, select the rows you do not want to use, then click Remove.

   e. Repeat step a through step d for each item for which you want to expand the revisions.

6. Specify the depth, or number of levels in the BOM, you want to include.

   Specify the item types you want to include in the report. By default, all the item types are selected; if you want to include all item types in your report, you do not need to modify this list.

   If you want to specify which item types to include, click the button. Move the item types you do not want to include from the Selected Values list to the Available Values list. When you are finished, click OK.

7. Click Finish to run and display the report.
Report layout fields | Description
---|---
Total Quantity | Total quantity of each specific item in the whole assembly (BOM)
Item fields as specified in the selected layout | Depending on the layout, the report can include any attributes from the selected item's Title Block, Page Two or BOM tabs.
For detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM.

**Effective BOM Explosion Report**

The Effective BOM Explosion report displays the report based on the Rev Release Date of parts in the BOM.

To run the Effective BOM Explosion report:


2. Click the **Execute** button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM. Click Next.

3. Select the items you want to include in the report. Click Add to open the Add Items wizard. You can then select Search or Advanced Search to find items, or locate them using saved searches or shortcuts (My Bookmarks list or Recently Visited list). Select the items you want in the Search Results window; the selected items appear in the Selected Items list. Click OK to close the wizard.

4. For each row, you can select a site, or all sites, from the drop-down list. Click Next. The Select Depth and Type page is displayed.

5. Specify the depth, or number of levels in the BOM, you want to include.

   Specify the item types you want to include in the report. By default, all the item types are selected; if you want to include all item types in your report, you do not need to modify this list.

   If you want to specify which item types to include, click the **...** button. Move the item types you do not want to include from the Selected Values list to the Available Values list. When you are finished, click OK.

   Select the sort type: Maintain BOM Structure or Sort By Item Type. Click Next.

6. On the Select Date Range page, select a start date and an end date.

   The report will display all the BOM components that were released on or after the start date and on or before the end date.

7. Click Finish to run and display the report.

Default fields | Description
---|---
Level | The BOM level, for example, 0, 1, 2, or 3
Item Activity Report

The Item Activity report shows the items that were processed during a specified period of time.

To run the Item Activity report:


2. Click the <b>Execute</b> button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM. Click Next.

3. Specify the start and end dates of the period to be covered by the report. Click Next.

4. Click the <b>...</b> button next to the Item Lifecycle Phase field and select the lifecycles to be included. Click the <b>...</b> next to the Sites field and select the sites you want.

5. Click Finish to run and display the report.

<table>
<thead>
<tr>
<th>Report layout fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>The name of the site associated with the listed item. The sites listed are determined by the sites you selected in the report wizard.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Site</th>
<th>The name of the site associated with the listed item. The sites listed are determined by the sites you selected in the report wizard.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Item manufacturers</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item fields as specified in the selected layout</td>
<td>Depending on the layout, the report can include any attributes from the listed item’s Title Block or Page Two tabs. For detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM.</td>
</tr>
</tbody>
</table>

Item Manufacturers Report

The Item Manufacturers report displays a list of all the items matching a query and shows the manufacturers that are used for each item.

To run the Item Manufacturers report:

1. Select the Item Manufacturer report in the Products Reports folder. The Item Manufacturer
Chapter 7

Report page appears.

2. Click the Execute button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM. Click Next.

3. Click Saved Search if you want to use a search from the list of global or personal searches. Click Advanced Search to create a new query.

4. Click the buttons next to the Preferred Status, Manufacturer Part Lifecycle Status, and Sites (optional) fields to select values from the lists.

5. Click Finish to run and display the report.

<table>
<thead>
<tr>
<th>Report layout fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item attributes</td>
<td>For each item listed in the report, item fields as specified in the selected layout. Depending on the layout, the report can include any attributes from the listed item’s Title Block or Page Two tabs. For detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM.</td>
</tr>
<tr>
<td>Manufacturer part attributes</td>
<td>Under each listed item, manufacturer part information as specified in the selected layout. Depending on the layout, the manufacturer part information under each item can include any attributes from the listed item’s Manufacturers tab, attributes from the manufacturer part’s General Info tab, and attributes from the manufacturer’s General Info tab. For detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM.</td>
</tr>
</tbody>
</table>

**Manufacturer BOM Report**

The Manufacturer BOM report runs the BOM Explosion report and shows the manufacturers that are used for each item in the bill of material. Manufacturer data can be filtered by the lifecycle status of the manufacturer or of the manufacturer part.

To run the Manufacturer BOM report:

1. Select the Manufacturer BOM report in the Products Reports folder. The Manufacturer BOM Report page is displayed.

2. Click the Execute button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM. Click Next.

3. Select the items you want to include in the report. Click Add to open the Add Items wizard. You can then select Search or Advanced Search to find items, or locate them using saved searches or shortcuts (My Bookmarks list or Recently Visited list). Select the items you want in the Search
Results window; the selected items appear in the Selected Items list. Click **OK** to close the wizard.

4. By default, the most recently released revision of the item is selected in the Select Items for Report page of the report wizard. To select a different revision, use the drop-down list in the Revision column of the table.

5. To select multiple revisions of an item or to select site-specific revisions of an item, use the following procedure:
   a. Select one item in the table, then click the **Select Multiple Revisions** button. You can expand only one item at a time.

   **Note** An unexpanded item has a drop-down list in the revision column.

   b. In the displayed dialog, select the sites for which you want to expand the item revisions. To expand the revisions of the common BOM, select **All Sites**. Click **OK**.

   If your company does not have the Sites server license, this step is omitted.

   c. When Select Multiple Revisions is complete, all revisions of the item for each selected site are displayed on separate rows of the table. For example, you might see both Revision B for the India site and Revision B for the Hong Kong site.

   If your company does not have the Sites server license, all revisions of the item are displayed, each revision on a separate row of the table.

   d. If you do not want to include every revision displayed in the Select Items for Report table, select the rows you do not want to use, then click **Remove**.

   e. Repeat step a through step d for each item for which you want to expand the revisions.

6. Specify the depth, or number of levels in the BOM, you want to include. Specify the item types by clicking the **...** button and selecting from the list.

7. Click the **...** buttons next to the **Preferred Status**, **Manufacturer Part Lifecycle Status**, and **Sites** (if it appears) fields to select the values you want to use.

8. Click **Finish** to run and display the report.

<table>
<thead>
<tr>
<th>Report layout fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item attributes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Level</strong></td>
<td>The BOM level, for example, 0, 1, 2, or 3.</td>
</tr>
<tr>
<td>For each item listed in the report, item fields as specified in the selected layout</td>
<td>Depending on the layout, the report can include any attributes from the listed item’s <strong>Title Block</strong>, <strong>Page Two</strong>, or <strong>BOM</strong> tabs. For detailed information about layouts, see the Working with Agile Reports chapter in <em>Getting started With Agile PLM</em>.</td>
</tr>
</tbody>
</table>
## Where Used Report

The Where Used report shows where the specified component or subassembly is used, up to the specified number of levels. It can show just the highest level of the assembly, all levels, or any number of levels in between.

**Note** An item will be selected for the report only if the specified component or subassembly is included in the BOM of the item’s latest released revision.

### To run the Where Used report:


2. Click the **Execute** button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in *Getting started With Agile PLM*. Click Next.

3. Select the items you want to include in the report. Click Add to open the Add Items wizard. You can then select **Search** or **Advanced Search** to find items, or locate them using saved searches or shortcuts (My Bookmarks list or Recently Visited list). Select the items you want in the Search Results window; the selected items appear in the Selected Items list. Click OK to close the wizard.

4. Specify the depth, or number of levels in the BOM, you want to include. Specify the item types by clicking the button and selecting from the list.

The **Only End Items** checkbox determines which items that contain the specified item are included in the report. In a Where Used report on Item P0003 below, selecting the checkbox causes only P0001 to be included, while clearing the checkbox causes P0001 and P0002 to be included.
5. Click **Finish** to run and display the report.

<table>
<thead>
<tr>
<th>Default fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Level</strong></td>
<td>The BOM level, for example, 0, 1, 2, or 3.</td>
</tr>
<tr>
<td><strong>Item fields as specified in the selected layout</strong></td>
<td>Depending on the layout, the report can include any attributes from the listed items' <strong>Title Block</strong>, <strong>Page Two</strong>, or <strong>BOM</strong> tabs. For detailed information about layouts, see the Working with Agile Reports chapter in <em>Getting started With Agile PLM</em>.</td>
</tr>
</tbody>
</table>

### Agile Process Reports

The Agile Process reports provide information about changes and transfer orders. The **Process Reports** node folder under **Standard Reports** in the navigation pane lists the following reports:

<table>
<thead>
<tr>
<th>Report</th>
<th>Displays…</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change process reports</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Change Activity Report</strong> (on page 169)</td>
<td>The Change Activity report shows the changes that were processed during a specified period of time.</td>
</tr>
<tr>
<td><strong>Change Backlog Report</strong> (on page 170)</td>
<td>The Change Backlog report counts the changes that were at a specified status but have not moved to another specified status during a time period.</td>
</tr>
<tr>
<td><strong>Change Cycle Time Report</strong> (on page 171)</td>
<td>The Change Cycle Time report calculates the time it took the specified changes to move from one status to another during the specified period. For example, the report indicates the average time it took for a change to go from Submitted to Released each month during the last year, grouped by product line.</td>
</tr>
<tr>
<td><strong>Change Metrics Report</strong> (on page 172)</td>
<td>The Change Metrics report counts the changes that were moved to a specified status during a specified period.</td>
</tr>
<tr>
<td><strong>Change Package Report</strong> (on page 173)</td>
<td>You can print the Change Package report to view the information about a change in an easy-to-read format.</td>
</tr>
<tr>
<td><strong>IP Transfer reports</strong></td>
<td></td>
</tr>
<tr>
<td><strong>IP Transfer Report</strong> (on page 175)</td>
<td>The IP Transfer report show the objects sent (by Agile transfer orders) to a given destination and when they were sent. (Requires the Agile Content Service server license.)</td>
</tr>
</tbody>
</table>
Change Activity Report

The Change Activity report shows the changes that were processed during a specified period of time. You choose which workflow to include in the report (for example, Default Change Orders or All Change Workflows). You also choose which status transitions to include in the report. For example, if you select Default Change Orders workflow and Released status type, the report lists all the changes orders that used the Default Change Orders workflow and that moved into the Released type status during the specified time period.

To run the Change Activity report:


2. Click the Execute button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM. Click Next.

   Note  
   To run this report for price change orders, select a layout that applies to price change orders. (The Agile-provided default layouts are Default Layout for Change and Default Layout for PCO.) If you create new layouts for this report, you can choose a Layout Type: either Changes or Price Change Orders. Make sure the name you choose for the new layout indicates whether the layout applies to changes or price change orders.

3. Specify the start and end dates of the period to be covered by the report. Click Next.

4. Select the workflow from the drop-down list. Click button next to the Status Changes field, and select the statuses to be included from the Available Values list.

   Note  
   If you select All Change Workflows, the status types are listed in the Status Changes selection dialog; this allows you to select status types that apply to all workflows (for example, Released status type). However, if you select a specific workflow (for example, All Change Orders) the specific status names that apply to that workflow are listed in the Status Changes selection dialog.

5. Click Finish to display the report.

<table>
<thead>
<tr>
<th>Report layout fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main Header attributes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Status based on the Status Changes selections in wizard.</td>
</tr>
<tr>
<td><strong>Status Date</strong></td>
<td>Date the change entered the selected status.</td>
</tr>
<tr>
<td><strong>For each change listed in the report, change object fields as specified in the selected layout</strong></td>
<td>Depending on the layout, the report can include any attributes from the listed change’s Cover Page or Page Two tabs. For detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM.</td>
</tr>
<tr>
<td><strong>Affected Item attributes</strong></td>
<td></td>
</tr>
</tbody>
</table>
Report layout fields | Description
---|---
Under each change object status transition row, item information from the change’s **Affected Items** tab, as specified in the selected layout | Depending on the layout, the report can include any attributes from the listed change’s **Affected Items** tab. For detailed information about layouts, see the Working with Agile Reports chapter in *Getting started With Agile PLM*.

### Change Backlog Report

The Change Backlog report counts the changes that were at a specified status but have not moved to another specified status during a time period.

**To run the Change Backlog report:**

2. Click the **Execute** button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in *Getting started With Agile PLM*. Click **Next**.

   **Note** To run this report for price change orders, select a layout that applies to price change orders. (The Agile-provided default layouts are Default Layout for Change and Default Layout for PCO.) If you create new layouts for this report, you can choose a Layout Type: either Changes or Price Change Orders. Make sure the name you choose for the new layout indicates whether the layout applies to changes or price change orders.

3. Click **Saved Search** if you want to use a search from the list of available searches. Click Advanced Search to create a new query. Or you can select **All Changes** to include all changes. Click **Next**.

4. Specify the other settings for the report:
   - The time period covered
   - The workflow
   - The starting status (to include changes that were in this status or moved into this status during the specified time period) and ending status (to include changes that have *not yet* moved into this status during the specified time period)

   For example, if you select starting status = Pending and ending status = Released, the report will count changes that were either in the Pending status or moved into the Pending status during the specified time period, but these changes have *not* moved into the Released status. The changes might be in a Submit type or Review type status, but they have not moved through the workflow to the Released status.

   - The time unit used in the report
   - The way to group data to evaluate trends

   Select the checkboxes if you want to display the changes or price change orders and exclude empty columns.

5. Click **Finish** to display the report.
Report layout fields | Description
---|---
**Main Header attributes**
Days since Submitted | Number of days since the change entered the Submit type status.
Days at current status | Number of days the change has been at the current status.
Hold Date | Date the change entered the Hold type status.
Submit Date | Date the change entered the Submit type status

For each change listed in the report, change object fields as specified in the selected layout

Depending on the layout, the report can include any attributes from the listed change's **Cover Page** or **Page Two** tabs.

For detailed information about layouts, see the Working with Agile Reports chapter in *Getting started With Agile PLM*.

**Affected Item attributes**

Under each change object status transition row, item information from the change's **Affected Items** tab, as specified in the selected layout

Depending on the layout, the report can include any attributes from the listed change's **Affected Items** tab.

For detailed information about layouts, see the Working with Agile Reports chapter in *Getting started With Agile PLM*.

---

**Change Cycle Time Report**

The Change Cycle Time report calculates the time it took the specified changes to move from one status to another during the specified period. For example, the report indicates the average time (in days) it took for a change to go from Submitted to Released each week during the last year, grouped by product line.

**To run the Change Cycle Time report:**

2. Click the **Execute** button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in *Getting started With Agile PLM*. Click **Next**.

**Note**

To run this report for price change orders, select a layout that applies to price change orders. (The Agile-provided default layouts are Default Layout for Change and Default Layout for PCO.) If you create new layouts for this report, you can choose a Layout Type: either Changes or Price Change Orders. Make sure the name you choose for the new layout indicates whether the layout applies to changes or price change orders.

3. Click **Saved Search** if you want to use a search from the list of available searches. Click **Advanced Search** to create a new query. Or you can select **All Changes** to include all changes. Click **Next**.
4. Specify the other settings for the report:
   - The time period covered
• The workflow
• The starting status (to include changes that were in this status or moved into this status during the specified time period) and ending status (to include changes that moved into this status during the specified time period)
• The time units used in the report
• The way to group data to evaluate trends

Select the checkboxes if you want to display the changes or price change orders and exclude empty columns.

5. Click Finish to display the report.

<table>
<thead>
<tr>
<th>Default fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main Header attributes</strong></td>
<td></td>
</tr>
<tr>
<td>Days since Submitted</td>
<td>Number of days since the change entered the Submit type status.</td>
</tr>
<tr>
<td>Days at current status</td>
<td>Number of days the change has been at the current status.</td>
</tr>
<tr>
<td>Enter Status Date</td>
<td>Date the change entered the starting status selected in the report wizard.</td>
</tr>
<tr>
<td>End Status Date</td>
<td>Date the change entered the ending status selected in the report wizard.</td>
</tr>
<tr>
<td>Number Days</td>
<td>The number of days between the Enter Status Date and the End Status Date.</td>
</tr>
</tbody>
</table>

For each change listed in the report, change object fields as specified in the selected layout

Depending on the layout, the report can include any attributes from the listed change’s **Cover Page** or **Page Two** tabs.

For detailed information about layouts, see the Working with Agile Reports chapter in *Getting started With Agile PLM*.

<table>
<thead>
<tr>
<th>Affected Item attributes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under each change object row,</td>
<td>Depending on the layout, the report can include any attributes from the</td>
</tr>
<tr>
<td>item information from the</td>
<td>listed change’s <strong>Affected Items</strong> tab.</td>
</tr>
<tr>
<td>change’s <strong>Affected Items</strong></td>
<td>For detailed information about layouts, see the Working with Agile Reports</td>
</tr>
<tr>
<td>tab, as specified in the</td>
<td>chapter in <em>Getting started With Agile PLM</em>.</td>
</tr>
<tr>
<td>selected layout</td>
<td></td>
</tr>
</tbody>
</table>

**Change Metrics Report**

The Change Metrics report counts the changes that were moved to a specified status during a specified period.

**To run the Change Metrics report:**


2. Click the **Execute** button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For
more detailed information about layouts, see the Working with Agile Reports chapter in *Getting started With Agile PLM*. Click **Next**.

**Note**  
To run this report for price change orders, select a layout that applies to price change orders. (The Agile-provided default layouts are Default Layout for Change and Default Layout for PCO.) If you create new layouts for this report, you can choose a Layout Type: either Changes or Price Change Orders. Make sure the name you choose for the new layout indicates whether the layout applies to changes or price change orders.

3. Click **Saved Search** if you want to use a search from the list of available searches. Click **Advanced Search** to create a new query. Or you can select **All Changes** to include all changes. Click **Next**.

4. Specify the other settings for the report:
   - The time period covered
   - The workflow
   - The status type (to include changes that moved into this status type during the specified time period)
   - The time unit used in the report
   - The way to group data to evaluate trends

   Select the checkboxes if you want to display the changes or price change orders and exclude empty columns.

5. Click **Finish** to display the report.

<table>
<thead>
<tr>
<th>Report layout fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main Header attributes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>Date the change entered the status you selected in the report wizard.</td>
</tr>
<tr>
<td>For each change listed in the report, change object fields as specified in the selected layout</td>
<td>Depending on the layout, the report can include any attributes from the listed change’s <strong>Cover Page</strong> or <strong>Page Two</strong> tabs. For detailed information about layouts, see the Working with Agile Reports chapter in <em>Getting started With Agile PLM</em>.</td>
</tr>
<tr>
<td><strong>Affected Item attributes</strong></td>
<td></td>
</tr>
<tr>
<td>Under each change object row, item information from the change’s <strong>Affected Items</strong> tab, as specified in the selected layout</td>
<td>Depending on the layout, the report can include any attributes from the listed change’s <strong>Affected Items</strong> tab. For detailed information about layouts, see the Working with Agile Reports chapter in <em>Getting started With Agile PLM</em>.</td>
</tr>
</tbody>
</table>

**Change Package Report**

You can print the Change Package report to view the information about a change in an easy-to-read format.
To run the Change Package report:


2. Click the Execute button. The Select Layout and Configuration page appears. Select the layout you want from the drop-down list, or use the Layout Manager to create a new layout. For more detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM. Click Next.

   **Note**  
   Agile PLM supplies a default layout for each change type. If you create new layouts for this report, you can choose a Layout Type. The layout type can be for all changes in a particular class (for example, change orders) or the layout type can be for a specific type of subclass of change (for example, ECOs). For ease of use, make sure the name you choose for the new layout indicates the selected layout type.

3. Select the items you want to include in the report. Click Add to open the Add Items wizard. You can then select Search or Advanced Search to find items, or locate them using saved searches or shortcuts (My Bookmarks list or Recently Visited list). Select the items you want in the Search Results window; the selected items appear in the Selected Items list. Click OK to close the wizard. Click Next.

4. Click next to the Tables field to specify the tables to include in the report. Click next to the Sites field to specify sites to include.

5. Click Finish to display the report.

<table>
<thead>
<tr>
<th>Report layout pages and fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cover Page</strong></td>
<td>Tabs of the change object that can be included in the report layout. Depending on the layout, the report can include any attributes from the change’s tabs.</td>
</tr>
<tr>
<td><strong>Affected Items</strong></td>
<td>For detailed information about layouts, see the Working with Agile Reports chapter in Getting started With Agile PLM.</td>
</tr>
<tr>
<td><strong>Workflow</strong></td>
<td>All Change Package layouts can include these tabs. Some change types can include additional information, as explained below.</td>
</tr>
<tr>
<td><strong>Attachments</strong></td>
<td>Lists the BOM redlines that appear on the change’s affected item BOM tab. Depending on the layout, the report can include any attributes from this tab. Available for change orders and site change orders only.</td>
</tr>
<tr>
<td><strong>History</strong></td>
<td>Lists the manufacturer redlines that appear on the change’s affected item Redline Manufacturers tab. Depending on the layout, the report can include any attributes from this tab. Available for change orders, site change orders, and manufacturer orders only.</td>
</tr>
</tbody>
</table>
### Report layout pages and fields

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Affected Items.Attachments</strong></td>
</tr>
<tr>
<td>Lists the attachments that appear on the change’s affected item <strong>Redline</strong></td>
</tr>
<tr>
<td>Folder tab: the list of attachments for the pending revision of the item.</td>
</tr>
<tr>
<td>Depending on the layout, the report can include any attributes from this tab.</td>
</tr>
<tr>
<td>Available for change orders only.</td>
</tr>
</tbody>
</table>

### IP Transfer Report

**Note** For information about Agile Content Service (ACS) and transfer orders, see the chapter about ACS settings in *Administrator Guide* and see *Agile Content Service User Guide*.

This report shows the objects sent by transfer orders to a given destination and when they were sent.

For details about running this report, see the Working with Transfer Orders chapter of *Agile Content Service User Guide*.
Details about Discovery and Read Privileges

Note For more information about the discovery warning messages, see the chapter about SmartRules in the Administrator Guide.

The Agile administrator can use the Discovery privilege to limit discovery of objects in the following ways:

- Prevent a set of users from seeing certain objects when they run a search. These objects are not displayed on the results table, even though they meet the search criteria. The Agile administrator can specify whether or not to display a warning message on the search results page.
- Prevent a set of users from seeing certain objects that are listed on these tables:
  - Affected items
    - Where used
    - Manufacturers
    - Changes
    - Sites
    - User address book
  The Agile administrator can specify whether to display a warning message.
- Prevent a set of users from seeing certain objects on the BOM tab. The Agile administrator specifies whether or not to display a warning message. The Agile administrator also has the option of displaying either the item number only or the item description only on the BOM tab, so the user can see a complete BOM, but does not have access to the undiscovered items.
- Prevent a set of users from running reports.

Note that while one set of users is prevented from seeing certain objects or fields, other users with different Discovery privilege and Read privilege settings can see those same objects and fields.

The creator of an object is always able to read and discover the object he created, even when he has not been granted Discovery privilege for that object.
Discovery and Read privileges are assigned by the Agile administrator. If you have questions about your Discovery privileges or Read privileges, see the Agile administrator.

**Displaying Non-viewable Fields**

**Note** The Agile administrator can create Read privilege masks that limit your ability to read specific fields. The Enforce Field Level Read privilege determines whether or not the Read privilege mask is enforced at the field level. If you have a role that includes the Enforce Field Level Read privilege, you may not be able to view the contents of specific fields. This section describes how those non-viewable fields are displayed. For more information, see the *Administrator Guide*.

If you do not have the appropriate Read privilege for a field, the words No Privilege appear in the field.

If a copy of a non-readable field appears in another object or in a table, the words No Privilege appear there also. For example, if you do not have Read privilege for the `Description` field of changes, when those changes are listed in a table, the words No Privilege also appear in the `Description` field of that table. Following are examples of tables where objects may be listed:

- Search results
- Change history
- Manufacturers
- Where used
- Affected items
- Audit results

On the BOM table only, the SmartRule that determines how non-discovered items are displayed on the BOM table is also applied to the non-readable fields. See How the Agile Administrator Controls What You See (on page 74).

**Part or Document?**

In general, if the document is shipped as part of a product, or it has costs associated with it, create it as a part object. If the document is an internal document, procedure, or reference, create it as a document object.

In certain cases, though, you may want to create a document as a part. Here are three examples illustrating when you might choose to create a document as a part object or as a document object.

**Example 1** If a document is the controlling document for a part (that is, it has the same number as the part), create that document as a part object.

For example, if you have an engineering drawing number 123 that specifies and describes part number 123 (thus the document controls the part), create part 123 and include the engineering drawing as an attachment.

Use this method if the part number must be the same as the document number. Note that the
document does not exist as a separate document object in the Agile PLM database.

In contrast to the above example, if it is not necessary for the drawing number and part number to be the same, create a document object (for example, document number 222) and add the engineering drawing to its Attachments tab (reference the engineering drawing in the appropriate file folder object). Then create a part object (for example, part 444). Add document 222 to the BOM tab of part 444 and enter zero or REF as the quantity. Enter zero as the find number; this forces a document object to appear at the top of the BOM tab for easy reference.

**Example 2:** If the document has costs associated with it, or it is shipped as part of a product, create it as a part object.

An example of a document that is shipped with a product is a manual. A manual might have a BOM that includes the binder, labels for the binder, binder tabs, and the printed document itself.

If a document goes to your customer with a product, create it as a part object, even if it does not have a BOM. Examples of such a document might be a warranty card, an instruction booklet, assembly instructions, or a printed software licensing agreement.

If the document has costs associated with it, such as printing costs, create it as a part object. When you add the document part to a BOM tab, and you enter a quantity of 1, the costs of the document part object are included in any reports that compute costs. (See Getting Started with Agile PLM for information about running reports.)

**Example 3:** If the following applies to a document, create it as a document object:

- It does not need to have the same number as a part.
- It is not shipped as part of a product.
- It does not have costs associated with it.

Examples of such documents might be a manufacturing process (a Quality Assurance procedure, a test procedure, or manufacturing instructions) or a reference document (a specification or an engineering drawing).

Create any internal company documents as document objects.

**Note** Because Agile PLM is so flexible, you are not required or forced to use the approach outlined in these examples when creating documents. You should, however, always follow your company’s policies or guidelines when creating a document as a part object or as a document object. If you have questions, see the Agile administrator.

If you create a document object, and later want to change it to a part object, you can hard-delete the document object (if you have the appropriate privileges), which removes it from the database and frees up the item number. Then you can create the document as a part object, using the same item number. For more information, see Deleting Agile Objects (on page 23).

### Changing an Item’s Subclass

If the Agile administrator has created additional subclasses, and you have the appropriate privileges, you can change the subclass of an item. For example, you can change the subclass of a particular document from Specification to Data Sheet.
Caution When you change the subclass of an item, its data fields change, and all previous information about the Page Three tab is cleared.

To change the subclass of an item:
6. On the Title Block tab of the part, select a new subclass from the Part Type drop-down list.
7. If Page Three is visible and has data, a warning message appears, alerting you that all Page Three data is cleared.
   - Click Yes (Java Client) or OK (Web Client) to continue changing the subclass and to allow Page Three to be cleared.
   - Click No (Java Client) or Cancel (Web Client) to cancel the change subclass process; no changes are made to the item. In the object screen or window, click Cancel to discard your modifications and exit the edit mode.
8. If the new subclass has an autonumber scheme assigned by the Agile administrator, Agile PLM asks you if you want to select a new autonumber for the new subclass.
   - Click Yes (Java Client) or OK (Web Client) to change the subclass but retain the existing number.
     If the new subclass either does not have an autonumber scheme assigned to it or does not require an autonumber, the process is completed; the subclass is changed but the number is not changed.
   - Click No (Java Client) or Cancel (Web Client) to reject the existing number. Manually select or enter a number, then click Save in the object page or window.
9. If you reject the existing number in the step above, you must manually select a new number. Depending on your system configuration, do one of the following:
   - If there is one autonumber source designated for the new subclass, click the Autonumber button to assign a new autonumber. Click Save in the object window or page to complete the process.
   - If an autonumber is not required, you can type in a number. Click Save in the object window or page to complete the process.
   - If autonumbering is required in your system, and more than one autonumber source is designated for the new subclass, use the Autonumber button to select one of the autonumber sources. Click Save in the object window or page to complete the process.

Note If the item is in use, you may see a dialog box alerting you that the item is locked. Click OK; the change subclass process is canceled.

10. Agile PLM displays the new number in the Number field, and enters the event on the History tab of the item.

About Matching Criteria in Workflows

Matching criteria are used to find which workflows may be used for each change. Agile PLM matches each change to a list of valid workflows for that change.

The Agile administrator selects matching criteria from a list of reusable criteria. A reusable criteria is a database query, just like an advanced search. Reusable criteria are named and defined by the
Agile administrator.

Some examples of possible reusable criteria are:

- **All MECOs** – finds all the changes that are MECOs (mechanical ECOs).
- **Scorpio ECOs** – finds all the ECOs that include “Scorpio” in the Product Line(s) field of the change.
- **Libra Project** – finds all the change orders that have any items on the Affected Items tab that contain “Libra” in the Product Line(s) field of the item.

By specifying a list of reusable criteria for each workflow, the Agile administrator limits which changes can use a specific workflow. For example, the Agile administrator might create a workflow named General Use, and select the three reusable criteria named above (All MECOs, Scorpio ECOs, and Libra Project) as the matching criteria for that workflow.

**Example 1:** If you create a change that is a Mechanical ECO (MECO), it matches one of the matching criteria of the General Use workflow (All MECOs). The General Use workflow appears in the Workflow drop-down list on the Cover Page tab of the change.

**Example 2:** If you create a change that is an ECO that includes “Scorpio” in the Product Line(s) field of the ECO, it matches one of the matching criteria of the General Use workflow (Scorpio ECOs). The General Use workflow appears in the Workflow drop-down list on the Cover Page tab of the change.

**Example 3:** If you create a change order and add items to its Affected Items tab that contain “Libra” in the Product Line(s) field, Agile PLM examines the Product Line(s) field on the Affected Items tab for every affected item. The General Use workflow appears in the Workflow drop-down list on the Cover Page tab of the change depending on the Criteria Matching Type setting for the workflow:

- **Some** – One or more (but not all) affected items must match the affected item–based reusable criteria, in this case, Libra Project.
- **All** – When multiple affected item–based reusable criteria are used as matching criteria, each affected item must match at least one affected item–based reusable criteria; however, each affected item does not have to match the same reusable criteria.
- **Same** – All affected items must match the same affected item–based reusable criteria, in this case, Libra Project.

**Note** As you add items to the Affected Items tab and complete the fields on the tabs of the change, the Workflow drop-down list on the Cover Page tab may vary, depending on which matching criteria apply at the moment. Contact the Agile administrator if you have questions about the matching criteria of a specific workflow.

In Java Client, when editing a change object, click the Refresh button to save and update the change object and display the correct list of workflows in the Workflow drop-down list.

In Web Client, when editing the Cover Page tab, click the Validate button to save and update the change object and display the correct list of workflows in the Workflow drop-down list.

The Criteria Matching Type setting also applies for each status in the workflow. For detailed information about workflows and Criteria Matching Type, see the Administrator Guide.

### Details About Revision Display on BOMs

Agile PLM calculates the revision number (or letter) that appears in the Rev field of the BOM table is
by checking the release date of the parent item, if already released, then locating the latest revision of the child item prior to that date and analyzing it. If the parent item hasn’t been released, the most recent revision of the child item is found.

The child item revision is analyzed according to three criteria:

- Its lifecycle phase (Preliminary or other)
- Whether there are any released revisions of the child item
- Whether there are no released revisions of the child item

**Note** In Agile PLM, if there are no released revisions of an item (the item has never been released), the Introductory revision is considered the latest revision, regardless of whether or not there are pending revisions of the never-released item. See *Introductory Revisions* (on page 14).

Depending on which revision of the parent you select, the child revision displayed may or may not be the latest revision of that child item. The following is an explanation of which child revision appears:

- The latest revision of the parent item always displays the latest revision of the child item. This means that the parent BOM reflects any changes that may be made to the child item since the parent revision was released. This applies until the next revision of the parent is released.
- The rev shown for a child item of any past revision of the parent item is the latest revision as of the time just preceding the next parent revision.
- For each child item, the lifecycle phase appears that corresponds to the displayed revision.
  - The child item may display a blank Rev field if it has no revision number as of the release of the parent revision. This occurs:
    - If the child item has never been released as of the present moment, if you are viewing the latest parent revision, or
    - If it had not been released by the time of the next occurring parent revision, if you are viewing past parent item revisions.

**Caution** Be aware that the unrelease and release of child items may affect the child revisions displayed on the parent BOM.

**Note** Pending revisions of the child item are not displayed on the parent item BOM table. However, any child item that has a pending change is indicated by the icon in its row in the parent item BOM table.

The change order (ECO) or manufacturer change order (MCO) number associated with the displayed revision is included in the *Item Rev* column of the BOM table. The ECO number is the ECO that released the displayed revision. An MCO number is displayed with the revision upon which it is based.

Site change orders (SCO) are based on ECO-released revisions and the revision displayed on the BOM table may include SCO-defined content, however, SCO numbers are not displayed on the BOM table.

For more information about item revisions, see *Working with Item Revisions* (on page 13).